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Preface

CIMS Web Reporting is a key portion of the CIMS Server chargeback system. It offers a
full range of IT resource reporting features that are accessible via your Web browser.

The technology behind CIMS Server and CIMS Server Web Reporting is based on CIMS
Lab’s many years of experience in the development and implementation of Resource
Accounting, Capacity Planning and IT Chargeback products.

About CIMS Lab

Founded in 1974, CIMS Lab has focused on meeting the financial and resource reporting
requirements of Information Services Departments. CIMS has evolved with corporate IT
management requirements. Focused commitment to client service and support sets
CIMS apart from competing products. Our goal is to provide the best chargeback and
resource reporting software in the world at the lowest possible cost to our customers.

CIMS Lab strongly believes in and executes the concept of continuous product
improvement. Customers have access to CIMS product development personnel to
ensure that customer feedback and other critical issues are incorporated into the next
release of the product.
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Contacting CIMS Lab

Contacting CIMS Lab

To contact CIMS Lab with questions, comments, or problems, please use one of the
following methods:

For product assistance or information:

USA & Canada, toll free - (800) 283-4267
International - (916) 783-8525

FAX - (916) 783-2090

World Wide Web - http://www.cimslab.com

Mailing Address:

CIMS Lab, Inc.
3013 Douglas Blvd., Suite 120
Roseville, CA 95661-3842

About This Guide

This guide explains how to use CIMS Server Web Reporting. Note that some features
described in this guide might have been customized for your organization. In this case,
consult your CIMS Server administrator for assistance.

CIMS Server Web Reporting is a component of CIMS Server. This guide assumes that you
have the CIMS Server system installed and configured as described in the CIMS Server
Administrator’s Guide.

This guide contains the following chapters:.

Ch.

No. Chapter Name Content Description

1 Getting Started Introduces the CIMS Server Web
Reporting interface and provides steps
for logging in and out and other tasks.

2 Running Reports Introduces the different report types
and describes how to run these reports.

3 Working with Reports Describes how navigate and use
generated reports.

4  Administering CIMS Describes how to configure user-
Server Web Reporting specific and system-wide
administration settings for CIMS Server
Web Reporting.

5  Using Transactions Describes how to use Miscellaneous,
Recurring, and Credit transactions.

CIMS Server Web Reporting User's Guide
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Preface W

. Chapter Name

Conventions

Content Description

6  Troubleshooting

A Standard Reports

Describes problems you may
encounter while using CIMS Server
Web Reporting and how to solve them.

Describes the standard graphs, reports,
spreadsheets, and templates available
with CIMS Server Web Reporting.

Terminology Used in This Guide: Reports, Graphs, and Spreadsheets

For simplicity, in this guide, the term “report” refers to reports, graphs, and spreadsheets

unless noted otherwise.

Conventions

Some or all of the following conventions appear in this guide:

Represents

Example

Alternate hyperlinked cross-references to ... see Related Publications.
color other sections in this guide
Italic words that are emphasized ...the entry after the current entry...
a new term ...by identifier values.
the titles of other manuals CIMS Server Administrator's Guide
Bold names of interface items such as The Reports menu
tabs, boxes, buttons, lists, and
check boxes. Select the Change Password check
box
The Group Tree appears in the
Preview tab
Monospace directories, file names, command Server folder
names, computer code, computer ProcTransactions.wsf script
screen text, system responses,
command line commands, what Typeiisreset /restart
the user types
<> the name of a key on the Press <Enter>
keyboard
4 navigating a menu or a folder Reports » View Published Reports

CIMS Server Web Reporting User’s Guide
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Related Publications

As you use this guide, you might find it helpful to have the CIMS Server Administrator’s
Guide available for reference.
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Getting Started

This chapter describes how to get started using CIMS Server Web Reporting. CIMS Server
Web Reporting is accessible via your Web browser (Starting CIMS Server Web Reporting
on page 1-2).

About CIMS Server Web RepOrting .....cocvveiiiiiieiiiiiieieiiieiieieneieeeiencncncanens 1-2
Types of CIMS Server Web Reporting USers .......c.couiiiiiiiiiiiiiiiiiiiiieieieienennnns 1-2
Starting CIMS Server Web Reporting ........cciviiiiiiiiiiiieiiiiiiiiiieienenenenenecenes 1-2
Logging On To CIMS Server Web Reporting .........cocoveiiiiiiiieieieieiieieiecenenenens 1-3
USiNgthe MenU BaAr ......ociuiiiiii ittt iieiiieieieeeeieneseeeenssesncnnnnns 1-5
Changing YoUr PassSWOrd .......cuveuieuinieneiiuieieneieeieseeeesenescesescscscacasencnons 1-5
T3 7 <0 1-6
Viewing OnliN@ HeIP .. ..vuininiiiiiiiiiiiiitiiiiitieiieteieteeesencncescncnsanencannns 1-6
L L1011 7= 00 1 1-6
Assigning CIMS Server Folder Security Permissions ..............cccooiiiiiiiiiiiiiiinnnn, 1-7
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About CIMS Server Web Reporting

About CIMS Server Web Reporting

CIMS Server Web Reporting enables you to generate and view IT chargeback and
resource accounting reports from a Web browser. These reports include invoice, budget,
summary, trend, and variance reports in report, graph, and spreadsheet format.

You can save, copy text from, and print reports. In addition, many reports generated
using CIMS Server Web Reporting include multi-level drilldown capabilities that enable
you to view detailed resource usage and cost information.

CIMS Server Web Reporting uses Crystal Reports as the report writer. If you are familiar
with Crystal Reports, you will recognize many of the reporting features.

Note ¢ Although CIMS Server Web Reporting is designed to use Crystal Reports, you
might be able to use other reporting tools. For more information, contact CIMS Lab
(see Contacting Technical Support on page 6-5).

Types of CIMS Server Web Reporting Users

There are two types of CIMS Server Web Reporting users:

B Administrators. Administrators can perform administrative functions in CIMS Server
Web Reporting such as changing the configuration options for the application (see
Configuring System-Wide Settings on page 4-7). Administrative access is assigned by
your CIMS Server administrator. For more information, refer to the CIMS Server
Administrator’s Guide.

m End Users. End users have no administrative privileges.

The terms CIMS Web administrator and CIMS Web end user are used in this guide to
differentiate the two user types when needed.

Starting CIMS Server Web Reporting

H 1-2

To start CIMS Server Web Reporting, open your Web browser and enter the URL for
CIMS Server Web Reporting in the Address bar. The specific URL depends on your
organization—see your system administrator for the URL. The following is an example
of a URL for CIMS Server Web Reporting:

http://<intranet>/cims/

If you are running the browser on the server that is running CIMS Server Web Reporting,
enter the URL http://localhost.

CIMS Server Web Reporting User’'s Guide
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Logging On To CIMS Server Web Reporting

Logging On To CIMS Server Web Reporting
There are two methods for logging on to CIMS Server Web Reporting:

® Auto log on. Auto log on enables you to use CIMS Server Web Reporting without first
logging on to the application through the Login page. If your CIMS Server
administrator has enabled auto log on for your user ID, you will see the following
message on the home page when you start CIMS Server Web Reporting:

Welcome username, you are currently signed on as userid

If you are a CIMS Web administrator, you can click Login to open the Login page and
log on as another user if needed (see the steps under the following bullet, Manual log
on). If you are a CIMS Web end user, the Login page is inactive.

B Manual log on. If your CIMS Server administrator has not enabled auto log on for
your user ID, you will see the following message on the home page when you start
CIMS Server Web Reporting:

Not currently signed in, please click Login to begin
To log on, do the following:

1 On the CIMS Server Web Reporting home page, click Login to open the Login
page.

2 Enter the following information, and then click OK:

e Your user ID and password (required). If you do not know your user ID and
password, contact your CIMS Server administrator.

The password is case-sensitive. Type the password exactly as provided by your
CIMS Server administrator.

e Your company or organization name (if the Your Company or Organization
box is present). Your CIMS Server administrator determines whether this box is
present on the Login page. For more information, refer to the CIMS Server
Administrator’s Guide.

Your company/organization name is saved in a cookie so that you do not have
to re-enter it each time that you log on.

The CIMS Server Web Reporting home page reappears as shown in example
Figure 1-1 on page 1-4.

CIMS Server Web Reporting User’s Guide -3 N
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Logging On To CIMS Server Web Reporting

H 14

CIMS5 Server - Microsoft Internet Explorer

File:

Edit  View Favorites  Tools  Help

@Back @ J @ @ \hh pSearch *Favorites @Media @

Address @ http: fflocalhost fdef aulk, asp

CIMS

Server

Login Reports Spreadsheets Favorites Admin Help Logout Home

C l MS LAB, INC.
Login successful

Welcome CIMS Server Administrator, you are currently signed on as admin

CIMS Server is the Enterprise Wide Systern for managing IT costs, A central repository of resource usage data is
collected from OS/390, NT, UNIX, Metwork, e-Commerce, and more, Any source of resource usage can be
collected and reported on. Web based reporting makes resource usage information immediately available across
your organization. & complete system for today's complex IT processing environment,

CIMS Lab, Inc.
3013 Douglas Blvd,, Suite 120
Roseville, T4 95661

www.cimslab.com
Phone: (9163 783-8525 | Toll-Free: (G00) 283-4267 | Fax: (916) 783-2090
Copyright @2001 CIMS Lab, Inc - All rights reserved Created 10/10/2003 1:28:53 PM

Figure 1-1  CIMS Server Web Reporting Home Page
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Using the Menu Bar

Using the Menu Bar

The menu bar enables you to easily navigate CIMS Server Web Reporting features. The
use of the links and menus contained on the menu bar are discussed in the following
chapters.

Figure 1-2 provides an overview of the functions of each of the links and menus on the
menu bar.

Click here to log on to the system Point here to view your favorite reports

Point here to access reporting features Point here for administrative options

| Point here to view Help

Help Logout Home

'h Spreadsheets Favorites Admin
Run Rports

¥iew Published Reports Click here  Click here to return
tolog out to the home page

Create a Report

Figure 1-2 « CIMS Server Web Reporting Toolbar

Changing Your Password

Note ¢ If you are a CIMS Web end user and are using auto logon, the information in
this section is not applicable. However, if you are a CIMS Web administrator using
auto logon, you can change the password of other users using the following steps.

Your CIMS Server administrator assigns user IDs and passwords using the CIMS Server
Administrator program. If the Change Password check box is present on the Login page,
you can change your password as follows:

1 Click Login to open the Login page.

2 Type your user ID, current password, and company or organization name (if
required).

3 Select the Change Password check box and then click OK.

4 On the Change User Password Page, type your current password and the new
password as directed. The password is alphanumeric and case-sensitive and can be
a maximum of 16 characters.

5 Click OK to change the password and return to the home page.

Your CIMS Server administrator determines whether the Change Password check box is
included on the Login page. For more information, refer to the CIMS Server
Administrator’s Guide.

CIMS Server Web Reporting User’s Guide 1-5 N
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Logging Off

Logging Off

Note ¢ If you are a CIMS Web end user and are using auto logon, this section is not
applicable. However, if you are a CIMS Web administrator using auto logon, you can
log on and off as other users during the same session.

To enable one user to log off and another to log on during the same session, click
Logout. The home page opens with the prompt Not currently signed in, please click
Login to begin. You cannot use CIMS Server Web Reporting until you log on.

Viewing Online Help

To view online Help, click Help.

Timing Out

B 1-6

If you are inactive for a period longer then the amount of time specified on the Edit
Configuration page (Admin » Configuration), the CIMS Server Web Reporting session
times out. If the session has timed out, one of the following occurs when you attempt to
perform another task:

m If you are a CIMS Web end user and are using auto log on, you are automatically
logged out and directed to Please Togin. Simply click Login to log on automatically.

m For all others, you are automatically logged out and are returned to the Login page to
log on again.

CIMS Server Web Reporting User’'s Guide
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Assigning CIMS Server Folder Security Permissions

Note ¢ Your CIMS Server or Windows administrator should have already set the
required folder security permissions described in this section. For more information,
refer to the CIMS Server Administrator’s Guide.

CIMS Web users must have the following security permissions for the CIMS Server
program folders shown. If CIMS Server is installed in the default location, the folders are
in C:\Program Files\CIMSLab.

Folder Required Permissions

Server Read & Execute
Server/Web/temp Full Control
Server/Reports/Published Read & Execute, Write

CIMS Server Web Reporting User’s Guide 1-7 N
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Running Reports

This chapter describes how to run reports in CIMS Server Web Reporting.

Note * For simplicity, the procedures in this section reflect commands in the Reports
menu. However, these procedures are also applicable to spreadsheets. For example,
if you are instructed to click Reports » Run Reports, the corresponding sequence for
spreadsheets is Spreadsheets » Run Spreadsheets.

Introduction tO REPOIt TYPES . .ouvnirieneiiiiiiieiiiiieitieeeeienececesencncacasencnnns 2-2
RUNNING REPOIES .. v ovitiiiiiiiiiiiiiititieieieeeteeeeeteeseseescsssssserstsssssscscnsnsns 2-2
Using Report Parameters ........... . e 2-4
AboUt ACCOUNt COUES . ...ttt e e e e e e 2-8
Example: Running a Report . ... ... . 2-9
Creating and Running CIMS Web User Created Reports .............ccoevviiiiiiiiiinn, 2-10
Creating or Updating a CIMS Web User Created Report ........... ... .. ... ... . ... 2-10
Running a Web User Created Report . ...... ... . i i 2-11
Deleting a Web User Created Report ........ ... ... i i 2-11
Example: Creating and Running a Web User Created Report ............ ... ... ... .... 2-12
Creating and Viewing Published REPOIS ........ccitiiiiiiiiiiiiiieiiiiieieiiccnenenenes 2-13
PUDIiShing RepOItS . . . ... e e 2-13
Creating Published Reports From a Batch Script .......... ... . ... . ... . .. .. 2-14
Viewing Published Reports . ...... ... .. i 2-15
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Introduction to Report Types

There are three types of reports that you can generate using CIMS Server Web Reporting:

m Standard or Custom Reports. CIMS Server includes a variety of standard reports,

including invoice, budget, summary, trend, and variance reports in report, graph, and
spreadsheet format (see Appendix A, Standard Reports). In most cases, your Crystal
Reports Developer will customize these reports for your organization or will create
new reports.

The report descriptions and examples used in this guide reflect the standard CIMS
Server reports. The parameters, look, and content of reports for your organization
might differ.

To run standard and/or custom reports, click Reports » Run Reports and follow the
steps in Running Reports on page 2-2

CIMS Web User Created Reports. These reports are created using report templates
that are supplied with CIMS Server Web Reporting (see Templates on page A-96) or
developed by your Crystal Reports developer. Template reports differ from the
standard or custom reports discussed previously in that CIMS Web users can create
reports that contain the data and format that they want directly within the CIMS
Server Web Reporting interface.

To create a report, click Reports » Create a Report and follow the steps in Creating
and Running CIMS Web User Created Reports on page 2-10.

Published Reports. These reports are created from generated reports. Publishing a
report enables other CIMS Web users to view the report with the data as it appeared
at the time the report was generated.

To publish a report, follow the steps in Creating and Viewing Published Reports on
page 2-13.

Running Reports

This section provides the steps for running a report from the CIMS Server Web Reporting
application. You can also run and publish reports in batch mode as described in Creating
Published Reports From a Batch Script on page 2-14.

m 2-2

To run a report:

1

Click Reports » Run Reports. The report page opens displaying reports categorized
by groups.

To expand the group, click + next to the report group that contains the report that you
want to run.

Links to the available reports appear. Click the link for the report that you want to run
as shown in example Figure 2-1 on page 2-3.
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Reports

= Invoices

Alternate Invoice {t”}

Invoice with Budget

Invoice with Shifts

Run Total Invoice with Drilldown
Run Total Invoice

Run Total Percent

Run Total Rate Group Percent
Zero Cost Center Invoice
Account Total Invoice

Invoice by Account Level ¥2

Account Reports
Top Usage Reports
Variance Reports
Trend

Resource Detail
Audit

Other

Figure 2-1 « Report Links

4 If the report requires parameters, enter the parameters on the parameters page and
then click OK to generate the report. For a description of the standard parameters
supplied by CIMS Lab, see Using Report Parameters on page 2-4.

You can do many things with the information in the generated report such as drill down
on data and print and save the report. For more information, see Chapter 3, Working with
Reports.

Note ¢ Drilldown is not available for graphs, spreadsheets, or CIMS Web user
created reports.

You can also publish the report so that others can view it in CIMS Server Web Reporting.
Published reports are saved with the data that was generated at the time the reports were
published. For more information, see Publishing Reports on page 2-13.
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Using Report Parameters

Table 2-1 provides a description of the report parameters that are supplied by CIMS Lab.

Your reports might use other parameters that are custom for your site. For information
about creating custom parameters, see Creating Custom Report and Transaction Parameters

on page 4-9.

The parameter values that you enter are stored in a cookie so that you do not have to re-
enter the values each time you run a report (unless you want to change the values).

Note ¢ Parameters vary by report.

Parameter Description

Audit Type

Calendar Period

Display Graph

From/To

Identifier

The type of changes that you want to
view in CIMS Client, Rate, and
Transaction table audit reports: all
changes, additions, updates, or
deletions.

The calendar period for the data that
you want to appear in the report.

If this parameter is Y (the default). a
graph appears before the report. If
this parameter is N, the graph does
not appear.

The beginning and end dates for the
data that you want to appear in the
report.

This parameter provides data by the
selected identifier. An identifier is a
unique key that denotes the source of
a resource that has been consumed
(for example, a device name, server
name, user ID, phone number).

Table 2-1 » Report Parameters

H 24
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Parameter Description

Invoice Level The account code level that you
want to view in the report. For
example, the account code
AABBBBCCC might contain three
levels: the two-digit company code
AA, the 6-digit division code
AABBBB, and the 9-digit department
code AABBBBCCC. The resource use
and charge data will reflect the level
that you select.

For more information about account
codes, see About Account Codes on
page 2-8.

Invoice Number Some invoice reports contain
separate invoices for the account
codes selected. If this parameter is
blank (the default), invoice
numbering begins with 1. Use this
parameter to begin invoice
numbering from a another number
(if needed).

Your CIMS Server administrator
determines whether this parameter
appears for invoices. If this
parameter is not available, the
invoice number set in the CIMS
Config Options table in the database
is used and invoice numbers
continue to increase sequentially
each time you run an invoice. For
example, if the last invoice in a
report was 99, the next invoice that
you run will begin with invoice
number 100. For more information,
refer to the CIMS Server
Administrator’s Guide.

Prorate The amount that you want to prorate
across accounts in proration reports.

Rate Code This parameter provides data by the
selected rate code. A rate code
represents resource units consumed
(for example, CPU time used, pages
printed, e-mail message sent).

Table 2-1  Report Parameters (continued)
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Parameter Description

Rate Group This parameter provides data for the
selected rate group. A rate group
contains rate codes.

Report Month The month for the data that you
want to appear in the report.

Report Year The year for the data that you want to
appear in the report.

Set the Date Range The range of time for the data that
you want to appear in the report.

Start and End Value The starting and ending identifier
value.

Starting and Ending This parameter works in conjunction

Account Code with the Invoice Level parameter and
specifies the account codes for that
level that appear in the report.

If you want all account codes for that
level to appear in the report, click
Lowest Possible Account for the
starting account code and Highest
Possible Account for the ending
account code.

If you want specific account codes,

click the appropriate start and end

codes or click Custom and type the
start and end codes.

Transaction ID Start This parameter provides data by the

and End selected CICS transaction ID range.
For example, if you want data for the
following three transaction IDs:
CESF, DEGYV, and TINQ, type CESF
as the start and TINQ as the end.

TopN This parameter specifies the number
of account codes that appear in a
report or the drilldown for a report.
For example, if you type 1, only the
account code that used the most
resources or incurred the most
charges appears. If you type 2, the
highest and second highest account
codes appear.

Table 2-1  Report Parameters (continued)
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Parameter Description

Transaction Type This parameter provides data for the
selected transaction type. For more
information about transactions, see
Chapter 5, Using Transactions.

Zero Cost Processing The Zero Cost Invoice report may be
Option processed in two different ways:

m A-Factor Total. This factors the
invoice total by the zero cost
amount.

m B-Factor Rates. This factors each
resource rate by the zero cost
amount.

Zero Cost Amount The zero cost amount. You can type
this amount with our without the
decimal point. For example, 100000
or 100000.00. For more information
about zero cost, refer to the CIMS
Server Administrator’s Guide.

Table 2-1 « Report Parameters (continued)
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About Account Codes

An account code is an alphanumeric string that identifies the hierarchy of a resource
record. Account codes contain sufficient information to describe what resource was used
by what entity. These codes may contain levels such as Company, Division, Cost Center,
etc.

For example, if your organization cost center structure is:

Level 1 Company

Level 2 Division

Level 3 Department within division
Level 4 Cost Center within department
Level 5 Application within cost center

Your account code structure might be designed as shown in Table 2-2.

DESCRIPTION (LEVEL) EXAMPLE

Full Account Code AABBBBCCCDDDAPP1
Company Code AA

Division Code BBBB

Department Code CCcC

Cost Center Code DDD

Application Code APP1

Table 2-2 « Example Account Code Structure

The account codes and account code levels that appear on the parameters page are set by
your CIMS Server administrator. For more information, refer to the CIMS Server
Administrator’s Guide.
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Figure 2-2 provides an example of the parameters used to create an Invoice by Account
Level report for the month of June. Figure 2-3 shows the resulting report.

2l CIMS Server - Invoice by Account Level Report Submission - Microsoft Internet Explorer.

Yiews  Favorites  Tools

File  Edit

Help

Qe - © @ @ _h ) search \iE’Favnr\tas @ reds €8 (- :\‘

<] 3

CIMS

Server

Login

fdldress | &) hitp s, cimsserver, com{Tadhcrpt aspreport=18repartname=Inyoice%20by T 20ACEouNt 0L

I 007.rpt

Links >

len

Reports Spreadsheets Favorites

Please select parameters for repart

Invoice Level: [Division, length 2 v
Invoice Number: [20 |
Display Graph:

Starting Account Code:

Admin

Help  Logout

Invoice by Account Level Report Submission for User: John Q. Customer

| [Lawest Possible Account

Ending Account Code: [zzzzzzzz

| [Fighest Fossible Account

Set the Date Range: |This Manth v
From:

K

b

Home

&l

B Internet

Figure 2-2 « Example Parameters for the Invoice by Account Level Report

File Edit View Favorites  Tools

2l CIMS Server - Microsoft Internet Explorer

Help

Q- O ¥ @ & ) search 57 Favories @ ede £2)

X
w

Invoice by Account Level

| % & @fm=fiove <] || 1 4]

Preview |

1 of 1+

Publish

Address (] hktp:/fum,cimsserver.comjreptescec. sspPInvoicel svel=1 adnvoiceNumber—18Graph=hEAccount CodeStart=-+rboAccount Codestart=+iccountCodeEnd=zzzezzzzzatiel ¥ | [£3 Go

Return

Links **

CIMS Lab, Inc. Gibbsbora
CIMS Lab, Inc. Laurel
CIMS Lab, Inc. International
CIMS Lab, Inc. Services

Invoice

Big Time Company

Invoice No. 1
Billing Period: 6/1/2002 to 6/30/2002

Corporate Headquarters
2013 Douglas Blud.

Suite 120
L l 1 Roseville, CA 95661 Date range SEIEdEd
evel
——— AA - CIMS | ab, Inc. Roseville
an - LIVioLab, Inc. hosewville
account codes
3013 Douglas Boulevard, Suite 120
Roseville, CA 95661-3842
ATTN: CIMS Lab Administrator
Units Rate Charge
©5/390 Jobs Started 2,692 250000000 7,230.00
05/390 Steps Started 13,431 0,50000000 6,745.50
©5/390 Cpu Minutes 432,50 20, 00000000 £,650.28
©5/390 Cpu Mirutes (Initistors) 656 0, 00000000 0.00
©5/390 Cpu Minutes (4ll) 485,23 0,00000000 0.00
Total 0S/3290 Batch charges 22,625.78
< 3 |
A
&) Done #® Internet

Figure 2-3 « Example Invoice by Account Level Report

CIMS Server Web Reporting User’s Guide

2-9 N



B Running Reports

Creating and Running CIMS Web User Created Reports

Creating and Running CIMS Web User Created Reports

This section describes how to create and run reports using the report templates provided
by CIMS Lab. Note that templates created by your Crystal Reports developer may differ.

Creating or Updating a CIMS Web User Created Report

B 2-10

The report templates provided by CIMS Lab enable you to choose the rate codes that you
want to appear in the report. You can specify that the report display the resource usage
per rate code, the resource cost per rate code, or both usage and cost. All cost and usage
is displayed by account code and rate code. Once you have created a report, you can
update the report (for example, select different rate codes) at any time.

To create or update a report:

1 Click Reports » Create a Report. The Build a Report page opens.

2

Enter or update the following parameters for the report:

Go to Report. Click New Report to create a new report or click an existing report
to update the report.

Report Type. Click the report type that you want to create:

* Resource (resource usage by account and rate code description)

e Cost (charges by account and rate code description)

e Both (resource and cost information)

Report Name (required). The name that you want to assign to the report.
Report Description. A brief description of the report.

Make visible to all users. If this check box is not selected (the default), the report
is available only to those in your user group. If this check box is selected, the report
is available to all CIMS Web users.

Resource. In the column select boxes, choose the rate code that you want to
appear in that column. You can choose up to four columns/rate codes for Both
reports and eight columns/rate codes for Cost or Resource reports.

Decimal Places. Type the number of decimal digits that you want to appear in the
resource usage amount.

3 Ifyou are creating a new report, click Add. If you are updating a report, click Update.

Once created, reports appear on the Reports page (Reports » Run Reports) under a
report group determined by your CIMS Server administrator (see Figure 2-4 for an
example). For more information about setting the report group for these reports, refer to
the CIMS Server Administrator’s Guide.
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Running a Web User Created Report

To run a report:

1 Click Reports » Run Reports. The Reports page opens displaying reports categorized
by groups.

2 Expand the report group that contains the created reports, and then click the report
that you want to run as shown in example Figure 2-4.

Reports
Invoices
Account Reports
Top Usage Reports
Variance Reports
Trend
Resource Detail
Audit
Other
= web User
CPU Cost Report
Storage Resources Report
)

Figure 2-4 « Example Links for Web User Created Reports

3 Enter the parameters for the report on the parameters page and then click OK to
generate the report. For a description of the parameters, see Using Report Parameters
on page 2-4.

You can do many things with the information in the generated report such print and save
the report. For more information, see Chapter 3, Working with Reports.

You can also publish the report so that others can view it in CIMS Server Web Reporting.
Published reports are saved with the data that was generated at the time the reports were
published. For more information, see Publishing Reports on page 2-13.

Deleting a Web User Created Report

To delete a report:
1 Click Reports » Create a Report.

2 On the Build a Report page, click the report in the Go to Report select box.

3 Click Delete and then click OK in the confirmation dialog box to delete the report.
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Example: Creating and Running a Web User Created Report

Figure 2-5 shows the creation of a Both report called Job Report. Figure 2-6 shows the
resulting report that has been run from the Reports menu.

<) CIMS Server - Build a Report - Microsoft Internet Explorer,

Filer

Edit

Views  Favorites  Tools  Help

Qo - ) ¥ B i Ooewch Frroonss @vede €2) (- 2 @ - 3
fddress | ] http: | fuwas. cimsserver. com|Define CustSumRpts., asp?OUtpULType=RaReset=true

CIMS

Server

v B ks ?

Login Reports Spreadsheets Favorites Admin  Help Logout Home

Build a Report

Please select parameters for Report
Go to Report: | (new Report)
Report Type: |Both v

Report Name: | Johb Report ‘

Report Description: |

[Imake visible to all users

Resource Decimal Places
Column 1: 2001 - 05/330 Jobs Started v
Column 2: [ 2003 - 05/390 Cpu Minutes v|
Column 3: | v|
Column 4: | v|

Add

&) 4 Internet

Figure 2-5 » Example—Creating a Report

3 CIMS Server, - Microsoft Internet Explorer

File Edit View Favorites Tools  Help '

.
A A B
- 7 @) 3 D | -k
@aack ) @ @ h ) search g ravories @ rede ) (- L 3B
Address | ] http: | fuwaw, cimsserver.com|reptexec, asp?Invaicel evel=1&Accaunt CodeStart=+acboAccount Codestart countCodeEnd=zzzzzzzzzztchofccauntCodeEnd=zzzzzzzz: ¥ | [og 6o  Links
Job Report Publish Return Help &
& &g oz~ 1 of 1+ > oM h .
Preview |
% Inc ] ~
% CIMS Lab, Inc. Gbbsbora
#-CIM5 Lab, Inc. Laurel b |
% CIMS Lab, Tnc. Tnternationsl
% CIMS Lab, Tnc. Services
Job Report Fram:
To:
Account 05/390 Jobs 05320 Jobs 05390 Cpu 057390 Cpu
Started Started Cost  Minutes Minutes Cost
RA-CIME Lab, Ine. Roserile
Z,592.00 7,23.00 TS0 5,650.25
BE-CIMS Lab, Ine. Gibbsboro
1,715.00 4,267.50 126,20 2,528.24
CC-CIMS Lab, Tno. Laurel
544,00 1,360.00 218,27 4,365.25
DD-CIMS Lab, Ine. International
266,00 565,00 32.46 649,12
EE-CIMS Lab, Inc. Services
129.00 322,50 .oz .49
v
] ]
-
@ Done ® Intemet

Figure 2-6 « Example Web User Created Report

H 2-12 CIMS Server Web Reporting User’'s Guide



Running Reports H
Creating and Viewing Published Reports

Creating and Viewing Published Reports

Once you have generated a report, you can publish the report. Publishing a report
enables other CIMS Web users to view the report without having to regenerate it. You
cannot change the data in published reports.

Note ¢ Reports that involve a wide range of dates or account codes can require
excessive system time and resources to generate. Consider publishing or saving these
reports for quicker access (see Publishing Reports vs. Saving Reports).

Published reports can be created directly within CIMS Server Web Reporting or
automatically via a batch file (see Creating Published Reports From a Batch Script on
page 2-14).

Publishing Reports vs. Saving Reports

Both publishing and saving a report saves a report that you have generated. However,
publishing a report saves the report in .rpt or .x1s (for a spreadsheet) format on the
Web server so that you and others can view it from within CIMS Server Web Reporting.
(Your CIMS Server administrator determines where the published reports are stored on
the server. For more information, refer to the CIMS Server Administrator’s Guide.)

Saving a report saves the report to the local or network drive that you choose in the
format that you choose. In this case, the report is not accessible via the CIMS Server Web
Reporting interface. For more information about saving reports, see Saving Reports on
page 3-8.

Publishing Reports

To publish a report:
1 Run a report.

2 On the report page, click Publish. The Save Report window appears. Enter the
following:

e Report File. The file name of the published report. You can use the default file
name or type another name. If you want to include the report in your favorites list,
you need to use the default file name (see Working with Favorite Reports on
page 4-2).

* Location. Location specifies the subfolder name for the published reports within
the overall published reports folder. For example, if you click User, the published
reports are stored in the user subfolder within the published reports folder.
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Location also determines the accessibility of the report as follows:

e User. The report is available to the specified user only. If you are a CIMS Web
administrator, you can choose any user ID within your user group. If you are not
an administrator, the user defaults to your user ID.

e Group. The report is available to those in your current user group.

e Account. The report is available to CIMS users in a group that is allowed to view
the selected client account code. (To enable client account code access to a
group, refer to the CIMS Server Administrator’s Guide). The report is stored in a
subfolder with the same name as the account code that you click in the account
list. The Account option appears only if you are a CIMS Web administrator.

* Global. The report is available to anyone using CIMS Server Web Reporting. The
Global option appears only if you are a CIMS Web administrator.

Note ¢ The preceding access permissions are applicable only within CIMS
Server Web Reporting—it does not affect the ability of Windows users to access
reports from the hard drive. If you want to control access to reports via
Windows, you need to set Windows security for the folders that contain the
published reports. CIMS Web users, however, must have the permissions
shown in Assigning CIMS Server Folder Security Permissions on page 1-7.

e Reporting Period. The date period assigned to the report for storage and retrieval
purposes. This date period does not affect the date of the data in the report.

e Replace Existing Report. Select this check box to replace any existing published
report with the same file name with this report.

3 Click OK to publish the new report to the location that you specified.

Creating Published Reports From a Batch Script

The CIMS Server administrator can use the BatchReport.wsf script to run and publish
reports in batch mode and direct the reports to the proper locations within the published
reports folder. If CIMS Server is installed in the default location, this script is in
C:\Program Files\CIMSLab\Scripts\Batch Reporting. For more information about this
script, refer to the CIMS Server Administrator’s Guide.
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Viewing Published Reports

Note  Links to published reports that are designated as favorite reports appear in
the left side of the home page. Click these links to quickly access these reports. For
more information about favorite reports, see Working with Favorite Reports on page 4-2.

To view a published report:
1 Click Reports » View Published Reports.

2 The Published Reports page opens. The reports that appear on this page are
determined by the location that was set when the report was published (see Publishing
Reports on page 2-13) and the Date Range and Location parameters on the page (see
Filtering the List of Published Reports on page 2-16).

3 Click the report date, name, or location (if present, see the following note) to open
the report.

Note ¢ By default, published reports include the full path to the folder that
contains the report. You can choose to show or hide the path (see page 4-5).

You can drill down on some items in a published report (see Drilling Down in Reports on
page 3-5).
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Filtering the List of Published Reports
You can filter the list of published reports using the Date Range and Location
parameters as follows.

Date Range This parameter lists reports by the reporting period that was assigned
when the published report was created (see Publishing Reports on
page 2-13). This may or may not be the date of the data in the report.

From and To Enter the beginning and end date of listed reports if you cannot select the
date that you want from Date Range.

Click the Calendar button to choose a beginning or end date for listed

reports.

Location Click one of the following:
m All. All published reports that the user can view appear.

m Global. All published reports that were assigned to a Global location
appear.

m User. All published reports that were assigned to a User location that
the user can view appear.

® Group. All published reports that were assigned to a Group location
that the user can view appear.

B Account. All published reports that were assigned to an Account
location appear. If you click a specific account code, published reports
for only that account code appear.

Sorting the List of Published Reports
To sort the list of published reports by date or report, click Date or Reports, respectively.
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Example: Creating and Viewing a Published Report
Figure 2-7 shows the creation of a published Invoice by Account Level report.

Figure 2-8 shows the link for the resulting report on the Published Reports page
(Reports » View Published Reports).

2 CIMS Server - Microsoft Internet Explorer

Save Report Invoice by Account Level

Please set parameters to save report

Repart File: ot

Location

@® User adrmin v
Ocrap (e ]
O sccount Al v

QO clobal

Reporting Period: Current 6/1/2003-6/30/2003 v

[JReplace existing Repart?

OK | Cancel |

Figure 2-7 « Example—Creating a Published Report

] http:/fiwww.cimsserver.com/Tsavedcntl.asp?select=1 - Microsoft Internet Explorer

File Edit View Favorites Tools  Help

Qe - ) ¥ B i Ooech Glproonss @hrede € (- L - 3

Aicdress @) hitp: fuwn. cimsserver com/Tsavedentl, asprselect=1 VB ks ?

CIMS

Server

Login Reports Spreadsheets Favorites Admin  Help Logout Home

Published Reports

Date Range: Current 6/1/2003 6/30/2003 v Location: | all v
From: 2003 v

Date Reports Location
5/502003 10.53.20 A \voice by Account Level ‘i cimsserver comiC. Program Files\CIMSLab\Server Reporls\Publishediuser test QD0306 Reportsrimvel7 rgt
&) ® nternet

Figure 2-8 « Example Published Report Link
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Working with Reports

This chapter describes how to navigate and use generated reports.

Working With REPOIES ....viuiiiiiiiiiiiiiiiiiiiiiiiitiiiieieneieneiesecncncncscnanenes 3-2
About the Report Interface . ... . 3-2
Using the Reporting Toolbar ....... ... ... . . . 3-3
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SaVING REPOMS . . ..o 3-8
Copying Text From a RepoOrt ... ... . o e 3-8
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Working with Spreadsheets in Microsoft Excel ............ ... ... .. ... ... 3-10
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Working with Reports

This section describes how to navigate and use reports. Except where noted, the
information in this section is applicable to all report types.

About the Report Interface

Figure 3-1 provides an introduction to the report interface. The use of the interface,
including how to use the toolbar, is discussed in the following sections.

Click here to return to the report parameters page

Click here to publish the report

2 CIMS Server - Microsoft Internet Explorer

Click here for Help

File Edt View Favorites Tools Help 7
@ Back - \ﬂ @ lJ /(f'i Search ' Favorites @ e ) - & By
Adcress @] http: fewa,cimsserver.comfreptexec. aspInvoicel evel=18dnvoic ph countCodestart=-+&rboAccdunt Codestart counfCodeEnd=zzezzazezetd v | EJ G0 Links >
Invoice by Account Level Publish Return
& &g oz ~ 1 of 1+ > oM & .
Preview ] 05/330 Jobs Started | 05/390 Cpu Minutes (A1) |
e ¥ i
38 CIMS Lab | ] ~
%1 CIMS Lah, Inc. Gibbshara =
- CIMS Lab, Inc. Laursl
- CIMS Lab, Inc. Inkernational
- CIMS Lab, Inc. Services
- Invoice No. 1
Invoice Billing Period: 6/1/2002 to 6/20/2002
Big Time Company
Corporate Headquarters
3013 Douglas Blvd.
Suite 120
Roseville, CA 05661
AA - CIMS Lab, Inc. Roseville
3013 Douglas Boulevard, Suite 120
Roseville, CA 95661-2842
ATTN: CIMS Lab Administrator
Units Rate Charge
©5/330 Jobs Started 2,892 2,50000000 7,230.00
©5/330 Steps Started 13,491 0,50000000 6,745.50
©5/350 Cpu Minutes 432,50 20, 00000000 8,650.28
©5/390 Cpu Minutes (Initiators) 6.56 0.00000000 0.00
©5/350 Cpu Minutes (All) 485.23 0,00000000 0.00
Total OS/3290 Batch charges 22,625.78
o i) 3 |0
™
&) Done B Intemet
L
Group tree  Tabs for open drilldown views

Figure 3-1 « Report Interface
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Using the Reporting Toolbar
This section provides an overview of the report toolbar options.

Closing the Detailed View

To close a drilldown view (see page 3-5), click the Close button. Note that this button is
available only at the drilldown level.

T & %= oo =] || K 4 2 ozt > M om |

Close button

Printing a Report
To print a report, click the Print button.

X TE % [0 =] || M 4 2 o2+ > M om || g4

Print button

Saving a Report

To save a report, click the Export button. For more information about saving reports, see
page 3-8.

X & @]&EIMD% IR 2 o2+ > M om || g4

Export button

Navigating Reports

To navigate through the pages of a report, click the page arrows or type a page number.
To open and close the Group Tree that appears to the left of the report, click the Toggle
Group Tree button. For more information about the Group Tree, see page 3-5.

X & @/’?ﬂmu% UH TI ZI of 24+ T M = “ dh

Toggle Group Tree  Go to first page  Go to previous page Type a page no. Gotonextpage  Go to last page
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Zooming In or Out

You can enlarge or shrink the size of information displayed in a report. In the Zoom
select box, click the appropriate selection to reduce or enlarge the size of displayed
information.

X & k%[ o] || 4 4 2 of 2+ > M o= ||
/

Zoom select box

Stopping a Report from Loading

To stop a report from loading, click the Stop Loading button. This button is only
available when the report is loading.

X & %m0 o] || 4 4 2 of 2+ 2 N/- | 4

Stop Loading button

Searching Text in a Report
To search for text in the report, click the Search Text button.

X & @Ehuu% - |J M 4 Z of 24 b M m |J|ﬁ

Search Text button /
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Navigating Using the Group Tree

The Group Tree appears in the Preview tab to the left of the report (see Figure 3-1 on
page 3-2). This tree view enables you to navigate down to data.

Note ¢ If the Group Tree does not appear, click the Toggle Group Tree button

Similar to the manner in which Windows Explorer displays folders and files, items in the
report are listed in the Preview tab as an expandable hierarchy.

To view the item in the report, click the item. To expand or collapse an item, click the +
or - beside the item.

Drilling Down in Reports

For certain items in a report, you can drill down to view information specific to that item
or you can drill down to generate a separate report for the item. For example, in invoices,
you can drill down on resource units to open a report that breaks out the units by
identifier (see Report Drilldown Example on page 3-6).

To drill down in a report:
If the cursor icon becomes a magnifying glass O\ when you point to an item in a report, you
can drill down to more detailed information about that item.

1 Place the cursor on the appropriate item in the report. For example, a rate or charge.

2 Double-click the item. Detailed information about the item appears.

3 You can continue to drill down where allowed to view additional detailed
information.

To drill down to another report:

If the cursor icon becomes a hand J\b when you point to an item in a report, you can drill down
to another report for that item.

1 Place the cursor on the appropriate item in the report. For example, an account code
oI resource units.

2 Click the item. Depending upon item that you click, the report either appears in the
same browser window or in a separate window. It the report opens in a separate
window, the parameters page for the report appears first.

Note * Drilldown to another report is available only in invoice reports.
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To close the drilldown view (same window):

Click the close button & on the report toolbar or right-click the drilldown view tab and
then click Close Current Drill Down View.

To close a drilldown report in a separate window:

Click the close button in the browser window @

Report Drill Down Example

The drill down example shown in example Figure 3-2 shows a drill down on resource
units.

72 CIMS Server, - Microsoft Internet Explorer, r__”'ilg‘

File Edt View Favortes Toos Help o
. ) A 7) A = 24

Qe - O - ¥ @ & ) gearch ¢ Favarites @ edia 7) p= 3

£l (@) hitp o, cimsserver comjrepexec  ssp?Involcel evel=1 adnvoiceMumber=18Graph=NAccount CodeStart—+achnAccount CodeStart—+uccountCodeEnd—zezezzzzateel @ | EJ o Liks ™
Invoice by Account Level Publish Return Help e

B &[T =] | M A s b Mo | &
Preview |

A

Gl CIMS Lab, Inc Hor
- CIM3 Lab, Inc. Laurel

- CIM3 Lab, Inc. International
- CIMS Lab, Inc. Services

- Invoice No. 2
Invoice Billing Period: 6/1,/2003 to 6/30,/2003

Big Time Company
Corporate Headquarters
2013 Douglas Blud.
Suite 120

Roseville, CA 05661

BB - CIMS Lab, Inc. Gibbsboro

Units Rate Charge
©8/390 Jobs Started 1,715 2,50000000 4,287.50
051390 Steps Started 3,555 0.50000000 1,772.50
©8/390 Cpu Minutes 1251 20.00000000 2,524.24
©5/330 Cpu Minutes (Initiators) .64 0.00000000 0.00
©8/390 Cpu Minutes (A} 130.73 0.00000000 .00
[os/290 Batch charges §,569.24
Tso Cpu Minutes 12.03 25.00000000 300.83
Tan Cnnneet Minites 71.7R0.91 N 25nnnnnn 17.R77 4R b
I
b
&) Done ® Internet

Figure 3-2 « Drill Down on Units

The parameters page for the drilldown report opens as shown in example Figure 3-3 on
page 3-7. This page enables you to break down and view the resource units by identifier
or identifiers.

Note that the possible identifiers that you can select include Usage Dates and
Accounting Dates. Usage dates are the actual start and end dates in the CIMS Server
Resource Records. Accounting dates are derived from the usage end date as described in
the CIMS Server Administrator’s Guide.

In Figure 3-3, the identifier Usage Dates and Jobname are selected.
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-2) CIMS Server - Reports Submission - Microsoft Internet Explorer,

File Edit View Favorites Tools  Help

3 = A L e =
O © B B G P formee @ue @ 3% 8- B
Aclcress | €] hitpe s, cmsserver.comdetident. aspPreportfie—IINXCD04 rptareport ID=0BAccountC odeStart=BBTIateStart=t/120038DateEnd=5/30{20035R ateCode=Z0025R: ¥ | [ Go

Links **

Drilldown Submission for User: John Q. Customer

Please select parameters for report

Identifier 1: | Usage Dates

Identifier 2: | lobname

Identifier 3: | **Optional**

Identifier 4: | **Optional**

] S

Identifier 5: | **Optional**

ﬁ

&) Done ® Intermet
=

Figure 3-3 « Select Report Parameters

Figure 3-4 shows the resulting report. The units are broken down by usage dates (in this

example, there is only one usage date range) and job names.

2 CIMS Server - Microsoft Internet Explorer EHE|E\
J"n

File Edit View Favorites Tools Help

Q- O HEG ) search e Favares @ rese €2) - :_\; - L) S

fcldress | &) hiktp s, cimsser ver, com rephexec2, asprident1 =999- Usage + Datesaddentz=4-Jobnamesddent 3=05ddent4=08ddentS=08submit, x=378submit y=7 v| B

I Publish Return Help

& &Iz | [ 1 oof1+ > M dh

Preview |

0S5/390 Steps Started for BB - CIMS Lab, Inc. Gibbshoro
From 6/1/2003 te 6/30/2003

Usage Dates
Jobname

5/25/2003-6/8/2003
CHMMPROC
CHMPSEI
DB21DEML
DB21MSTR
DB215PAS
FTPD1
IRLMPROC
(oL}
TCPIP
TS0

5/25/2003-6/8/2003

[ [ T

-

Links »

A

~

{59

&) Done #® Internet

Figure 3-4 « Drilldown by Identifier Report
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Publishing Reports

See Publishing Reports on page 2-13.

Saving Reports

Note ¢ Saving a report is distinct from the process of publishing a report. Saving a
report saves the report to a local or network drive. When you save a report, users can
access the report from this location. When you publish a report, users can access the
report directly from the CIMS Server Web Reporting application. For more
information about published reports,see Creating and Viewing Published Reports on
page 2-13.

CIMS Server Web Reporting enables you to save reports that you generate so that you or
other users can access the report again without regenerating the report. For example, if
you run a daily report that others need to view, you can generate the report each day and
save it in an accessible drive or folder.

Note * Reports that involve a wide range of dates or account codes can require
excessive system time and resources to generate. Consider publishing or saving these
reports for quicker access.

To save a report:

1 On the report page, click the Export button on the report toolbar .

2 In the Report Viewer Export dialog box, enter a path and file name for the export file.
If you want to share the saved report with others, choose a network drive.

3 If you want to save the report in a format other than the default, click the format in
the Save as type box.

4 Click Save. The system saves your report and asks if you would like to open the saved
report. If you click Yes, the report opens in the appropriate program for the format
you selected.

Copying Text From a Report

To copy an item in a report, right-click the item, and then click Copy. The system places
the text in the Windows clipboard, enabling you to paste the text into other applications.
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Working with Spreadsheets

This section describes how to use CIMS Server spreadsheets. When you run a
spreadsheet, CIMS Server Web Reporting presents the report data in Microsoft Excel. You
must have Excel installed on the client running the spreadsheet.

About the Spreadsheet Interface

Figure 3-5 provides an introduction to the spreadsheet interface. You can view and/or
publish the spreadsheet from this interface or you can open the spreadsheet in Microsoft
Excel and save, print, and/or edit the spreadsheet.

(lick here to return to the spreadsheet parameters page
Click here to publish the spreadsheet

Click here to open the spreadsheet in Excel Click here for Help

/3 CIMS Server - Microsoft Internet Explorer

File Edit Wiew Favorites Tools  Help
O Back * |£| IELI _‘I‘J ) search 7 Favorites @ Medis ) =S 32
&) http:fjwww.cimsserver.comfreptexec. asp?InvoiceLevel=18AccountCodeStart=-+&cbaAccountCodeSthrt=-+&Account CodeEnd hoAccountCad
Spreadsheet Invoice Open with Publish Return Help b
Excel
1311 =0
A B € D E F G H I J K [oni

1 |AccountMame AccountCode RateCode RateDescripti RateGroup GroupTitle StartDate EndDate Resourcelnits Ratevalue Peri0oQ Money ™
2 |CIMS Lab, IniAA Zool 0S5/390 Jobs 2 05/390 Batch 6/1/2003 6/30/2003 2,632.00 2.50 7.2

3 |CIMS Lab, Iniaa Z0o0z 05/390 Steps 2 0S/390 Batch 6/1/2003 6/30/2003 13,491.00 0.50 8,7

4 |CIMS Lab, IniAA Z0n03 05/390 Cpu I 2 05/390 Batch 6/1/2003 6/30/2003 432.50 20.00 8,5

5 |CIMS Lab, IniAa Z03z 05/390 Cpul 2 0S/390 Batch 6/1/2003 6/30/2003 6.56 0.00

B |CIMS Lab, IniAA Z033 05/390 Cpu I 2 05/390 Batch 6/1/2003 6/30/2003 485.23 0.00

7 |CIMS Lab, Iniaa Zozo Tso Cpu Ming 3 0S/390 Tso 6/1/2003 6/30/2003 2049 25.00 E

g |CIMS Lab, Ini A ZZ04 Tso Connect | 3 05/390 Tsa 6/1/2003 6/30/2003 48,117.62 0.25 12,0

9 |CIMS Lab, IniAa Z0z1 Tso Inputs 3 0S/390 Tso 6/1/2003 6/30/2003 63,130.00 2.00 M 1
10 |CIMS Lab, IniAA zZnzz Tso Outputs 3 05/390 Tsa 6/1/2003 6/30/2003 71,276.00 1.00 M

11 |CIMS Lab, IniAA Z035 Tso Cpu Ming 3 0S/390 Tso 6/1/2003 6/30/2003 0.24 0.00

12 |CIMS Lab, IniAA Z036 Tso Cpu Minu 3 05/390 Tsa 6/1/2003 6/30/2003 22.09 0.00

13 |CIMS Lab, IniaA Z00s Total SI10s 5 0S/390 Input 6/1/2003 6/30/2003 48,907 ,877.00 0.00

14 |CIMS Lab, IniAA Zn06 Disk 510z 5 05/390 Input 6/1/2003 6/30/2003 29,379,287.00 0.25 M 7,3
15 |CIMS Lab, IniaA Z007 Tape S10s 5 0S/390 Input 6/1/2003 6/30/2003 19,528,580.00 0.35 M B8
16 |CIMS Lab, IniAA Zni4 Input Record: 6 O5/390 Printe 6/1/2003 6/30/2003 617,063.00 1.00 M [
17 |CIMS Lab, IniAA ZZ05 Tape Mounts 7 0S/390 Stora 6/1/2003 6/30/2003 3,835.00 0.00

18 |CIMS Lab, IniAA ZZ06 Disk Data Sel 7 05/390 Stora 6/1/2003 6/30/2003 36,373.00 0.25 3,0
13 |CIMS Lab, IniAA ZZ33 DBZ Transact 10 05/390 DBZ 6/1/2003 6/30/2003 i7.00 0.0z

20 |CIMS Lab, IniAA ZZ34 DB2 Transact 10 05/390 DB2 6/1/2003 6/30/2003 0.27 0.15

21 |CIMS Lab, IniAA LLAL01 Unix disk I/O 12 Unix interacti: 6/1/2003 6/30/2003 5147 0.10

22 |CIMS Lab, IniAA LLA10Z Unix characts 12 Unix interach 6/1/2003 6/30/2003 36,095.35 0.00 M

23 |CIMS Lab, IniAA LLALOS Unix image it 12 Unix interacti: 6/1/2003 6/30/2003 1,975.81 0.09 1
24 |CIMS Lab, IniAA LLA104 Unix connect 12 Unix interach 6/1/2003 6/30/2003 583.70 0.10

25 |CIMS Lab, IniAA LLALO0S Unix user CPL 12 Unix interacti: 6/1/2003 6/30/2003 25.90 0.01

26 |CIMS Lab, Iniad LLALOG Unix system « 12 Unix interach® B/1/2003 6/30/2003 9.07 0.02

27 |CIMS Lab, IniAA LLAL07 Unix total CPL 12 Unix interacti: 6/1/2003 6/30/2003 34.97 0.03

20 |CIMS Lab, IniAA LLALOS Unix mermary 12 Unix interach 6/1/2003 6/30/2003 6,249 ,668.85 0.00 M

23 |CIMS Lab, IniAA LLAL09 Unix image cq 12 Unix interacti: 6/1/2003 6/30/2003 17,087.00 0.0z 3,
W[ 4[» [M}SINVCOOLrpt / || N

v
L& Done B Internet

Figure 3-5 « Spreadsheet Interface

Publishing Spreadsheets

See Publishing Reports on page 2-13.
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Working with Spreadsheets

Opening a Spreadsheet in Excel

To open a spreadsheet in Excel:
Click Open with Excel.

The spreadsheet opens in Excel within the Web browser. You can then save, print, and/
or edit the spreadsheet using the Excel commands and toolbar.

If the Excel toolbar does not appear, click the Tools button % on the browser toolbar.

Working with Spreadsheets in Microsoft Excel

B 3-10

To save a spreadsheet:

1 Click File » Save As on the browser menu bar.

2 Navigate to the folder that you want to save the file in, and then enter the file name
and file type in the File name and Save as type select boxes.

3 Click Save to save the file to the location you selected.

Note * You need to click Save As each time you want to save the spreadsheet.
Clicking the Save button on the Excel toolbar will not save the spreadsheet.

For more information about the benefits of saving spreadsheets rather than regenerating
them, see Saving Reports on page 3-8.

To print a spreadsheet:

1 Click File » Print on the browser menu bar or the print button on the Excel toolbar.

To edit a spreadsheet:

Edit the spreadsheet as required and then follow the steps in To save a spreadsheet:.

To close a spreadsheet in Excel:

Click Back to return to the CIMS Server Web Reporting spreadsheet interface.

Note * Any changes you made to the spreadsheet while the report was open in Excel
are not saved in CIMS Server Web Reporting.
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Administering CIMS Server
Web Reporting

This chapter describes user-specific and system-wide configuration settings for CIMS
Server Web Reporting. It also provides information about creating custom report
parameters.

Note ¢ For simplicity, the procedures in this section reflect commands for reports.
However, these procedures are also applicable to spreadsheets. For example, if you
are instructed to click Favorites » Add » Reports, the corresponding sequence for
spreadsheets is Favorites » Add » Spreadsheets.

Configuring User-SpecificSettings ...........cooiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiieae, 4-2
Working with Favorite Reports . ... 4-2
Showing or Hiding Folder Paths for Published Reports ........... ... ... ... ... .. ..., 4-5
Choosing a Crystal Report VIEWer . .. ... e e 4-6
Configuring System-Wide Settings ........cooiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiieienenenens 4-7
Creating Custom Report and Transaction Parameters ............cocoiiiiiiiiieieieiennnnes 4-9
Creating Parameters USING ASP . .. ... . i e e 4-9
Creating Parameters Using Parameter Fields .............. ... .. ... ... ... oo i i, 4-9
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Configuring User-Specific Settings

Configuring User-Specific Settings

Working with Favorite Reports

B 4-2

The settings described in this section can be different for each CIMS Web user. These

settings are not applied system wide.

You can use the Favorites feature to create shortcuts (maximum of five) to reports that

you frequently access.

Note « When you add a report as a favorite, any published reports created from that
report are also automatically included as favorites if the default file name was used
when the published reports were created (see Publishing Reports on page 2-13). If a file
name other than the default was used for a published report, the system will not add
the report as a favorite and you cannot add the report manually.

To add a report as a favorite:
1 Click Favorites » Add » Reports.

2 On the Maintain Favorites—Add Reports page, expand the report group that contains

the report that you want, and then click the report.

The report is designated as a favorite as shown in example Figure 4-1 and appears on the
Favorites page (see To access a favorite report: on page 4-3).

Maintain Favorites - Add Reports

Invoice with Budget has been added
B 1nvoices
F&% Invoice by Account Level
Fa&% Alternate Invoice

F&% Invoice with Budget
Invoice with Shifts

Run Total Invoice
Run Total Percent
Run Total Rate Group Percent
Zero Cost Center Invoice
Account Total Invoice
Invoice by Account Level ¥2

Account Reports

Top Usage Reports

Yariance Reports

Trend

Resource Detail

Audit

Other

Web User

Run Total Invoice with Drilldown

Figure 4-1 - Favorite Report Links
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Configuring User-Specific Settings

To access a favorite report:

Click the report link in the left frame of the home page (Figure 4-2). If the report has a
correlating published report for the current period, the most current published report
opens.

If the favorite report does not have a correlating published report for the current period,
the parameters page for the report opens.

ZA CIMS Server - Microsoft Internet Explorer

Fle Edit Wew Favorites Tools  Help
- N Al O < . n Al . B a8
Qe - Q- [ [A & S ssarch 57 Favorves @Preda €2 (2- L [ 32
Address | &] hitp:fflocalhostjdefaul. asp v[Be ks
CIMS ' [
Server
Login Reports Spreadsheets Favorites Admin  Help Logout Home
CIMS L:e inc

welcofne CIMS Server Administrator, you are currently signed on as admin

CIMS Herver is the Enterprise Wide System for managing IT casts, & central repository of resource usage data is

collectgd fram OS/390, NT, UNIX, Metwork, e-Cornmmerce, and more, Any source of resource Usage can be

collectqd and reported on. wieb based reporting makes resource usage information immediately available across L
= your oiganization, & cormplete system for taday's complex IT processing environment,

CIMS Lab, Inc.
3013 Douglas Blvd, Suite 120
Roseville, CA 95661
www.cimslab.com
Fhone: (916) 763-6525 | Tall-Free: (600) 263-4267 | Fax: (916) 783-2090
Copyright @2001 CIMS Lab, Inc - Al rights reserved Created 6/10/200% 1:39:10 PM
)
& Local intranst

List of favorite reports

Figure 4-2 - Favorite Report Links

You can also access favorite reports as follows:
1 Click Favorites » Reports.

The Favorites page opens displaying a hierarchy of reports that you have saved as
favorites.

2 Navigate to the appropriate report (see Figure 4-3 on page 4-4) and expand it.
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3 Do one of the following:
e Click Run Report to run the report.

e Click a published report (if available) to view the report. You can hide or display
the folder path that appears for the published report. See Showing or Hiding Folder
Paths for Published Reports on page 4-5.

£ hitp:hwww.cimsserver.com/{Tfavorites.asp?select-Reports - Microsoft Internet Explorer. ‘:HE”Z‘

File Edit View Favorites Tools Help o
- O ® A SR - 3

eﬂack © E @ ‘h S sesrch lpravories @ meds €28 (- 1L 3

Address @] http: fewas,cimsserver.com{ Thavorites, asp?select=Reports B ks 2

Server

Login Reports Spreadsheets Favorites Admin  Help Logout Home

Favorites

= Favorite Reports
B  Invoice by Account Level

Run Report
.Ci . C:\Program Files\CIMSLab\Server\ReportsiPublished\\user\test\200306
6/5/2003 10:53:29 4M \Reportsirinyc007.rpt

A .Ci . \C:\Program Files\CIMSLab\Server\Reports\Published\\user\test\ 200305
[197 .30 viww.Cimsserver.com
——— \Reportsirinyc007.rpt
A .Ci . \C:\Program Files\CIMSLab\Server\Reports\Published\\user\test\ 200301
[28f .56 viww.Cimsserver.com
e \Reportsirinyc007.rpt
alternate Invoice
Run Total Invoice

Click here to view

Click here to run the report '
a published report

&) # Internet

Figure 4-3 - Navigating to a Favorite Report
To remove a favorite report:
1 Click Favorites » Delete.

2 On the Maintain Favorites—Remove Reports page, click the report that you want to
remove.

The report is removed from Favorites list.

Note ¢ Removing a favorite report simply removes the report from your list of
favorites. It does not delete the report from the system.
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Showing or Hiding Folder Paths for Published Reports

By default, published reports that appear on the Published Reports and Favorites page
include the full path to the folder that contains the report. You can choose to show or
hide these paths.

To hide or display folder paths of reports:
1 Click Admin » User Options.
2 On the Set User Options page, do the following:

¢ To show the full folder paths on the Published Reports and/or Favorites pages,
click Y in the appropriate box.

e To hide folder paths, click N in the appropriate box.
3 Click Update.

The system shows or hides the directory paths as you requested.
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Choosing a Crystal Report Viewer

In most cases, your CIMS Server administrator will have set the appropriate Crystal
Report viewer for your browser. (For more information, refer to the CIMS Server
Administrator’s Guide.) However, you can change the viewer as needed from CIMS Server
Web Reporting. The viewer that you select should be based on the specifics of your
browser and computer.

Note ¢ The following steps are applicable to selecting a viewer for an individual
CIMS Web user only. To set the viewer for all users, see Configuring System-Wide
Settings on page 4-7. CIMS Server Web Reporting uses the viewer set for the individual
user if it differs from viewer set for all users.

To choose a Crystal Report viewer:
1 Click Admin » User Options.

2 On the Set User Options page, click one of the following in the Crystal Web Viewer
select box:

e Default. This option uses the viewer set on the Edit Configuration page (see
page 4-7).

e ActiveX. This option works only in Internet Explorer.

e Java using Browser JVM. This option works in Netscape Navigator or Internet
Explorer.

e HTML. This option is appropriate for users with lower powered computers with
minimal memory (64MB or less). It offers a smaller feature set.

3 Click Update to change the viewer.
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Configuring System-Wide Settings

You must be a CIMS Web administrator to edit the configuration settings described in
the section. If you are not an administrator, you can view these settings in a read-only

capacity.

These configuration settings are saved to the CIMS Server database and are applied to all
CIMS Web users.

To edit the configuration settings:

Note ¢ Many of the following settings can also be configured using CIMS Server
Administrator.

1 Click Admin » Configuration.

2 Edit the settings on the Edit Configuration page as follows:

Web Site UID (not editable). This is the Unique Identifier (UID) for the database
or Default. For more information about using UIDs for databases, refer to the
CIMS Server Administrator’s Guide.

ODBC DSN (not editable). The name of the ODBC-compliant data source that
CIMS Server Web Reporting is using.

Localization ID (LCID) (not editable).The LCID assigned to the user’s regional
setting in Windows.

Organization Name and Address Fields. Address information for your
organization. This information appears in the standard invoices that ship with
CIMS Server.

Invoice Number. This invoice number is used only if the Invoice Number report
parameter is not available (see page 2-5).

Session Timeout Minutes. The number of minutes of inactivity that are allowed
before users are automatically logged out of CIMS Server Web Reporting.

Note ¢ If you change this setting, the change will not take effect during the
same session. You need to log out and the log on again.
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B 4-8

e Crystal Web Viewer. This setting determines the particular Crystal Viewer used to
view reports. You can choose one of the following:

e Default. This option uses the ActiveX setting (see the following).
e ActiveX. This option works only in Internet Explorer.

e Java using Browser JVM. This option works in Netscape Navigator or Internet
Explorer.

e HTML. This option is appropriate for users with lower powered machines with
minimal memory (64MB or less). It offers a smaller feature set.

¢ Display Account Code Selection to Level. This setting determines the level of
account codes that appear in the Starting Account Code and Ending Account
Code lists on a report parameters page. For example, if you type 1, only the top
level account codes appear. However, if you type 3, the first, second, and third level
account codes appear.

¢ Current Database Version (not editable). The version of the CIMS database
currently used by CIMS Server.

e Last Reporting Date. The last reporting date that CIMS Web end users can view.
For example, if the date is 06/30/03, end users cannot view reports for dates after
June 2003. CIMS Web administrators can view reports for any date.

3 When you are finished, click Update Configuration to change the settings.

Note * Update Configuration also refreshes additional configuration options that
are set in CIMS Server Administrator and stored in the Web server cache. For more
information about the configuration options that you can set for CIMS Server
Web Reporting, refer to the CIMS Server Administrator’s Guide.

About Updating Identifiers

A key feature of viewing invoices in CIMS Server Web Reporting is the ability to drill
down on the units consumed for a resource by identifier. This feature uses the CIMS Rate
Identifiers table, which contains the rate codes that are processed from the input resource
file(s) and correlates them to their corresponding identifier names in the CIMS Ident
table.

If the identifiers in the CIMS Server Resource File changed and/or a rate code or codes in
the input file have changed, the CIMS Rate Identifiers table will retain unused data in
addition to the current data. Although this does not cause processing problems, the table
can accumulate a large amount of data. You can click Update Rate Identifiers Cache to
update the table so that it contains only the current data; however, in most cases this step
will already be completed by your CIMS Server administrator.

For more information about maintaining identifiers, refer to the CIMS Server
Administrator’s Guide.
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Creating Custom Report and Transaction Parameters

The standard reports provided with CIMS Server use Active Server Pages (ASP) to provide
report and transaction parameters. If needed, you can create custom parameters using
either ASP or parameter fields in Crystal Reports.

For assistance creating custom report parameters, contact CIMS Lab (see Contacting

Technical Support on page 6-5).

Creating Parameters Using ASP

You can modify an existing parameter page to create a custom parameter. For
convenience, CIMS Lab recommends that you modify the parmRateCode.asp parameter.
If CIMS Server was installed in the default location, this page is in C:\Program
Files\CIMSLab\Server\Web.

The parameter field name defined in the report, the ASP file name, and the control name
for the parameter within the page must match. If the ASP file name is parmABC.asp, the
parameter field name must be ABC (or @ABC if the parameter is not used in a stored
procedure), and the control name must be 'ABC' (for example, SELECT NAME='ABC'").

Creating Parameters Using Parameter Fields

You can also use parameter fields to create parameters within a report. To add parameter
fields:

1 Open the report in Crystal Reports, and then click Insert » Field Object.
2 Right-click Parameter Fields, and then click New.

3 In the Create Parameter Field dialog box, type the name of the field.

4 In the Prompting text box, type one of the following:

e LEN= This creates a text box with the specified maximum character length on the
report parameters page in CIMS Server Web Reporting. For example, LEN=6
limits the maximum characters that can be typed in the box to six.

e YorN This creates a Y/N select box on the report parameters page in CIMS Server
Web Reporting.

5 In the Value type box, leave the value at String (the default).

6 Click OK to save the parameter field.

Note * You can set options in the Options area of the Create Parameter Field dialog
box. However, these options are not used by CIMS Server Web Reporting. Refer to
your Crystal Reports documentation for more information about these options.
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Using Transactions

This chapter describes how to create miscellaneous, recurring, and credit transactions.

Working With Transactions ..........ociiiiiiiiiiiieieieiiiiieieieneneiesecececncncaenes 5-2
Adding Transactions . ... ...ttt e e e 5-3
Editing Transactions .. ... ... .. i i e 5-4
Deleting Transactions . . ... .. .ttt e i e 5-4
Navigating Transactions . . . ... .. . 5-4
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Working With Transactions

B 5-2

The primary method for input into CIMS Server is the CIMS Server Resource File. This
file provides usage data from any IT source in a common format. CIMS Server Resource
Files are generated from usage metering files produced by systems in your organization,
for example, 1IS log files, SQL Server trace files, or disk usage output files.

In some circumstances, you might want to generate a CIMS Server Resource File for
occurrences that are not contained in a usage metering file. For example, you might want
to generate a CIMS Server Resource File to apply a credit for an overcharge or to charge
for a one time occurrence such as the cost of providing a computer to a new employee.
In these cases, you can create a transaction that contains the chargeback information that
you want to include in the CIMS Server Resource File.

In summary, a transaction enables you to generate charges or credits for any item or
resource that is not contained in a usage metering file.

There are three types of transactions:

B Miscellaneous Transactions. These are transactions that occur on a one-time basis.
For example, charging for the services of a consultant who worked on a project for two
days.

B Recurring Transactions. These are transactions that re-occur over a period of time.
For example, charging for a set number of computers that are delivered to a
department each quarter.

m Credit Transactions. These are transactions that apply a credit for resources units
consumed or monetary charges.

To process transactions, you need to use the CIMS Data Collector for Transactions. For
more information about this script, refer to the CIMS Data Collectors for Microsoft
Windows Installation and User Guide.
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Working With Transactions

Adding Transactions

To add transactions:

1 Click Admin » Transactions » Miscellaneous/Recurring/Credit. Note that
Miscellaneous, Recurring, and Credit are separate commands.

2 On the transaction list page, click Add.

3 On the add transaction page, enter the following parameters for the transaction:

e Account Code or account code levels. Depending on the configuration set by
your CIMS Server administrator for your user group, the first setting that appears
on the page will be either Account Code, in which you can enter an overall
account code, or account code level boxes, in which you can enter levels of the
account code. For more information about configuring this setting, refer to the
CIMS Server Administrator’s Guide.

e Rate Code. The rate code for the transaction.

» Shift Code (optional). The shift code for the transaction. Shift codes are set by
your CIMS Server administrator. For more information, refer to the CIMS Server
Administrator’s Guide.

¢ Amount. The amount of the transaction. Usually this figure is in resource units,
for example, 500 computers, but it can also be monetary. If monetary, you can
type this amount with our without the decimal point. For example, 1000 or
1000.00. Credit amounts need to be specified by a minus sign (e.g., -1).

e From/To Date (Miscellaneous and Credit Transactions only). The date range
that the transaction occurred.

¢ Frequency (Recurring Transactions only). The frequency that the transaction
should occur (that is, every month, every 6 months, every quarter, etc.). Frequency
is based on the calendar year (January-December).

¢ Enter transaction on (Recurring Transactions only). The period in which the
transaction should be processed. The number of periods correlates to the value in
the Frequency select box. For example, if Every 6 months is selected for frequency,
six periods appear (Period 1 represents January and July, Period 2 represents
February and August, etc.)

Note that the date parameter used by the Transactions collector determines which
recurring transactions are processed. For example, if the collector is run in June
with a date parameter of Current, and the transaction is set to Once a year and
Period 1 (January), the transaction will not be processed.
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e Begin/End Processing on (Recurring Transactions only). The date range in
which you want recurring transactions to be processed. CIMS Server will not
process recurring transactions before or after these dates. The default is the first day
of the current month to December 31, 2199.

e Notes. Any relevant comments.

4 When you are finished, click Add to save the transaction and return the transaction

list page. If you do not want to save the transaction, click Return.

Editing Transactions

To edit miscellaneous and credit transactions:

1

On the transaction list page, click the date for the transaction(s) that you want to edit
in the Set the Date Range or From/To select boxes.

Click Refresh. All transactions within the specified date range appear.

Click Edit for the transaction that you want. For a description of the settings that you
can edit, see Adding Transactions on page 5-3.

When you have completed the edits, click Update to save the edits and return to the
transaction list page. If you do not want to save the edits, click Return.

To edit recurring transactions:

1

Click Edit for the transaction that you want. For a description of the settings that you
can edit, see Adding Transactions on page 5-3.

When you have completed the edits, click Update to save the edits and return to the
transaction list page. If you do not want to save the edits, click Return.

Deleting Transactions

To delete transactions:

On the transaction list page, click Delete for the transaction that you want to delete. You
can also delete the transaction from the edit transaction page. In this case, the delete
transaction page opens indicating the date and time that the transaction was deleted.

Navigating Transactions

You can navigate to the transaction pages by:

m Clicking Admin » Transactions.

Or

m Within an open transaction list page, clicking another transaction type in the Select

B 5-4

Type select box.
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Troubleshooting

This chapter describes problems you may encounter while using CIMS Server Web
Reporting and how to solve them. If you cannot find the answer to your question here,
please contact CIMS Lab (see Contacting Technical Support on page 6-5).

ConNECtioN ProblemS . ...c.vuitniiiiiieiiiieieiiieieieieneeseseecesescscacasescacascnons 6-2
Unable to connect to the CIMS Server Web Reporting Web site ......................... 6-2
The CIMS Server Web Reporting Web site is not opening properly ....................... 6-2
LOgONPIODIEMS .. ..eiiiiiiiiiiiiiiieitiieieeieeaesossesassocscssssscssssssscsssscsscnss 6-2
System will not accept user ID Or password . ....... ... ...ttt 6-2
RepOrtiNG PrODICMS .....vuiiiiiiiiiiitiiiiiiiiieieitieieeteneneneneeseesescscncnanens 6-3
Error message appears when trying to run a spreadsheet or

PUDIiSh @ rePOIt . . ... e 6-3
Reports take a long timeto generate ... ... ... . 6-3
Problems VieWing reports . . .. ... e 6-3
Old data appears IN TePOMS . ... ...ttt e e e 6-3
Cannot drill down INTePOMS .. ... 6-4
Error message appears wWhen running reports . ..........co.iiitnn i 6-4
Reports are missing from reports listS . . ... 6-4
GENEral ProbIEIMS ...vvuiuitiiiiiitiiiiiieieitteteneeeenensasacsesssssssscnsssssscsscncnes 6-4
Web reporting session is timing out before or after session timeout value ................ 6-4
Computer Iocks Up OF FUNS SIOWIY . . . ..o oo e e 6-4
Contacting Technical SUPPOIL .....ouiuiniiiiiiiiiiiiieiiieiiiiiieieieneseseesenesesecsnes 6-5
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Connection Problems

Unable to connect to the CIMS Server Web Reporting Web site
Verify the following:

®m Your Internet or network connection is working properly.

B You have appropriate network permissions and are using Internet Explorer 5.5 or
later.

B You entered the correct URL.

®m You have the required security permissions for the CIMS Server program folders
discussed in Assigning CIMS Server Folder Security Permissions on page 1-7.

For assistance troubleshooting these problems, contact your system administrator.

The CIMS Server Web Reporting Web site is not opening properly
Try the following:
m Restart IIS by clicking Start » Run, type iisreset /restart, and then click OK.

B Check the IIS security settings (refer to the CIMS Server Administrator’s Guide for more
information)

m If you are using Crystal Reports 8, make sure that you have applied all updates

m Install the latest Service Pack for Microsoft SQL Server.

Log On Problems

System will not accept user ID or password

Make sure that you are typing the correct user ID and password. Note that the user
password is case-sensitive.

If the password is invalid, another possible cause is that your CIMS Server administrator
did not click Change when he added your password in the User Maintenance dialog box
in CIMS Server Administrator. The administrator must click Change to save the
password regardless of whether he is adding the password for the first time or is changing
the password. For more information about setting the user ID and password, refer to the
CIMS Server Administrator’s Guide.
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Reporting Problems

Error message appears when trying to run a spreadsheet or
publish a report

If you receive the following messages when you try to run a spreadsheet or publish a
report, you do not have the correct security permissions for the CIMS Server program
folders discussed in Assigning CIMS Server Folder Security Permissions on page 1-7. Contact
your CIMS Server administrator or system administrator.

Spreadsheet Message

Your Web Userid does not have sufficient access rights to create spreadsheets. Please
have the CIMS Web Administrator enable write permissions for the IIS Web User to the
..\CIMSLab\Server\Web folder on the CIMS Server. Consult the CIMS Server Administrator's
Guide for more information.

Published Report Message

Your Web Userid does not have sufficient access rights to create published reports. Please
have the CIMS Web Administrator enable write permissions for the IIS Web User to the
..\CIMSLab\Server\Reports\Published folder on the CIMS Server. Consult the CIMS Server
Administrator's Guide for more information.

Reports take a long time to generate

Make sure that your Internet or network connection is working properly. It could be that
excessive network usage is slowing down either the connection or the server. If you
would like to stop a report that has begun loading, click the Stop Loading button (see
Stopping a Report from Loading on page 3-4).

If you or other users would like to view the same report again, you can avoid waiting for
the report to generate by publishing or saving the report. For more information, see
Publishing Reports on page 2-13 or Saving Reports on page 3-8.

Problems viewing reports

Change the viewer used to view reports. For more information, see Choosing a Crystal
Report Viewer on page 4-6.

If you are using the Crystal Report ActiveX viewer and report headers and data do not
appear in the report, you may need to use the Java or HTML viewer instead. You may not
have administrative privileges to allow the ActiveX viewer to be automatically
downloaded and installed on the computer on which your are trying to run the report.

Old data appears in reports

One or more old loads have not been removed from the database. Unload the old data.
For more information, refer to the CIMS Server Administrator’s Guide.
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Cannot drill down in reports

Certain items do not have any additional information available. If you place the cursor
on an item and the cursor icon becomes a magnifying glass or a hand, you can drill
down. If it does not, there is no detailed information available about the item.

If you cannot drill down on items that should have drilldown capability, install the
ActiveX patch from Crystal. CIMS Lab provides this patch on the CIMS Lab FIP site and
the product CD (...\CIMSServer\CrystalPatches\Crystal Decisions ActiveX Viewer
Patch.exe).

Error message appears when running reports
If one of the following error messages appears when running a report:
B A time-out message that appears immediately.

B -2147192179 An error has occurred on the server in attempting to access the
data source.

Click Administration » Database » Database Object Manager in CIMS Server
Administrator and add any database objects that do not exist in the database (that is, No
appears in the Exists column for an object or objects). If this does not solve the problem,
drop all objects and then create them again. For more information about database
objects, refer to the CIMS Server Administrator’s Guide.

To view a more detail error message, run the report directly from Crystal Reports (not
from the Web browser).
Reports are missing from reports lists

If reports that you used to be able to access are missing from reports lists, your CIMS
Server administrator may have removed access to those reports from you user group.
Contact your CIMS Server administrator.

General Problems

Web reporting session is timing out before or after session timeout
value

If you change the Session Timeout Minutes value, the change will not take effect until
you restart IIS. For instructions on how to restart IIS, see page 6-2.

Computer locks up or runs slowly

The computer might not have enough memory to process. Try running the application
on a PC with more memory (preferably 256 MB or more).
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Contacting Technical Support

The CIMS Lab Technical Support department is here to answer your questions on any
aspect of CIMS Lab products.

CIMS Lab technical support can be reached in the following ways:

m Telephone: (800) 283-4267 in USA and Canada; 916-783-8525 International
® E-mail: support@cimslab.com

m Fax request: (916) 783-2090

International customers may contact one of our authorized international partners.
Contact CIMS Lab for more information.

In addition, customers may visit the Customer Area on our Web site for product
downloads, updates, technical documentation, and password information. We are on
the Web at http://www.cimslab.com.
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Standard Reports

This appendix describes the standard reports provided with CIMS Server.

ADbOout CIMS Server REPOIES ...vvvuiiteiieierieieeieeseeneesssoccesssosssssccssssssscncns A-4
Report Naming Conventions .. .......... .. i e i e A-4
Conventions Used in This AppendiX ........ccciiiiiiiiiiiiiiiiiiiiiiiiiieiieieienenienenns. A-4
Reports by FIle NAamMe ....ovuininiiiiiiiiiiiiiiiiiiieieiiiiieieieeeetencncecenencacencnons A-5
[ £ T3 A-7
Cost Trend—Accounts Graph .. ... .. e e e A-7
Cost Trend—Rates Graph . ......... . o e e A-8
Resource Trend Graph .. ... ... e e e e A-9
DrilldOWN REPOKES ...ouvneiiiiiiiiiiiiiititieieieeeeeeaeeeseseesessnsssncscsssssscacncns A-10
Invoice Drilldown for Rate Group Report . ... ... . A-10
Invoice Drilldown for Rate Group by Date Report .......... ... ... .. A-12
Invoice Drilldown for Units Report ......... ... .. . A-13
Invoice Drilldown for Units by Date Report ......... ... ... . i i A-15
Multilevel Drilldown for Units Report ......... ... ... i A-16
2 1) 4 A-18
Client Audit RepOrt .. ... o A-18
Rate Audit Report .. ... .. A-20
Transaction Audit REPOIt . ... ... A-22
Batch Report . . ... A-23
Account Budget for Period and YTD Report ... ... .. i A-24
Line Item Budget for Period and YTD Report ......... ... ..o, A-25
Configuration RePOIt . . .. ... A-26
CICS Transaction REPOIt .. ... . o e e e A-27
Client RePOIt . . .. e A-28
Account Summary Daily Report . .. ... A-29
Account Summary Daily 2 Report . ... A-30
DB2 Summary RepOrt . .. ... A-31
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Detail by Rate Group Report . ... ... e A-32
Detail by Rate Group/Identifier Report ....... ... ... i A-33
Invoice by Account Level V2 Report ... ... o A-34
Alternate Invoice RepoOrt . ... . A-34
Account Total Invoice Report . ... ... A-36
Invoice with Budget Report . . ... .. e A-37
INVOICE REPOIT . . o e e A-39
Invoice by Account Level Report . ... o A-41
Invoice with Shifts Report . ... ... .. A-43
Run Total INnvoice Report . ... ... e A-45
Run Total Percent Report . . ... o A-46
Run Total Rate Group Percent Report ....... ... ... i A-47
Run Total Invoice with Drilldown Report . ... ... o e A-48
Zero Cost Center Invoice REpOIt ... ... o A-49
Zero Cost Center Factor Report .. .. ... A-51
Percentage Report ....... ... A-52
Rate RePOIt . . e A-53
TOp COSt REPOI . .. A-54
Top 10 Bar Graph Report . ... .o e A-56
Top 10 Pie Chart Report . ... ... e A-58
Top Accounts for Rate Report . . ... o e A-60
Cost Trend Report . .. .. o e A-61
Cost Trend by Rate RepoOrt . .. ... i e A-62
Resource Usage Trend Report . ... .o A-63
Transaction REPOIt . .. ... oo A-64
Cost Variance RepOrt . ... ... A-65
Cost Variance Drilldown Report . ... ... A-66
Resource VarianCe Report . ... ... . A-67
Account Summary by Week Report . ... ... . e A-68
Account Summary by Week—Wide Report . ...... ... i A-69
Account Summary YTD Report ... ... A-70
Account Summary YTD—Wide Report . ... ... .. A-71
Spreadsheets ......c..couiuiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii it ittt cttirieieieiaaas A-72
Invoice Spreadsheet . ... ... .. e A-72
Run Total Invoice Spreadsheet ... ... ... ... A-73
Invoice by Rate Group Spreadsheet . ....... ... ... . . A-74
Invoice by Account Code Spreadsheet .. ......... .. i A-75
Proration by Total Amount Spreadsheet ......... ... . ... ... A-76
Proration by Rate Code Spreadsheet . ........... ... . . . i A-77
Proration by Rate Group Spreadsheet ........ ... ... ... . i A-78
Top 10 Accounts for Rate Spreadsheet ...... ... .. ... .. . i A-79

CIMS Server Web Reporting User's Guide



Standard Reports H

Account Summary Week Spreadsheet .......... ... ... A-80
Account Summary YTD Spreadsheet ................ i A-81
Account Summary YTD by Rate Spreadsheet ........... ... ... ... ... i, A-82
Account Summary YTD Cost by Rate Group Spreadsheet .............................. A-83
Crosstab RePOIES .. ..oueiiiiiiiiiiiiii ittt ittt iiiiitiitieeeeeeenceecncsncsscnacnenns A-84
Daily Crosstab—Charges . . ...t e e A-84
Daily Crosstab—Usage . . . ... .o A-85
Detail by Identifier Crosstab . ....... ... . A-86
Detail by Identifier by Date Crosstab .......... ... i A-87
Monthly Crosstab—Charges . ....... ...ttt e e A-88
Monthly Crosstab—Usage ............. .. i A-89
Summary Crosstab—Charges .. ...ttt e A-90
Summary by Rate Group Crosstab—Charges .............. i, A-91
summary Crosstab—Usage ........ ... .. A-92
Summary by Rate Group Crosstab—Usage . .............c.o ittt A-93
WeeKIly Crosstab—Charges . . ......... ittt e e e A-94
WeekKIly Crosstab—USage . . . . ... oottt e e A-95
=3 1] 0] =1 (= A-96
Report Both Template . . ... ... e e A-96
Report Cost Template ... ... e e e A-98
Report Resource Template .. ... ... ... i e A-99
Spreadsheet Both Template ... ....... ... e A-99
Spreadsheets Cost Template ............. o i e A-101
Spreadsheets Resource Template ............ . i i A-102

CIMS Server Web Reporting User’s Guide A-3 R



B Standard Reports

About CIMS Server Reports

CIMS Server produces chargeback and resource accounting reports based on IT usage
data from your organization. To help you to easily create reports that display the
information that you need, CIMS Server includes a variety of standard reports that you
can use as templates. (If CIMS Server is installed in the default path, these reports are in
C:\Program Files\CIMSLab\Server\Reports\Standard.) This appendix provides a
description of each standard report.

Report Naming Conventions

The following is the file naming convention for the CIMS Server standard reports:

Character 1 The type of report: (G)raph, (I)Drilldown, (R)eport, (S)preadsheet,
(X)Crosstab

Character 2,3,4  Description of report (if template, TMP)
Character 5 Function of report: (R)esource, (C)ost, (B)oth, (U)ser, (X)Other

Character 6,7,8  Numbering sequence for reports of the same type (for example,
invoice, budget, trend)

For example, the file name RBGTCO01. rpt represents the following:

R = Report

BGT = Budget

C = Cost

001 = Report number

Conventions Used in This Appendix

B A4

The reports listed in this appendix are grouped by type (graphs, drilldown reports,
reports, spreadsheets, crosstab reports, and templates) and are presented in alphabetical
order by file name.

Each report includes a description with the following information:
File name. The name of the report file.

Stored Procedure. The stored procedure used for the report (if applicable). A stored
procedure is a set of SQL statements that can perform both queries and actions that allow
the system to generate reports.

Drilldown. The drilldown features for the report (if applicable).

Parameters. The parameters for the report such as starting and ending account codes,
invoice level, and from and to dates. For a description of these parameters, see Using
Report Parameters on page 2-4.
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Reports by File Name

For easy reference, the following lists each standard report by file name and provides the
page number where you can find the report description. Reports that begin with RTMP or

STMP are report templates, which are in the ...Standard/Templates folder.

GTRDCOO1.
GTRDCOOZ.
GTRDROO1.
TINXCOOL.
TINXCO0Z.
TINXC004.

TINXCO05

TINXCO06.
RACLX0O01.
RARTX001.
RATRX001.
RBATROO1.
RBGTCOO1.
RBGTCO0Z.
RCFGX001.
RCICROOI.
RCLTX001.

RDAYC001

RDAYC002.

RDB2R0O01

RDETROO1.
RDETR00Z.

rpt page A-7
rpt page A-8
rpt page A-9
rpt page A-10
rpt page A-12

rpt page A-13

.rpt page A-15

rpt page A-16
rpt page A-18
rpt page A-20
rpt page A-22
rpt page A-23
rpt page A-24
rpt page A-25
rpt page A-26
rpt page A-27

rpt page A-28

.rpt page A-29

rpt page A-30

.rpt page A-31

rpt page A-32

rpt page A-33
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RINVC0O1

RINVC002.
RINVC003.
RINVC0O04.

RINVC0O06.
RINVCQO7.

RINVC009.

RIVTCOO01

RIVTC002.
RIVTC003.
RIVTCOO04.
RIVZCOO1.
RIVZC002.
RPERXQO1.
RRATX001.
RTMPBOO1 .

RTMPC001

RTMPROO1 .
RTOPCOO1.
RTOPC002.
RTOPC003.
RTOPC004.

.rpt page A-34
rpt page A-34
rpt page A-36
rpt page A-37
rpt page A-39
rpt page A-41
rpt page A-43
.rpt page A-45
rpt page A-46
rpt page A-47
rpt page A-48
rpt page A-49
rpt page A-51
rpt page A-52
rpt page A-53
rpt page A-96
.rpt page A-98
rpt page A-99
rpt page A-54
rpt page A-56
rpt page A-58

rpt page A-60
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RTRDCOO1.
RTRDCOOZ.
RTRDROO1 .
RTRNX0O1.
RVARCOO1.
RVARC002.

RVARROO1

RWEKCOO1 .
RWEKCO02.
RYTDCOO1.

RYTDCO02.
SINVCOOL.

SINVCOO02Z.
SINVCO03.
SINVCO04.
SPERX001.

SPERX002

SPERX003.
STMPBOO1.
STMPCOO1.
STMPROO1.
STOPCOO4.
SWEKCOO1.
SYTDCOOL.
SYTDCOO2.
SYTDCOO03.

rpt page A-61
rpt page A-62
rpt page A-63
rpt page A-64
rpt page A-65
rpt page A-66

.rpt page A-67

rpt page A-68
rpt page A-69
rpt page A-70
rpt page A-71
rpt page A-72
rpt page A-73
rpt page A-74
rpt page A-75
rpt page A-76

.rpt page A-77

rpt page A-78
rpt page A-99
rpt page A-101
rpt page A-102
rpt page A-79
rpt page A-80
rpt page A-81
rpt page A-82
rpt page A-83

XDAYCOO1.
XDAYROO1.
XDETROO1.
XDETR002.
XMONCOO1.
XMONROO1 .
XSUMCOO1 .
XSUMCO02.
XSUMROOL.
XSUMR002.
XWEKCOO1.

XWEKROOL.

rpt page A-84
rpt page A-85
rpt page A-86
rpt page A-87
rpt page A-88
rpt page A-89
rpt page A-90
rpt page A-91
rpt page A-92
rpt page A-93
rpt page A-94
rpt page A-95
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Graphs

Cost Trend—Accounts Graph

File name: GTRDCOO1.rpt

Stored Procedure: CIMSSP_Summary_Month

This graph report provides the total charges for all account codes for each month for the
parameters selected followed by charges for individual account codes for each month.

Drilldown: None

Parameters:
B Report Year

m Invoice Level

m Starting and Ending Account Code

Report Example

2 CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Tools  Help

Qo © BB G P dyroor @ @ 3-2 8 L3

X)
&

% & @[=E o o

Preview |

M5 Lab, Inc. Ladrel
- CIMS Lab, Inc. International
- CIMS Lab, Inc. Services

2 ozt PoH e 8

Beo | umks

Publish Return

Cost Trend
Af - CIMS Lab, Inc. Roseville

For 2003

Cost per Month

January

February March

Cost

505,828 55

Month

HAotil

W January
W February

&) Done

B Internet

Figure A-1 * Cost Trend—Accounts Graph Example
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B Standard Reports

Cost Trend—Rates Graph
File name: GTRDCO02.rpt

Stored Procedure: CIMSSP_Summary_Month

This graph report provides the total charges for all rate codes for each month for the
parameters selected followed by charges for individual rate codes for each month.

Drilldown: None

Parameters:

B Report Year

m Starting and Ending Account Code

Report Example

2 CIMS Server - Microsoft Internet Explorer
File Edit Wiew Favorites  Tools  Help

Qe - © - [x] [B] & ) ssarch 5% Favorkes @ Meda 2) 2 ;_;. -

Address | @] hitp: fmaw.cimsserver comfreptexec asp?

Cost Trend Graph 2

Publish

countCodeStart=+ecboAccountCodeStart=+&Account CodeEnd=zzzzzzzzzzdchoAccount CodeEnd=zzzzzzzzz28m ¥

Links >

SE

|

Return

= - 1N T 7 o 11+
fadl

51390 Jobs Started [

51390 Steps Started
5/390 Cpu Minutes
51390 Cpu Minutes (Initiz
©5{350 Cpu Minutes (Al)

Cost Trend

Tso Cpu Minutes

For 2003

l

Cost per Month

o Cpu Mindtes (Tch)
o Cpu Mindtes (Initiator)
Tsa Cpu Mindtes (Al
Total SI0s

isk SI0s

pe 5105

90 510

80 510

75 510

3480 510

3420 510

1200

1000

January Fabiuary areh Aaril

Month

B2 Transactions (Records
DB2 Transaction Cpu Minut
DB2 Transaction Elapsed
B2 1O Activity (Get Page
S Windows Oracle logins
M5 Windows Oracle sessiol ¥ |
< im I =]

dune

B January
W Fewruary
O mareh

[

|1 pone

& Internet

Figure A-2 « Cost Trend—Rates Graph Example

H A-8
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Resource Trend Graph
File name: GTRDROO1.rpt

Stored Procedure: CIMSSP_Summary_Month

This graph report provides the total resource usage for all rate codes for each month for
the parameters selected followed by resource usage for individual rate codes for each

month.
Drilldown: None

Parameters:
B Report Year

m Starting and Ending Account Code

Report Example

2 CIMS Server - Microsoft Internet Explorer
File Edit Wew Favorites  Tools  Help

Qe - O [¥] B T Oseurh Frraones @reda &) (2- 02 B L) B

Address | @] hitp: fmaw.cimsserver comfreptexec asp?

Trend Graph Publish

Jx%@"__raz Ll““ < 51

Preview |

of 53+

oHoe |

Return

Links >

[SES

- M5 Windows SOL Server R 4|

[ M5 Windows 5L Server W
# 115 FTP Sucesssful Protoco
[ 115 FTP Redirection Protoc:
- 115 FTP Client Evror Protoc:
+-115 FTP Ssrver Error Protor

Resource Trend
115 Web Bytes Sent

For 2003

sived

t

| Pratoc:
#1115 Web Redirection Protoc
+1- 115 Web Client Error Protoc
+1- 115 Web Server Error Protc
[ 115 Weh Time Eaken

+- M5 Windows Disk Size in M
MS Windows humber of Fil
MS Excchange Bytes Sent

# M5 Exchange Emails Sent
+)- M5 Exchange Bytes Receiv
+)- M5 Exchange Emails Receit
- M5 Windows Elapsed Time
+- M5 Windows CPU Tre ins
MS Windows Kernel CPU Ti
MS Windows User CPU Tim
£ MS Windows Read Reques
+1- M5 Windows KB Read

MS Windows KB Written
MS Windows Write Reques
Unib disk 1/

[ Unix character 1jO

- Unix image time

| )| 3

Resource Usage per Month

June

Januay Fanruary maren Aaril

Month

Month Resource Usage
ZE}

Toul 140,235,845

B January
W Fewruary
O mareh
O Anril

0 May

W June

|€1 pone

& Internet

Figure A-3 « Resource Trend Graph Example
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Drilldown Reports

Drilldown reports enable you to view a breakdown of an item in a report, for example
resource units or charges, by an identifier or identifiers. Drilldown reports are invoked
from other reports and cannot be run independently.

Invoice Drilldown for Rate Group Report

B A-10

File name: IINXCOO01.rpt
Stored Procedure: CIMSSP_Drilldown_by_RateGroup

This report enables drilldown of the charges for a rate group by identifier name. For
example, the report in Figure A-4 on page A-11 provides a drilldown of a rate group for
charges associated with the identifier name JOBNAME. Charges for each rate code within
the rate group are broken down by the identifier values for JOBNAME.

This report invokes from the following reports.

®m Invoice with Budgets (see page A-37)

Invoice (see page A-39)

Invoice by Account Level or Invoice by Account Level V2 (see page A-41)
m Invoice with Shifts (see page A-43)

m Zero Cost Center Invoice (see page A-49)

Drilldown: None

Parameters:

m I[dentifier name

m All other parameters are supplied by the invoice report

CIMS Server Web Reporting User's Guide



Standard Reports H

Report Example

23 CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Tools Help

Q- O ¥ @ & ) search 5o Favories @ ede €2

sserver.com//secondary, asp?Tdent Jobnametsubr Esubr Beo ks
I Invoice by Account Level Publish Return Help o
& ¢l +| [ 1 of i =
Preview |
—~
Az
0S /390 Tso for AA-CIMS Lab, Inc. Roseville by Jobname
From 6/1/2002 to 6/20/2002
fobname i3-Tso Cpu Minutes [15-Tso Connect 16-Tso Inputs 18-Tso Outputs
inutes
0.02| 32.13] 13| 15|
0.03 40.60| 65| 70|
0.17| 121.27| 563 636|
0.53 963.446| 1,669 1,908|
0.02] 9.59 40|
0.04 4.43] 39|
0.02| 73.61 63|
0.08| 21.99 72|
0.35 1,970.27| 195
0.19| 139.14] 579
0.30| 2,610.91] 752
0.17| 45.42] 12|
0.21 2,939.72] 187
0.03| 2,726.62| 28|
5.51 2,754.56| 16,829
7.68| 14,453.71] 21,425‘
v
< >
v
&) Dane B Intemet

Figure A-4 « Invoice Drilldown for Rate Group Report Example
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Invoice Drilldown for Rate Group by Date Report
File name: IINXC002.rpt
Stored Procedure: CIMSSP_Drilldown_by_RateGroup_Date

This report is similar to the Invoice Drilldown for Rate Group report (see page A-10).
However, it also provides a breakdown of the data by date.

Drilldown: None
Parameters:
m Identifier name

m All other parameters are supplied by the invoice report

Report Example

2 CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Tools  Help L

Q- © ¥ @ & ) search ¢ Favarites @ media 7) - \j,’ - 3
Beo ks ®
I Invoice by Account Level Publish Return Help &
& [l - [ 1 of 1+ (] b .
Preview |
08/390 Tso for AA-CIMS Lab, Inc. Roseville by Jobname
From 6/1/2002 to 6/20/2002
Tobname 13-Tso Cpu Minutes 15-Tso Connect 16-Tso Inputs 18-Tso Ov
Minutes
WMERDI k/10/2003 0.02] 32.13] 13]
Total 0.02] 32.13] 13]
WMER13 6/3/2003 0.03] 40.60] 65
Total 0.03] 40.60] 65
DSI1 6/2/2003 0.03] 18.14| 63
6/5/2003 0.14] 103.12] 500
Total 0.17| 121.27| 563
DSIZ2 6/2/2003 0.13] 271.46| 352
6/3/2003 0.22] 333.39 aa3|
6/6/2003 0.03] 158.46| 230
6/9/2003 0.04| 87.01 115
6/10/2003 0.06| 113.14] 84|
Total 0.53] 963.46| 1,669
DTIO1 6/3/2003 0.02] 9.59 39
Total 0.02] 9.59 39
DTID3 6/2/2003 0.02] 1.61] 21
6/3/2003 0.02] 2.82| 12|
Total 0.04| 4.43] 33
DTIOS 6/3/2003 0.02] 73.61 59
Total 0.02] 73.61 59 “
< >
-
&) Dane B Intemet

Figure A-5 < Invoice Drilldown for Rate Group by Date Report Example
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Invoice Drilldown for Units Report
File name: IINXC004.rpt
Stored Procedure: CIMSSP_Dri11down_by_Rate

This report enables drilldown of resource units by identifier name. For example, the
report in Figure A-6 provides a drilldown of resource units for the units associated with
the identifier name JOBNAME. Units are broken down by the identifier values for JOBNAME.

This report invokes from the following reports.
m Alternate Invoice (see page A-34)

m Invoice with Budgets (see page A-37)

m Invoice (see page A-39)

®m Invoice by Account Level or Invoice by Account Level V2 (see page A-41)
m Invoice with Shifts (see page A-43)

® Run Total Invoice 2 (see page A-48)

m Zero Cost Center Invoice (see page A-49)
Drilldown: None

Parameters:

m Identifier name

m All other parameters are supplied by the invoice report
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B A-14

Report Example

A CIMS Server - Microsoft Internet Explorer

Filz  Edit View Favorites Tools Help o
. Al & ry 2
Qe - O m @ ()| ) search 7 ravories @ veda )
. cimssar ver.com, brametsuby ubr Links
I Invoice by Account Level Publish Return Help e |
& & iz <] [ 1 o1+ » M & B
Preview |
~
08/3290 Cpu Minutes for AA - CIMS Lab, Inc. Roseville
From 6/1/2002 to 6/20/2003
Jobname Units
ABCODZ 0.03
ABCULE 104
ABCU30 9.85
ABCO3T 4.43
ABCUSE 56,51
ABC14D 0.45
ABC1S0D .28
ABC1S0S .28
ABCAUDIT 0.04
ABCDLYBK 8,33
ABCFTPOL 0.0z
ABCFTPOZ 0.0z
ABCHOOL 135
ABCINFOL 0.05
ABCUIZLA 001
ABCU321B 0.04
ABCUIZ2A 001 v
M
&) Dane B Intemet

Figure A-6 « Invoice Drilldown for Units Report Example
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Invoice Drilldown for Units by Date Report
File name: IINXC005.rpt

Stored Procedure: CIMSSP_Drilldown_by_Rate_Date

This report is similar to the Invoice Drilldown for Units report (see page A-13). However,

it also provides a breakdown of the data by date.

Drilldown: None
Parameters:

m Identifier name

m All other parameters are supplied by the invoice report

Report Example

23 CIMS Server - Microsoft Internet Explorer

Fle Edt View Favortes Tools Help o
NG N > B
- ) - Ps
Q- O HEAG S sesrch Slpravories @ meds &) (-
Address | ] http:ffuwas,cimsserver. comffsecondary. asp?Identifier=4-JobnameDrilDownDet ail=YESEsubmit. x=278submity=12 v| B ks ?
I Invoice by Account Level Publish Return Help e
& & Iz | [ 1 of 1+ > oM 4 .
Preview |
o
6/2/2003 0.03
Total for: 4BCOO2 0.03
ABCD16
5/30/2003 n.z0
6/2/2003 2t
6/3/2003 2t
6/5/2003 2t
6/6/2003 2t
Total for: ABCO16 1.04
ABCD30
5/30/2003 040
6/2/2003 220
6/3/2003 2.67
6/4/2003 0.60 2
b
&) Dane B Internet

Figure A-7  Invoice Drilldown for Units by Date Report Example
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Multilevel Drilldown for Units Report

File name: IINXC006.rpt

Stored Procedure: CIMSSP _Drilldown_3D

This report enables drilldown of resource units by up to five identifier names. For
example, the report in Figure A-8 on page A-17 provides a drilldown of resource units by
the identifier values associated with the identifier names SYSTEM_ID, APPLICATION ID, and
TERMINAL_ID.

To enable this report, the report file name I INXCO06 must be entered in the Configuration
dialog box in CIMS Server Administrator (refer to the CIMS Server Administrator’s Guide).
If this option is not set, the Invoice Drilldown for Rate or Invoice Drilldown for Rate by
Date report is invoked.

This report invokes from the following reports.

Alternate Invoice (see page A-34)

Invoice with Budgets (see page A-37)

Invoice (see page A-39)

Invoice by Account Level or Invoice by Account Level V2 (see page A-41).
Invoice with Shifts (see page A-43)

Zero Cost Center Invoice (see page A-49).

Drilldown: None

Parameters:

B A-16

Identifier name 1
Identifier name 2
Identifier name 3

All other parameters are supplied by the invoice report
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Report Example

IMS Server - Microsoft Internet Explorer

File Edt View Favorites Tools  Help

O~ © 1) @ G Psowsn fgross @vote @ @ % 8 -1 B

address | @] hitp: flocalhost]reptexec2. asp?lden

| % & [ vHu{ 1 o1 >NIHM

Previen |

CICS Transaction Minutes for AA- CIMS Lab, Inc. Roseville

From 5/1/2003 1o 5/31/2003

SYSTEM_ID
APPLICATION_ID
TERMINAL_ID
5G
TOOCS01
T 104
2191 0.03
2502 015
2433 054
A106 007
CHSL 003
MO2E 008
MOS9 000
SEQL 0,00
TOOCS01 193
TooCssE
CHSL 1.33
M043 013
TOOCSSE 1,46
SYSG 3.39

& tore T
L

| & Local intranet

Figure A-8  Multilevel Drilldown for Units Report Example
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Reports

Client Audit Report

File name: RACLX001.rpt

H A-18

Stored Procedure: CIMSSP_AuditClient

This report tracks changes to the CIMS Client table and contains the following:

Date and time the change was made
The type of change that was made:

e U = update to existing data

e I =addition of new data

e D = deletion of data

Windows user ID

Client account code

Old account name (if applicable)

New account name (if applicable)

Drilldown: None

Parameters:

From and To Date

Audit Type

CIMS Server Web Reporting User's Guide
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Report Example

File Edit View Favorites Tools

2} CIMS Server - Microsoft Internet Explorer

Help

Q- © @6 ) search 5o Favartes @ e 2) - :‘,’, B3

Client Audit Report

Address | @] hitp: localhostreptexer . asp?Range=130;

“h2F1%2ZF19988FromDate=1

Publish

1-018fromMonth=18fromDay=18fromVear=1998280ateEnd=12%2F 31 %2F2004; ¥ .—) Go Links >

Return

| % & @z ] [ W4 Lo >y o || o4 | B
Preview |
-
Client Audit Report
Date/Time Changed Type UserID Account Code OM Account Name New Account Name
10/2/2003  3:55:03P D CIMSLABDebora uu Security
1092002 3:5432FM U CIMSLABRDebora A4DDDD Administration Department 14
10/9/2003  3:54:12P 1 CIMSLABDebora ABDDDD
1092002 3:5402FM U CIMSLABRDebora Ak Administration Administration Site &
o
<0 ) @ |
o
&) Dane % Local intranet

Figure A-9 « Client Audit Report Example
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Rate Audit Report
File name: RARTX001.rpt
Stored Procedure: CIMSSP_AuditRate
This report tracks changes to the CIMS Rate table and contains the following:
m Date and time the change was made
m The type of change that was made:
e U = update to existing data
e [ =addition of new data
e D = deletion of data
m Windows user ID
m Rate code
m Old and new rate value
m Old and new rate per resource unit or per thousand unit indicator:
e M (Per thousand units)
e Blank (Per unit)
m Old and new resource conversion factor:
e 1 (Divide total resource value by 60)
e 2 (Divide total resource value by 3600)
e 3 (Divide total resource value by 1000)
e 4 (Multiply total resource value by 60)
e 5 (Divide total resource value by 60000)
e jf (Multiple total resource value by user-defined number)
e Blank (No conversion factor)
® Old and new zero cost indicator:
e N (The rate will not be included in zero cost calculations)
e Blank (The rate will be included in zero cost calculations)

Drilldown: None
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Parameters:

® From and To Date
m Rate Code

m Audit Type

Report Example

2} CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Tools  Help

Qe - © \ﬂ @ /h ;‘J Search \:,[\L(Favw\tes @ e £ (- ;. B3

fdress | @] hitp flocalhost reptexec  sspRange=1 BDateStart=1 %2F 1 %2F 1 99B&F romDate=1 996-01-01&fromMonth=16fromDay =1 BfromVear—19988DateEnd—=12%2F31 %2F20n4 ¥ | [Ed 6o Liks ™

Rate Audit Report Publish Return

| % & @foor <] |14 Lot »ob o || ok | =B

Preview |

Rate Audit Report

Raie Yalue Per Thou  Res Comv Zero Cost
Date/Time Changed  Type UserID Rate Code oM New OM New OM New OM New

1092003 4:2636FM U CIMSLABDeborah -TECH 5000

10/9i200%  4:26:16F I

CIMSLABDeborah -TECH

10072003 42508FM D CIMSLAB\Deborah LLY208 0.00
100972003 424:44FM U CIMSLAB\Deborah Z001 250 3.50
L
E i} 3 |8
bl
@ Done % Local intranet

Figure A-10 + Rate Audit Report Example
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Transaction Audit Report
File name: RATRX001.rpt

Stored Procedure: CIMSSP_AuditTransaction

This report tracks changes to the CIMS Transaction table and contains the following:

Date and time the change was made

The type of change that was made:

e U = update to existing data or transaction marked as deleted

e [ =addition of new data

Account code

Old and new rate code

Old and new amount
Drilldown: None
Parameters:

m From and To Date

m Audit Type

Report Example

3 CIMS Server, - Microsoft Internet Explorer

User ID (usually the Windows user ID or SQL Server user ID)

(,

File Edit View Favorites Toals Help ff
Qe - © ¥ @ & SO seach Glpraories @ ueda ) - &8 L3
fildress | @] hittpfvoni-webtestz reptexec. aspR ange=5aDateStark=10%2F 1 % 2F 20038FromDake=10%2F 1 %2F 20038 romMonth=106fromDay =1 BfromVear—20038DateEnd—=10%: | [Ed 6o Liks
trans audit Publish Return Help e
= | [ T oft #h .
Preview |
—
Transaction Audit Report
Date/Time Changed ~ Type UserID Account Code  OM Rate Code New Rate Code OM Amount New Amount
10/1072003 120733FM 1 sa Ak EMONEY 5000.00
10/1072003 120102PM U sa DDWWWWGA Z016 Z016 50.00 60.00

&) Done
.

% Local intranet

Figure A-11 + Transaction Audit Report Example
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Batch Report
File name: RBATROO1.rpt

Stored Procedure: CIMSSP_Batch

This report provides OS/390 batch job data for the parameters selected. This data is taken

from the CIMS Detail table.
Drilldown: None

Parameters:

m Invoice Level

m Starting and Ending Account Code
m From and To Date

Report Example

-2 CIMS Server - Microsoft Internet Explorer

Fle Edt View Favorites Tools Help ar
Q- © ¥ @ & ) search 5 ¢ Favarites @Pmedia 2 3
Links **
Batch Report Return Help &
& & 7 [l - [ 1ot b oM ih =
Preview |
+ ABCOI6-JES2 ~ A
+ ABCD30-JESZ
= ABCD37-IESZ M
SN CIMS
+ ABCDEE-JESZ ;
+ ABC140-JES2 H
& uactson sz Resource Report in Job Name Sequence
+ ABCIS0S-JESZ
+ ABLAUDIT-ESZ Account Range: All
) ABCDLYEK-ES2 Date Range: 6/1/2003 to 6/30/2003
+ ABCFTPO1-JES2 cPu CPU (INIT) CPU (ALL)
% ABCFTPOZ-JESZ JOB NAME  SUB-ID ACCOUNT J0BS  STEPS s555.55 s555.55 555.55 DISK 510
+ ABCIHOOL-JES2
+ ABCINFO1-JESZ ABCOOZ JESZ A 1 2 184 0.04 209 9,
+ ABCU3Z1A-JESZ ABCOLE JES2 A 4 192 50.28 6.57 58.20 45,6
+ ABCU321B-JES2 ABCU30 JES2 A 2 261 567.06 7.55 664.73 3,417,¢
+ ABCU3Z2A-JESZ RECU37 JESE A 0 82 226,25 2.73 245.68 475,
) ABQU3228-JES2 RBCOBE JESZ | AA S 155 2,626,685 4.6 Z,934.50 4,203,
+ ABCU323A-JES2 ABC140 JES2 AA 1 21 26,94 0.76 30,05 13,0
+ ABCU3238-JES2 ARCISOD JES2 AA 1 58 16,74 159 20.77 10,0
) ABCU3z4A-JES2 ABCISOS JES2 AA 1 61 17.43 173 2167 108,
* ABCU3Z24E-JES2 ABCAUDIT  JESZ  AA 4 3z 179 L0z .00 H
# ABCU32SA-JES2 ABCDLYBK  JESZ A4 1 1 423,28 0.0 46110 0,8
- ABCLI3Z5E- JES2 ABCFTPOL JEsz ma 5 5 078 019 104
- ABCLIMG1A-JESZ ABCFTPOZ JEsz ma 5 5 0.83 016 104 ]
- ABCLI51B- JES2 ABCIHOOL 2 AA 5 5 66,12 058 69,12 1,8
* ABCUATLA-ESZ ABCINFOL  JESZ AA 6 54 2.86 252 5.48 :
* :Sémzijgz ABCUZIA  JESZ AA 1 7 034 0.20 0.55 3
n -
i oz sz 1. 225 1% an i
+ ABCL4BL1A-JES2 CANES] @ |0
v
€] Done ® Intermet
=

Figure A-12 « Batch Report Example
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Account Budget for Period and YTD Report
File name: RBGTCOO01.rpt
Stored Procedure: None

This report provides actual, budget, and difference charges by account code for the
parameters selected. This report includes totals for the calendar period selected and year
to date (YID).

This report reflects the amount for the Overall Account Budget for the account code as
set in the CIMS Client Budget table. For more information about setting budgets, refer
to the CIMS Server Administrator’s Guide.

Drilldown: None

Parameters:

m Starting and Ending Account Code
m Invoice Level

m Calendar Period

Report Example

2 CIMS Server - Microsoft Internet Explorer

File Edit ‘View Favorites Tools  Help o
Qe - ) (%] B G0 POseach §'¢raaies @Preda ) - g 3
</ & | 7 P J =
fuddress [42] hibtps v, cimsser ver, comjrephees, sSpPACCRUREC oSt art =+ A CoUnkC e Start—+&ArtoUnt CodeEnd. boAceountCodsEnd nvolcelevel=\v| B Go | Liks
~
Account Budget for Period ¥TD Publish Return Help
& &% - T oft dh .
Preview |
—~
Account Budget for Period and YTD
From: 06/01/200% o D6/30/2003 YTD
AccauntCode Actual Budget Difference Actual Budget Difference
AA-CIMS Lab, Inc, Roseville
s1,003.58 s5.333.33 77274 s21,065.65 5000000 17106565
BB-CIMS Lab, Inc, Gibbsbore
818874 2s.000.00 ttem T 235, 437.83 150,000.00 g3,437.83
GC-CIMS Lab, Inc. Laurel
ss.15488 50,000.00 -5 194,65 385,053.54 300,000.00 9308384
DD-CIMS Lab, Inc, International
10,6378 10,000.00 3378 ssevzas 50,000.00 a1z7.82
EE-CIMS Lab, Inc, Services
1110930 16,055.67 s497.37 szast60 100,000.00 476432
Grand Total 15517007 160,000.00 4,829.93 1,257.811.18 260,000.00 -237.811.18
v
~
&) Done ® Internet
L

Figure A-13 + Account Budget for Period and YTD Report Example
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Line Item Budget for Period and YTD Report
File name: RBGTCO02.rpt
Stored Procedure: CIMSSP_LinelItem Budget

This report provides actual, budget, and difference charges by account code, rate group
and rate code description for the parameters selected. This report includes totals for the
calendar period selected and YTD.

This report reflects the amount for the individual resource budgets for the account code
as set in the CIMS Client Budget table. For more information about setting budgets, refer
to the CIMS Server Administrator’s Guide.

Drilldown: None

Parameters:

m Invoice Level

m Calendar Period

m Starting and Ending Account Code

Report Example

A CIMS Server - Microsoft Internet Explorer @@
ir

File Edit View Favorites Tools Help
o ) Al O < 2 2. a9
Qe - O \ﬂ @ ()| D search § ¢ ravories @Peda ) (- 3
Address (] hktp:fum,cimsserver.comjreptesec. ssprInvoicel svel=1 &-VearPeriodStart=2003%2F8RAccoUnt CodesStart=-+irbofceount CodeStart=+ccountCodeEnd=zezzzzzezatic ¥ | g G0 Links
Line Item Budget Publish Return Help L/
& & =[x < [ T of 1+ » M & =
Preview |
—~
From: 06/01/2003 to 06/30/2003 YTD
Account Actual Budget Difference Actual Budget Differt
AA-CIMS Lab, Inc. Roseville
DB2 Transactions (Records)
0.26 125 0.99 286 7.50
DB2 Transaction Elapsed Minutes
0.04 0.63 0.79 0.57 5.00
05/390 DB2
0.30 2.08 1.78 3.43 12.50
Unix disk O
451 208 -z.43 432,44 12.50
Unix character 10
0.03 167 164 278 10.00
Unix image time
167,05 208,33 4128 250,49 1,250.00
Unix connect time
35,19 25,00 -10.19 157,20 150,00
Unix user CPU
018 167 149 830 10.00 v
< ‘ ¥ |
hd
&) Dane B Intemet
=

Figure A-14 « Line Item Budget for Period and YTD Report Example
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B Standard Reports

Configuration Report
File name: RCFGX001.rpt
Stored procedure: None

This report provides information contained in the CIMS Configuration table.
Drilldown: None

Parameters: None

Report Example

-2 CIMS Server, - Microsoft Internet Explorer, E‘Elg‘

File Edt View Favorites Tools Help ]
-8 AP E I . B a

Qe - ) ¥ B (i Ooewch Fproonss @vede ) (- s L3

Adcress ] httpffewas,cimsserver.ci \aspireport anfiguratior le=RCFGROOL.rpt v| B ks ?

Configuration Publish Return Help e

S & [z <] [ 1oof1 ] .

Preview |

~

CIMS

Configuration Repdrt

Organization:

Big Time Company
Corporate Headquarters
3013 Douglas Blvd,
Suite 120

Roseville, CA 95661

Invoicing:
Mext Invaice Mumber 97
Invoice Number Type 1
Directories:
Standard Reports C:\Program Files\CIMSLabhServeriReportshStandardy,

Custom Reports Ch\Program Files\CIMSLabhServeriyReportsiCustomy,
Published Reports C\Program Files\CIMSLabhServeryReportsyPublisheds,

(£

=3

&) Done B Internet

Figure A-15 « Configuration Report Example
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CICS Transaction Report
File name: RCICROO1.rpt
Stored Procedure: CIMSSP_CICS

This report provides data for CICS transactions by transaction ID for the parameters

selected. This data is taken from the CIMS Detail table.
Drilldown: None

Parameters:

m Invoice Level

m Starting and Ending Account Code

m From and To Date

B Trans ID Start

m Trans ID End

Report Example

2 CIMS Server - Microsoft Internet Explorer

File Edt View Favorites Tools Hslp o
o Al O J ¥ 2
@aack ) \ﬂ @ ) ) search e ravories @ medis §2) =S 3
fcldress | €8] hips s, cimsser ver. comjrephexet. aspPinvaicel evel=1 B ccount CodeStart=-+ &cboActount CodeStart countCodeEnd=zzzezzezaztbofecountCodeEnd=zzzzzzez: ¥ | g G0 Links >
CICS Transaction ID Report Publish Return Help =
& & e Iz ] [ 1 of 1+ > oM h .
Preview |
[#] A‘
+ BJ2003
+ 9/2003
- 10f2003 Cl MS F
Account Range: All
Date Range: 1/1/1998 to 1273172004
TRANS cPU TERMINAL TERMI
TRAN TIME TIME INPUTS ouTP
ID Account Code DATE COUNT  _SS555.56555 55555.5555S
CESF A4 31/ 2003 6 0.03299 0.02636 6
CESF BB 7312003 z 0.00953 0.00842 z
CESF «cC 74312003 3 0.09227 0.03011 [
CESF T3 2003 1% 013479 0.08459 I
CESF 14 0.13479 0.06489 14
CESN A4 31/ 2003 50 311549 0.58109 50
CESN T3 2003 50 F11549 0.58109 50
CESN 50 3.11549 0.58109 50
CESS o 331/ 2003 1 000397 0.00254 1
CESS 3172005 1 0.00597 0.00254 1
CESS 1 0.00397 0.00294 1 )
<)) |-
]
&) Done 4 Internet

Figure A-16 + CICS Transaction Report Example
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B Standard Reports

Client Report
File name: RCLTX001.rpt

B A-28

Stored procedure: None

This report provides the information contained in the CIMS Client table for the
parameters selected.

Drilldown: None

Parameters:

m Starting and Ending Account Code

Report Example

A CIMS Server, - Microsoft Internet Explorer

e

File Edt View Favorites Tools Help a
Qe - ) ¥ B G Ooewch Froonss @vede ) (- 1o 3
fcdress | ] hitp: o, cimsserver.c .aspriccountCodeStart=+&rbaccountCodeStart=+&Account CodeEnd=zzzzzzzzzztichofccount CodeEnd=zzzzzz: v | [og 6o Links
I Client Publish Return Help o
& &Iz | [ 1 of 1+ > oM & .
Preview |
o
AA - CIMS Lab, Inc. Roseville
Contact: CIMS Lab Administrator
Department: Administration
Office: Main Office
Address: 3013 Douglas Boulsvard, Suits 120
Rossville, CA 95661-3642
EMAILL: infa@eimslab. com
FAX1: (916) 783-2090
FAX2:
IPPHONEL:
MOBILEPHONE1:
PAGERL:
¥OICEL: (916) 7838525
YOICE2: (800) 283-4267
WEBURLL:
AAAAAA - Roseville - CIMS Lab Administration
v
v
&) Done # Internet

Figure A-17 + Client Report Example
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Account Summary Daily Report
File name: RDAYCOO1.rpt
Stored Procedure: CIMSSP_Summary_Day

This report provides total daily and monthly charges by account code and rate code
description for the parameters selected.

Drilldown:

m Double-click a day or the charge for a day and a breakdown of charges by rate code
description for the day appears.

Parameters:
m Invoice Level
m Starting and Ending Account Code

m From and To Date

Report Example

72 CIMS Server, - Microsoft Internet Explorer, "._H‘Elg
Filz  Edt View Favorites Tools Help o
A =y i o ) ¥ 24
Q Bk~ () \ﬂ E" ) ) searh Sl ravories @ meds ) = 3
Address | @] http:ffewas,cimsserver.comfreptexe, asp?Invoicel evel=1#Account CodeStart=+achoAccount CodeStart countCodeEnd boAccountCodeEnd v| B ks ?
Account Summary Daily Publish Return Help &
S & e <] W4 2 ofsr b oM i B
Preview |
% CIV5 Lab, Inc. Rosevile Account Charde ~
Bl CIMS Lab, Inc. Gibbsboro
% CIMS Lab, Inc. Laurel [BB - CIMS Lab, Inc. Gibbsboro |
% CIMS Lab, Inc. International
4 CIMS Lab, Tnc. Services June 2003
6/1/2003 281.89
6/2/2003 505.73
£/3/2003 4,430.40
6/4/2003 450,32
6/5/2003 723.18
6/6/2003 21735
6/7/2003 595.94
6/8/2003 676,89
6/9/2003 4,303.24
£/10/2003 2,432.10
£/11/2003 1,420.14
Total for June 2003 16,097.19
Total for BB - CIMS Lab, Inc. Gibbshoro 16,097.19
v
< ¥
v
&) Done B Internet

Figure A-18 + Account Summary Daily Report Example
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B Standard Reports

Account Summary Daily 2 Report

File name: RDAYC002.rpt

Stored Procedure: CIMSSP_Summary_Day

This report is similar to the Account Summary Daily report (see page A-29). However,
the month (rather than the account code) appears as the top level of the report.

Drilldown:

m Double-click a day or the charge for a day and a breakdown of charges for the day by
account code appears. Double-click an account code and a breakdown of charges for
the day by rate code description appears.

Parameters:

m Invoice Level

m Starting and Ending Account Code

m From and To Date

Report Example

<A CIMS Server, - Microsoft Internet Explorer

File Edit View Favorites Tools  Help

Oaack L

BREK o) ) search 5o Favartes @ e 2) - :;

Account Summary Daily 2

& &g oz~

Preview |

1 of 1

E38 6/2003

Address | ] http: | fuwaw, cimsserver.com|reptexec, asp?Invaicel evel=1&Accaunt Codestart

boAccount CodeStart:

[

EEX
'i{l
3
countCodeEnd bofccountCodeEnd: v| B ks ?
Publish Return Help &

Account Summary By Day

Month
Dav

-~

From: 6/1/2003 To: 6/30/2003

Charge

June 2003

£/1/2003
6/2/2003
6/3/2003
6/4/2003
6/5/2003
6/6/2003
6/7/2003
6/8/2003
£/9/2003
£/10/2003
/11,2003

5,571.68
7,255.24
10,586.16
8,502.74
9,898.69
4,763.24
8,661.15
7,981.29
11,785.33
14,194.24
11,567.44

Total for June 2002

100,767, 20

Report Total

100,767.20

€] Done

B Internet

Figure A-19 + Account Summary Daily 2 Report Example
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DB2 Summary Report
File name: RDB2R0O01.rpt
Stored Procedure: CIMSSP_DB?2

This report provides DB2 data for the parameters selected. This data is taken from the
CIMS Detail table.

Drilldown: None

Parameters:

m Invoice Level

m Starting and Ending Account Code
m From and To Date

Report Example

-2 CIMS Server, - Microsoft Internet Explorer.

Fle Edt ‘View Favortes Tools Help
- 68 ER A1De) S e TR
Q- O KA G S search g ravortes @Prede ) (- L e o8
fiddress | €] hittp ! flocalhostreptexes. aspPInvaicel evel=1EAccount CodeStart=-+ &cboAccount CodeStart countCodeEnd=zzzezzezaztnbofecountCodeEnd=zzazzzezzztange=5 v | [Eg G0 Liks >
DB2 Summary Publish Return
| % & &= o] | u 4] & of 12+ P oK om |4 | B
Preview |
[ PTIL -~
R FT22
- PT3L
<em CIMS
.
Account Range: All
Date Range: 6/1/2003 to 6/30/2002
NUM OF TRANS ACCUM TRANS a
s¥S DB2 cPu cPU ELAPSED EL:
ID  AUTHID PLANNAME  ACCOUNT CODE TRANS TIME TIME TIME T
PTI1  ZEKEMTP  DSHBIND oD 13,604 255168 1,176.39 7,326.58
FTI1  ZEKEMTF  DSRBID 13,608 75568 1176.39 7,326.58
PTL1 ZEKEMTP 13,604 2,551.68 1,176.39 7,326.68
PT11 24,261 3,820.32 1,428.10  66,709.14
PT2z  DCBATCH  DSHUTIL A 72 s0.92 000 260,08
PT2Z  DCBATCH  DSRUTIC 7z 002 [ 760,08
PT22  DCBATCH  PLCARLAN AR ] 1211 0.00 46,76
FT2Z  DCBATCH  FLGAFLAN g XY 0.00 .76
PT22 DCBATCH 80 63.03 0.00 326.84
P2z DCCIMDM  DISTSERY  BE 4,521 54,38 n.oo 2,527.93 v
S ) a3 |&
b
&) Done & Local intranet

Figure A-20 « DB2 Summary Report Example
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B Standard Reports

Detail by Rate Group Report

B A-32

File name: RDETRO01.rpt
Stored Procedure: CIMSSP_Drilldown_by_RateGroup

This report provides total resource units used for the first eight rate code descriptions in
a rate group for the parameters selected. If applicable, a total for the next highest level of
the account code appears. For example, in Figure A-21, total units appear for account
codes AAAAAA, AADDDD, AAFFFF, and AAMMMM. The sum of these totals appears for account
code AA (the next highest level).

Drilldown: None
Parameters:
m Rate Group

m Invoice Level

Starting and Ending Account Code

m From and To Date

Report Example

2l CIMS Server, - Microsoft Internet Explorer ‘L‘|E|E‘
File Edt View Favorites Tools Help >
. Al O ve v %
Q- O XA G S sesrch Sl ravores @ medis ) & 3
Adidress | €8] hitps s, cimsser ver, com/reptexet. aspTRateGroup=2-+0S%2F390- Batch  chargesednvoiceLevel=2EdccountCodeStart=+ &xbofccountCodeStart=+ &AccountCodetne v | (£ 60 Links >
Detail by Rate Group Publish Return Help fa ]
& g oz~ 1oof 1+ > oM & .
Preview |
=J- CIMS Lab, Inc. Roseville ~
Ro: ah Admi
Rosevills - CIMS Lab Deve = # T
Rosevils - CIMS Lab Finan ‘ l Ms e
Rosevills - Marketing & Sal o ’ -
- CIMS Lab, Inec. Gibbshora =
o IV L, T, L Detail
- CIMS Lab, Inc, ional
- CIMS Lab, Inc. Services
Account Code 05/390 Jobs 05/390 Steps 05/330 Cpu 05/390 Cpu 05/390 Cpu Bateh Cred
. Started tarted Minutes Minutes Minutes (All)
Description (Initiators)
[[Aassss - Rosevile - CIMS Lab Administration
4,523 5, 212,80 125,17 5,656, 11
AADDOD - Roseville - CIMS Lab Development
124 248 233,85 %04 267.02
AAFFFF - Roseville - CIMS Lab Finance
105 231 593.33 T.87 609,62
AAMMMM - Roseville - Marketing & Sales
z 2 0.04 0.06 0.10
A - CIMS Lab, Inc. Roseville
1,003 5,004 6,040.02 142.14 6,532.85
]
£ L35 | & W
™
€] Done #® Internet

Figure A-21 + Detail by Rate Group Report Example
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Detail by Rate Group/Identifier Report
File name: RDETR0O02.rpt
Stored Procedure: CIMSSP_Drilldown_by_RateGroup_Identifier

This report is similar to the Detail by Rate Group report (see page A-32). However, the
resource units are broken down by identifier value for the identifier name selected.

Drilldown: None

Parameters:

® Rate Group

m Invoice Level

m Starting and Ending Account Code
® From and To Date

m Identifier

Report Example

<3 CIMS Server, - Microsoft Internet Explorer

File Edit View Favorites Tools Help

Q- O XK@ G ) search 57 Favartes @ e 2) - :\; <IN 3

fcldress | €] hitps s, cimsser ver, com/reptexet. aspTRateGroup=2-+0S%2F390 Batch  chargesednvoiceLevel=2EdccountCodeStart=+ &xbofccountCodeStart=+ &AccountCodetne v | (£ 60 Links >

Publish Return
| % & @[z <] || u 4 3 o3t PoH e84 | =B
Preview |
= CIMS Lab, Inc. Rossville al

Roseville - Marketing & Sal

CIMS Lab, Tne. Gibbshora Detail by Jobname

CIMS Lab, Inc. Laurel
CIMS Lab, Inc. International
CIMS Lab, Inc. Services

Account 05390 Jobs 05/330 Steps 05330 Cpu 05/390 Cpu 05390 Cpu Batch Cred
Started Started Minutes Minutes Minutes (&1
Jobnarne (Tnitiators)

[ £40DDD - Roseville - CIMS Lab Development

BKALICAT ) 014 5,00 T 15
BKALIDLE 2 10 0.25 .01 026
BKALIRES 1 s 0.1z 0.00 014
BKALISPL 1 10 0.21 .01 024
BKALIST1 1 s 0.06 0.00 0.07
BKALISTZ 2 10 0.1z .01 013
BKALISY1 4 0.1z 0.00 014
BKALISYZ 2 10 0.26 .01 028
BKALISYE 4 0.13 0.00 014
BKALISY4 1 3 0.25 .01 028
BKALISYS 1 3 0.26 .01 030
BKFWKPD1 1 10 .02 .01 0.03
DAAD3 2 4 0.63 .01 074
DAAZT 1 H 0.24 .01 0.2
rEALT AE ‘ A nan nan i
< L3 |49, i @ |0
~
&) Done # Internet

Figure A-22 « Detail by Rate Group/Identifier Report Example
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B Standard Reports

Invoice by Account Level V2 Report
File name: RINVCOO1.rpt

See Invoice by Account Level Report on page A-41.

Alternate Invoice Report
File name: RINVCO02.rpt
Stored Procedure: CIMSSP_Summary

This report provides charges by account code and rate code description for the
parameters selected. An optional graph showing total expenses by account code is also
included.

Drilldown:
m Double-click a bar on the graph and the invoice appears.

m Click the units for a rate and a new page appears to enable a drilldown of units by
identifier. This page invokes the report Invoice Drilldown for Rate (see page A-13),
Invoice Drilldown for Units by Date (page A-15), or Multilevel Drilldown for Units
(see page A-16).

m Double-click a rate code description or its corresponding rate or charge and the next
lower level of the account structure appears. This drilldown can be continued through
the account structure.

Parameters:

Invoice Level

Invoice Number

Display Graph

Starting and Ending Account Code

m From and To Date
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Report Example

CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Tools  Help

Qe - © m @ .ﬁh j'__j Search ‘EE‘Favw\tEs @ reda €8 - ; (=] 3

BAccountCadeStar

»
2227272720 |V Links

-firbodccountCodeStat

-fuecounkCodeE

address | @] http: i, cirmsserver.com|reptexec . aspPlnvalcel ew

Alternate Inv Return
| % & @fm=five <] || W 4] 3 ofor »oMou || dh =B
Preview |
CIMS Lab, Inc. Roseville &

CIMS Lab, Inc. Gibbshora
CIMS Lab, Inc. Laurel
CIMS Lab, Inc. International

Invoice No. &
Billing Period: 6/1 /2003 to 6/30/2003

Invoice

Big Time Company
Corporate Headquarters
3013 Douglas Blvd.
Suite 120

Roseville, CA 95661

EE - CIMS Lab, Inc. Services

Units Rate Charge
QS5/390 Jobs Started 41 2.50000000 102,50
05/390 Steps Started 16 050000000 8.00
05/390 Cpu Minutes 0.01 20, 00000000 012
05/390 Cpu Minutes (Initiators) 0.01 0, 00000000 0.00
05/390 Cpu Minutes (All) 0.01 0, 00000000 0.00
Total SI0s 3 0.0000 /M 0.00
Disk 510= 3 0.2500 /M 0.01
Input Records 2 100000000 /M 0.00
Disk Data Sets 2 0.25000000 0.50 &
<) _ /It
v
&) Done ® Intemet
L—

Figure A-23 « Alternate Invoice Report Example
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B Standard Reports

Account Total Invoice Report
File name: RINVC003.rpt

Stored Procedure: CIMSSP_Account_Summary

This report provides the total charges by each level of the account code structure for the

parameters selected.

Drilldown:

m Click the Invoice link and a complete invoice for the account code level appears (see

Invoice Report on page A-39).

Parameters:
m Starting and Ending Account Code

®m From and To Date

Report Example

2) CIMS Server, - Microsoft Internet Explorer

EEE
e

Fle Edt Vew Favortes Tools  Help
Q- O (¥ & & ) search ¢ Favories @ viedia ) A 3
Address |&] http:fmaw. cimsserver comfreptexec. asp?Aceount CodeStart=-+BrboAccount CodeStart=+&AccountCodeEnd boAccountCodeEnd ge=58Dat ¥ | fgd Go ks 7
Account Total Invoice Publish Return Help i
& &= <] || Mo« 8 ofbs > o # foes]
Preview |
# CIMS Lab, Inc. Rosevile A
- CIMS Lab, Inc, International =
o QS Lok T, Serdios CIMS Account Total Invoice
Account Range: All
Date Range: 6/1 /20023 to 6/20/2002
Account Invoice Amount
CIMS Lab, Inc. Gibbsboro 16,889.70
- Gibbsboro - CIMS Lab Development 15,114.31
- - Gary 766.43
- - - BBDDDDGGblackd.exe blac 20.74
- - - BBDDDDGGblackice.exe blac 52.82
- - - BBDDDDGGdIlhost.exe dith 388.58
- - - BBDDDDGGgarym  garym 22.04
- - - BBDDDDGGIRLMPROC" 64.52
- - - BBDDDDGGlIssrv.exe lss 0.34
- - - BBDDDDGGralph f 0.00
- - - BBDDDDGGralph fusr 0.00
- - - BBDDDDGGralph 4Dgifts 0.24
- - - BBDDDDGGralph adm 0.12
- - - BBDDDDGGralph arsap 6.12
- - - BBDDDDGGralph bin 1.56
- - - BBDDDDGGralph demos 1.56
- - - BBDDDDGGralph george 11.40
- - - BBDDDDGGralph gpereyo 0.12 L
< | 3| =) 3 |
™
@Dnne B Internet

Figure A-24 + Account Total Invoice Report Example
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Invoice with Budget Report
File name: RINVC004.rpt
Stored Procedure: CIMSSP_Lineltem Budget

This report provides charges by account code, rate code description, and rate group for
the parameters selected. This report also includes a Budget and Variance field for the
calendar period selected and YI'D Charges, Budget, and Variance fields.

Drilldown:

m Click the units for a rate and a new page appears to enable a drilldown of units by
identifier. This page invokes the report Invoice Drilldown for Rate (see page A-13),
Invoice Drilldown for Units by Date (page A-15), or Multilevel Drilldown for Units
(see page A-16).

m Click the rate group name in the Total line and a new page appears to enable a
drilldown of charges by identifier. This page invokes the Invoice Drilldown for Rate
Group (see page A-10) or Invoice Drilldown for Rate Group by Date (page A-12)
report.

Parameters:
m Invoice Level
m Calendar Period

Invoice Number

Starting and Ending Account Code
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A-38

Report Example

2@ CIMS Server - Micrasoft Internet Explorer, E”E‘El

Fle Edt Wew Favortes Tooks Help w
= 2 n . B
eBack ) @ @ ) }.ﬁ Search ¢ Favorites @ Media ) D:j{v & 3
adldress | &) http: funw.cimsserver comjreptexec. aspHnvoicsLevel=1 &Y eatPeriodSt art=2003%2F6aInwoicshumber =1 BAccount CadeStart—+achnAccount CodeStart—+auccountCode | (B Go  Links
Invoice with Budgets Publish Return Help had
& & = [00% =] T Mo || =
Preview |
—
Invoice with Budget Invoice No. 1
Billing Period: 6/1/2003 to 6/20
Big Time Company
Corporate Headquarters
3013 Douglas Blvd.
Suite 120
Roseville, CA 05661
AA
ATTN:
Units Rate Charges Budget Variance YTD Charges YTD BudgetyTD v
DB2 Transactions (Records)
0.01500000 0.26 125 0.99 266 7.50
DB2 Transaction Elapsed Minutes
0.27 0.15000000 0.04 0.83 0.79 0.57 .00
Total 05/390 DB2
0.30 2.08 1.78 3.43 12.50
Unix disk I/0
45.20 010000000 451 2.08 2.43 432,44 12,50
Unix character 1/0 v
E3Jlm] @ |9
b
L&) Done: B Internet
L—

Figure A-25 + Invoice with Budget Report Example
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Invoice Report
File name: RINVC006.rpt
Stored Procedure: None

This report provides charges by account code, rate code description, and rate group for
the parameters selected. This report is invoked by clicking the Invoice link for the
account code in the following reports.

B Account Total Invoice (see page A-34)
m Top Cost (see page A-54)

m Top 10 Bar Graph (see page A-56)

m Top 10 Pie Chart (see page A-58)

Drilldown:

m Click the units for a rate and a new page appears to enable a drilldown of units by
identifier. This page invokes the report Invoice Drilldown for Rate (see page A-13),
Invoice Drilldown for Units by Date (page A-15), or Multilevel Drilldown for Units
(see page A-16).

m Click the rate group name in the Total line and a new page appears to enable a
drilldown of charges by identifier. This page invokes the Invoice Drilldown for Rate
Group (see page A-10) or Invoice Drilldown for Rate Group by Date (page A-12)
report.

Parameters:

m All parameters are supplied by the report from which the invoice is invoked.
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B Standard Reports

Report Example

2 CIMS Server - Microsoft Internet Explorer, E‘@lg‘
Fle Edt View Favorites Toos Help >
<) m @ (0 D search 5 ¢ Favaries @Pmeda ) - 3

Go  Llinks **
Invoice Help e
& & [l - [ 1 of 1+ (] b .
Preview |
—~
Invoice Billing Period: 6/1/2002 to 6/20,/2002
Big Time Company
Corporate Headquarters
3013 Douglas Blvd.
Suite 120
Roseville, CA 05661
BBDDDD
Units Rate Charge
05390 Jobs Started s08 250000000 1,270.00
05/390 Steps Started 1,378 0,50000000 689,00
05390 Cpu Minutes 58.78 20, 00000000 1,175.64
05390 Cpu Minutes (Initiators) 111 0,00000000 0.00
05390 Cpu Minutes (A1) 60.74 0, 00000000 0.00
| 08/3290 Batch charges 3,134.84
Tso Cpu Minutes 533 2500000000 133.25
Tso Connest Mindtes 45,014.80 0,25000000 11,253.69
Tso Inputs 21,375 2, 00000000/ 42.75 o) [
A
&) Done B Intemet
—

Figure A-26 * Invoice Report Example
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Invoice by Account Level Report

File name: RINVCOO7.rpt

Stored Procedure: CIMSSP_Summary

This key report provides charges by account code, rate group, and rate code description
for the parameters selected. An optional graph showing total expenses by account code
is also included.

Drilldown:

Double-click a bar on the graph and the invoice appears.

Click the units for a rate and a new page appears to enable a drilldown of units by
identifier. This page invokes the report Invoice Drilldown for Rate (see page A-13),
Invoice Drilldown for Units by Date (page A-15), or Multilevel Drilldown for Units
(see page A-16).

Click the rate group name in the Total line and a new page appears to enable a
drilldown of charges by identifier. This page invokes the Invoice Drilldown for Rate
Group (see page A-10) or Invoice Drilldown for Rate Group by Date (page A-12)
report.

(Invoice by Account Level V2 only) Double-click a rate code description or its
corresponding rate or charge and the next lower level of the account structure appears.
This drilldown can be continued through the account structure.

Parameters:

Invoice Level

Invoice Number

Display Graph

Starting and Ending Account Code

From and To Date
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B Standard Reports

Report Example

CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Tools Help
. \ NG A, » B
Qe - © m @ (0 ) search 5 ¢ Favorites @ meda 2) = B 3
Address (] http:Jum,cimsserver.comjreptesec. ssprInvoicel svel=1adnvoiceNumber=18Graph=ReAccount CodesStart=+icbofceount Codestart=-+uiccountCodeE
Invoice by Account Level Return
| % & @lT=fix = || 14 Ui »oMou || dh =
Preview |
i
CIMS Lab, Inc. Gibbshora
CIMS Lab, Inc. Laurel T
CIMS Lah, Inc. International
CIMS Lab, Inc. Services
- Invoice No. 1
Invoice Billing Period: 6/1/2002 to 6/20/2003
Big Time Company
Corporate Headquarters
3013 Douglas Blvd.
Suite 120
Roseville, CA 05661
AA - CIMS Lab, Inc. Roseville
Units Rate Charge
©5/390 Jobs Started 1,452 250000000 3,630.00
05/390 Steps Started 7,138 0,50000000 3,567.50
©5/390 Cpu Mirutes 314,29 20, 00000000 6,286.04
©5/390 Cpu Mirutes (Initistors) 344 0, 00000000 0.00
©5/390 Cpu Minutes (4ll) 357,27 0,00000000 0.00
Total 08/390 Batch charges 13,483.54
Tsa Cpu Mindtes 882 2500000000 ez
A e e, .,,.,,l__
M
&) Done B Intemet
5=

Figure A-27 < Invoice by Account Level Report Example

B A-42
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Invoice with Shifts Report
File name: RINVC009.rpt
Stored Procedure: CIMSSP_Summary_Shift

This report provides charges by account code, rate group, and rate code description
broken down by shift for the parameters selected.

Drilldown:

m Double-click a bar on the graph and the invoice appears.

m Click the units for a rate and a new page appears to enable a drilldown of units by
identifier. This page invokes the report Invoice Drilldown for Rate (see page A-13),
Invoice Drilldown for Units by Date (page A-15), or Multilevel Drilldown for Units
(see page A-16).

m Click the rate group name in the Total line and a new page appears to enable a
drilldown of charges by identifier. This page invokes the Invoice Drilldown for Rate
Group (see page A-10) or Invoice Drilldown for Rate Group by Date (page A-12)
report.

Parameters:

Invoice Level

Invoice Number

Display Graph

Starting and Ending Account Code

®m From and To Date

CIMS Server Web Reporting User’s Guide A-43 N
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Report Example

CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Tools Help
- 6 7| O < >, B
Qe - © \ﬂ @ f0 | O seach Favorites @ Meda F) e B 3
Address (] http:flocahost/reptexec. asp?Invoicel evel=1adnvoiceNumber=18Graph=heAccount CodeStart=+acboAccount CodesSt art=+iAccountCodeEnd=zzzzz2z222BeboAccountCe ¥ Links
Return
| % & @t =] || 14 Ui+ »oMou || dh =
Preview |
i
CIMS Lab, Inc. Gibbshora
CIMS Lab, Inc. Laurel b |
CIMS Laf, Inc., Inkernational
- Invoice No. 1
Invoice Billing Period: 6/1 /2002 to 6/20/2003
The Bia Time Combanv
Corporate Headauarters
3013 Doualas Blvd.
Roseville. CA 95661
United States of America
AA - CIMS Lab, Inc. Roseville
Units Rate Charge
CICS Transaction Minutes 0.34
shift 1 173 0, 16000000 0,31
Shift 2 1.86 0. 01500000 0.03
CICS Cpu Minutes 5.82
shift 1 0.06 30, 00000000 169
shift 2 017 2500000000 413
CICS Transactions 3.27
shift 1 161 0, 01500000 242
shift 2 570 000150000 0.85
CICS Input Messages 2.50
shift 1 111 0, 01500000 167 v
</ a .
hd
&) Done & Local intranet

Figure A-28 + Invoice with Shifts Report Example
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Run Total Invoice Report
File name: RIVTCOO01.rpt
Stored Procedure: CIMSSP_Summary

This report provides total charges by rate group and rate code description for the
parameters selected.

Drilldown:

m Double-click a rate code description or its corresponding units, rate, or charge and
and a breakdown of data by account code appears.

Parameters:

m Invoice Level

m Starting and Ending Account Code
® From and To Date

Report Example

72 CIMS Server, - Microsoft Internet Explorer, g@@
File Edt View Favorites Toos Help &
Q- © ¥ @ & SO seach Slpraries @reds &) - 3
Address (] http: fum.cimsserver. com/reptese. ssprInvoicel svel=2BAceount CodeStart=-+BrboAccount CodeStart=+&sAccountCodeEnd hofccountCadsEnd vBe ks ?

Run Total Inveice Publish Return Help o
& 7= [l < [ 1 o1+ b oM dh B
ges i
+ O5{390 Tso charges
+ OF{390 InputjOutput charges
+ OF/390 Printer/Reader charge
+ O5{390 Starage charges
+ O5{390 DEZ charges =
s oo | CIMS Run Total Invoice
- Unix background job type chal Billing Period: 6/1/2002 to 6/20/2003
# Unix storage charges %
- Unix filesystem
- Oracle charges Big Time Company
- M3 Windows storage charges Corporate Headquarters
+] M3 Windows Oracle charges 3012 Douglas Blvd.
+ M3 windows SQL Server Suite 120
M5 115 Roseville, CA 95661
+ M5 Exchange
+ M3 windows Processes Units Rate Charge
05/390 Jobs Started 1,929 250000000 4,622.50
05/390 Steps Started 10,210 0,50000000 5,105.00
05/390 Cpu Minutes 548,37 20.00000000 10,987.63
05/390 Cpu Minutes (Initiators) 671 0. 00000000 0.00
05/390 Cpu Minutes (All) 615, 61 0.00000000. 0.00
|| Total OS/290 Batch charges 20,895.13 |
Tso Cpu Minutes 1209 25,00000000 302,39
Tso Connect Minutes 46,633,573 0.25000000 11,658 42
Tso Inputs 33,750 2,00000000 /M 67.48
Tso Outputs 35,857 1,00000000 /M 35,88
Tso Cpu Minutes (Initiator) 0,18 0.00000000 000w
< | 138/ | ) 5 J
il
&) Done B Intemet
L

Figure A-29 + Run Total Invoice Report Example

CIMS Server Web Reporting User’s Guide A-45 N



B Standard Reports

Run Total Percent Report
File name: RIVTC002.rpt
Stored Procedure: CIMSSP_Summary

This report is the same as the Run Total Invoice 1 report (see page A-45) except that the
drilldown includes percent total by account code in addition to units, rate, and charge.

Drilldown:

m Double-click a rate code description or its corresponding units, rate, or charge and
and a breakdown of data by account code appears.

You can set the number of account codes that appear in the drilldown using the TopN
parameter. For example, if you type 2 as the TopN parameter, only the account codes
with the highest and second highest charges appear when you drill down. If you leave
the TopN parameter blank, all account codes for the parameters selected appear.

Parameters:

Invoice Level

m TopN

Starting and Ending Account Code

®m From and To Date
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Run Total Rate Group Percent Report
File name: RIVTC003.rpt
Stored Procedure: CIMSSP_Summary
This report provides charges and percentage by rate groups for the parameters selected.
Drilldown:

m Double-click the charge or percentage for a rate code description and breakdown of
data by account code appears.

You can set the number of account codes that appear in the drilldown using the TopN
parameter. For example, if you type 2 as the TopN parameter, only the account codes
with the highest and second highest charges appear when you drill down. If you leave
the TopN parameter blank, all account codes for the parameters selected appear.

Parameters:

Invoice Level

m TopN

Starting and Ending Account Code
® From and To Date

Report Example

3 CIMS Server, - Microsoft Internet Explorer

File Edit View Favorites Tools Help o
- A © < ) Gl 3
@ Bk - () \ﬂ g" ) D seerh Slpravories @ veds 2 = 3
address | ] http: e, cimsserver.c asp?Invaicelevel: ph=3&Account CodeStart=-+&cboAccountCodeStart: countCadeEnd: boAccountCodeEnd= v | [og G0 Liks >
Run Total Rate Group Percent Publish Return Help a
ER I [ T oft #h .
Preview |
* th charges ]
# O5{390 Tso charges .
) O5{390 InpUEQUERLE charges LW ¥
) O5{390 Printer/Reader charge Cl MS E ﬁ
# O5{390 Starage charges d
# O5{390 DB charges
s enmeemesae | CIMS Run Total Rate Group Percent
+) Unix background job type chal
: j::z :ﬁ:;:f:;:arges Account Range: All
) Oracle charges Date Range: 6/1 /20023 to 6/20/2002
+ M3 windows storage charges Big Time Company
+ M3 windows Oracle charges Corporate Headauarters
+ M3 windows SQL Server Ls q
4 M5 115 2013 Douglas Blvd.
#)- M3 Exchange Suite 120
I MS Windows Processes Roseville, CA 95661
Rate Group Charge %%
| Total O5/390 Batch charges 20,895.13 19.40%
Total 05/390 T=o charges 12,064.15 11.20%
Total 054390 Input/Output charges 11,560,22 10.74%
Total 05/390 Printer/Reader charges 401,854 0.37%
Total 0S5/390 Storage charges 8,491.25 7.89%
Total 0S/390 DB2 charges 0,30 0.00%
Total Unix interactive job type charges 4z1.90 0.39% @
. 5 e . s . e e 5
v
&) Done ® Intemet
L

Figure A-30 + Run Total Rate Group Percent Report Example
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B Standard Reports

Run Total Invoice with Drilldown Report
File name: RIVTC004.rpt
Stored Procedure: CIMSSP_Summary

This report is the same as the Run Total Invoice report (see page A-45) except that this
report provides drilldown by identifier for resource units and rate group and includes
two additional parameters.

Drilldown:

m Click the units for a rate and a new page appears to enable a drilldown of units by
identifier. This page invokes the report Invoice Drilldown for Rate (see page A-13),
Invoice Drilldown for Units by Date (page A-15), or Multilevel Drilldown for Units
(see page A-16).

m Click the rate group name in the Total line and a new page appears to enable a
drilldown of charges by identifier. This page invokes the Invoice Drilldown for Rate
Group (see page A-10) or Invoice Drilldown for Rate Group by Date (page A-12)
report.

m Double-click a rate code description or its corresponding rate or charge and a
breakdown of data by account code appears.

Parameters:

Invoice Level

Invoice Number

Display Graph

Starting and Ending Account Code

From and To Date
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Zero Cost Center Invoice Report
File name: RIVZCO01.rpt
Stored Procedure: None

This report provides zero cost invoicing by account code for the parameters selected. You
can adjust the total invoice amount or the amount for each rate by the zero cost amount.

This report first displays the Zero Cost Center Factor Report. The Zero Cost Center Factor
Report shows the zero factor difference between the total amount due for all account
codes and the zero cost amount. You can run the Zero Cost Center Factor Report
independently (see page A-51).

Drilldown:

m Click the units for a rate and a new page appears to enable a drilldown of units by
identifier. This page invokes the report Invoice Drilldown for Rate (see page A-13),
Invoice Drilldown for Units by Date (page A-15), or Multilevel Drilldown for Units
(see page A-16).

m Click the rate group name in the Total line and a new page appears to enable a
drilldown of charges by identifier. This page invokes the Invoice Drilldown for Rate
Group (see page A-10) or Invoice Drilldown for Rate Group by Date (page A-12)
report.

Parameters:

m Starting and Ending Account Code
m Invoice Level

® From and To Date

m Invoice Number

B Zero Cost Processing Option

B Zero Cost Amount
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B Standard Reports

Report Examples:

CIMS Server - Microsoft Internet Explorer

File Edit  View Favorites  Tools  Help

Qs © ) [2) ] Pover e @ @ @3- % B B

Address @] hitp umm.cinsserver com|reptexec  ssp?AccountCadetart=+EcboAccountCodeStart=+Bccount CodsEnd=zzzzazezaabchoAccount CodsEnd=azezezzzaztrwoicel evel= | Y Go  Links >

Zero Cost Center Invoice Publish Return

X & @R[ -] M & of6+ YoM on | dh | =B

Freview |

CIMS

Zero Cost Center Invoice Billlng Period: 6/1/2003 te &30 3503

Big Time Company
Corporate Headquarters
3013 Douglas Bivd.
Suite 120

Roseville, CA 95661

AA-CIMS Lab, Inc. Roseville

M5 Exchange Emails Sent
M3 Exchange Bytes Received
M3 Exchangs Emails Received

Total MS Exchange

M Windaws Elapsed Time in seconds
MS Windows CRU Tire in seconds

MS Windows Kernel CPU Time in s2conds
M Windaws User CPU Time in seconds
MS Windows Read Requests

MS Windows KB Read

MS Windows KB Written

MS Windows Write Requests

Windows Pages

Total M5 Windows Processes 666518

Sub Total 37,681.90
Zero Reduction Factor 0.87505186
Amount Due 3

41,81

@ Done B Intemet

Figure A-31 + Zero Cost Center Invoice—Factor Total Report Example

CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Tools  Help

Q- © 1B G| Lo drros @ @ 3-5 8 [ 3

Addrass @http:”www‘c\msserver.c \aspPaccountCodeStart=+EcboAccounbCodeStart=+&Account CodeEnd=zzzzzzzzzzdchoAccount CodeEnd=zzzzzzzzzz@lnvoicel evel= ¥ . Go Links >
2ero Cost Center Invoice Publish Return
% & &= o] Mo & of 7t bW os | ‘ ]
Preview |
= Invoice Na. 1 ~|
Zero Cost Center Invoice iling pariog: 672/2003 to 61307 2603 i
Big Time Company
Corporate Headquarters
3013 Douglas Blvd.
Suite 120
Roseville, CA 95661
AA-CIMS Lab, Inc. Roseville
Units Rate Charge
MS Windows Disk Size in ME 69,393.57 0.00000975 |M 0.00
MS Windows Mumber of Files a8 0.00195010 009
Total MS Windows storage charges 0.08 =
M5 Exchange Bytes Sent 178,651,851 17.22
M5 Exchange Emails Sent 1,048 0.00097505 4 0.00
MS Exchange Byres Received 411,967,162 0.00146258 602.53
M5 Exchange Emails Received 5,290 0.00029252 /1 0.00
Total MS Exchange 619,76
MS Windows Elapred Time in seconds 0.00000000 0.00
MS Windows CPU Time in seconds 0.00009751 0.00
MS Windows Kernel CPU Time in seconds 0.00146258 | 0.00
MS Windows User CPU Time in seconds 0.00
MS Windows Read Requests 24.25
MS Windows KB Read 1.55
MS Windows KB Written 0.49
MS Windows Write Requests 5,408,441
Windows Pages 0.00000000 0.0
Total MS Windows Processes 6,502.76
Total Amount Due
~
v
€] Done D Intemet

Figure A-32 « Zero Cost Center Invoice—Factor Rates Report Example
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Zero Cost Center Factor Report
File name: RIVZC002.rpt
Stored Procedure: None

This report appears as the first report in the Zero Cost Center Invoice (see page A-49);
however, you can also run this report independently. The last page of this report provides
the zero factor difference between the total amount due for all account codes and the
zero cost amount.

Drilldown:

m Double-click a rate code description or its units, rate or charge and a breakdown of
charges by account code appears.

Parameters:
m Starting and Ending Account Code
®m From and To Date

B Zero Cost Amount

Report Example

2l CIMS Server - Microsoft Internet Explorer, \LHEWX\
Filg Edit View Favorites Toaols Help q"'
o Al O g Z - 3
Q- © ¥ @ G ) gearch ¢ Favarites @ edia 2) R 3
fuldress (45 hibtps i, cimsserver, comjrephees, sSpPACCOUREC oSt art =+ A CoUnkC e Start—+&ACtoUnt CodeEnd. boAceountCodeEnd nvolceLevel=\v | Ed Go | Links
~
Zero Cost Center Invoice Publish Return Help —
& = - [T > M i ] .
Preview |
@ =
+ BB
5o Total M5 IS 508.43 E
+ DD M3 Exchange Bytes Sent 2261
) EE MS Exchange Emails Sent .00
M3 Exchange Bytes Received 0.19
M5 Exchange Emails Received 0.0
Tatal MS Exchange 5280
M3 Windows Elapzed Time in zeconds
MS Windows CPU Time in seconds
M5 Windews Kernel CPU Time in seconds
MS Windows User CPU Time in secands
M3 Windows Read Requests
MS Windows KB Read 340
MS Windows KB Written 111
M3 Windows Write Requests
Windows Pages .00
Tatal M5 Windows Processes 10,407.37
Amount Due 107,686.58
Zero Value 105,000.00
Zero Factor 0.97505186
£/13/2001 at 2:05:300M Fage 3
hd
v
@ Dane B Intemet

Figure A-33 « Zero Cost Center Factor Report Example
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Percentage Report
File name: RPERX001.rpt

Stored Procedure: CIMSSP_Summary

This report provides the total charge by account code for the parameters selected and
specifies the percentage of that charge in relationship to the total charges for all account
codes. This report also provides a breakdown of the percentage by rate group and rate

code description for each account code.

Drilldown:

m Double-click an account code and a breakdown of percentage by rate group appears.
Double-click a rate group and a breakdown of percentage by rate code description

appears.
Parameters:
m Invoice Level
m Starting and Ending Account Code
m From and To Date

Report Example

3 CIMS Server, - Microsoft Internet Explorer

File Edit View Favorites Tools  Help

Q- O HEG ) semrch o Favares @ ed §2) (- o B

L3

boAccount CodeStart:

Address | &) http: | fuwa, cimsserver.com|reptexec, asp?Invaicel evel=1&Accaunt CodeStart

Percentage
| % & @[=fioe <] || 1 4 1 o1 >y o || o4
Frevlewl

countCodeEnd=zzzezzezaztnbofecountCodeEnd=zzazzezz: ¥ | [ G0

Publish

Return

- €IMS Lab, Inc. Laursl
- CIMS Lab, Inc. International
- CIMS Lab, Inc. Services

CIMS ..
CIMS Percentage Report

Account Range: All
Date Range: 6/1/2003 to 6/30/2002

[~

Charge O
AR - CIMS Lab, Inc. Roseville 37,681.90 34.99%
BB - CIMS Lab, Inc. Gibbsboro 16,889.70 15.68%
CC - CIMS Lab, Inc. Laurel 40,481.11 37.59%
DD - CIMS Lab, Inc. International 7,316.57 6.79%
EE - CIMS Lab, Inc. Services 5,317.30 4.94%
Run Total 107,686.58

3

[

1E2]]

&) Done

B Internet

Figure A-34 + Percentage Report Example
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Rate Report

File name: RRATX001.rpt

Stored procedure: None

This report provides the information contained in the CIMS Rate and Rate Group tables.

Drilldown: None

Parameters: None

Report Example

23 CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Tools  Help

O O BB G Poo o @vn @ 22 8 LB

&
&

Addrass @] hitp e, cimsserver.ci

.asprreport

| = &a@&fm = |1 4 U o1t

Preview |

P oe |8

TXO0L.rptereporttemplatefile=

Publish

Return

Links >

v| B

Rate Report

Description Order

Per  Rsre  Zero Resource  Flat
Value  thou

Conu Cost DecPos  Fess

pise  cPU
Value

Comments

Rate Table: STANDARD

Rate Group: 1 - All unassigned rate
Rate: LLYL03

Rate Group: 2 - 05/38
Rate: 2001
Rate: 2002
Rote: Z003
Rate: 2032
Rote: Z033
Rate: CREDBAT
Rate: SMF30CPT

Rote Group: 3 - 05/380 Tsa chorges
Rate: 2020 Minu
Rote: 2204
Rate: 2022
Rate: 2022
Rote: 2034
Rate: 2035
Rote: 2036

Rale Group: 4 - 05/390
Rate: SMFIOSRY
Rote: SMF30CSU

€] Done

| 4 Internet

Figure A-35 « Rate Report Example
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Top Cost Report
File name: RTOPCO01.rpt
Stored Procedure: CIMSSP_Summary

This report provides the account codes with the highest charges for the parameters
selected. For example, if you type 3 as the TopN parameter, the three account codes with
the highest charges appear (see example Figure A-36 on page A-55). If you leave the
TopN parameter blank, the account codes with the ten highest charges appear.

Drilldown:

m Click the Invoice link and a complete invoice for the account code level appears (see
Invoice Report on page A-39).

B Double-click an account code or its corresponding percent or charge and a
breakdown of charges by rate group appears.

Parameters:
m TopN

m Invoice Level

Starting and Ending Account Code

®m From and To Date
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Report Example

2l CIMS Server - Microsoft Internet Explorer

File Edit  View Favorites  Tools  Help

Q- O 1x] [ G P v @ @ @3- BB

Acddress (] hktp:fum,cimsserver. com/reptescec. sspToph=3dnvoicel svel=1 fAceount CodeStart=+arboAccount CodeStart=+&iccountCodeEnd=zzzzzzzezalicboiccountCodeEnd: % | g Go  Links ™

Top 10 Cost Publish Return

| % & @&for <] |04 Lot »ob o || ok | -}

Preview |

CIMS Top 3 Cost Report

Account Range: All
Date Range: 6/1 /2002 to 6/20/2002

Account % Charges

CC-CIMS Lab, Inc. Laurel 37.590% 40,481.11 Invoice -

AR-CIMS Lab, Inc. Roseville 34.99% 37,681.90 Lnvoice

BB-CIMS Lab, Inc. Gibbsbora 15.68% 16,669.70 Invoice

Other Accounts 11.73% 12,633.87

Total 107,686.58

~
v

@ Dane B Intemet

Figure A-36 * Top Cost Report Example
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B Standard Reports

Top 10 Bar Graph Report
File name: RTOPC002.rpt
Stored Procedure: CIMSSP_Summary

This report is similar to the Top Cost Report (see page A-54). However, it provides
accounts codes with the 10 highest charges for the parameters selected and it provides
the data in bar graph as well as table format.

Drilldown:

m Click the Invoice link and a complete invoice for the account code level appears (see
Invoice Report on page A-39).

m Double-click an account code or its corresponding percent or charge and a
breakdown of charges by rate code description appears in both bar graph and table
format.

Parameters:
m Invoice Level
m Starting and Ending Account Code

m From and To Date
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Report Example

Note ¢ In the following example, there are only five account codes for the account
code level selected.

2l CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Tools  Help

Q- © N [B) €] Lo Frrowe @ @ 35 8 LB

Address ] http:fum.cimsserver.com/reptescec. ssprInvoicel svel=1 fAceount CodeStart=+BrboAccount CodeStart=+&sccountCodeEnd=2zzzzzz2zz e boccountCodeEnd=zezzzzzz ¥ | [£4 G0

Links **

Top 10 Bar Graph Publish Return

|* & @@ = |1« yoroe

Preview |

CIMS Top 10 Cost Report

Account Range: Al
Date Range: 6/1/2003 to 6/30/2003

Account Charges

W cc
|
O es .
I oo 3
W ee
Actount " Charges
CC-CIMS Lab, Inc. Lourel 27.59% 40,481.11
AR-CIMS Lab, Inc. Rossville 24.99% 37,681.90
BE-CIMS Lab, Inc. Gibbsbore 15.68% 16,8898.70
DD-CIMS Lab, Inc. Internstionsl 6.78% 7,316.57
EE-CIMS Lab, Inc. Services 4.94% 5,317.30 lnvoice
Total 107,686.58

@Dnr\a ket

Figure A-37 + Top 10 Bar Graph Report Example
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Top 10 Pie Chart Report
File name: RTOPC003.rpt
Stored Procedure: CIMSSP_Summary

This report is similar to the Top Cost Report (see page A-54). However, it provides
accounts codes with the 10 highest charges for the parameters selected and it provides
the data in pie chart as well as table format.

Drilldown:

m Click the Invoice link and a complete invoice for the account code level appears (see
Invoice Report on page A-39).

m Double-click an account code or its corresponding percent or charge and a
breakdown of charges by rate code description appears in both pie chart and table
format.

Parameters:
m Invoice Level
m Starting and Ending Account Code

m From and To Date
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Report Example

Note ¢ In the following example, there are only five account codes for the account

code level selected.

2} CIMS Server - Microsoft Internet Explorer

File Edit View Favorites  Tools  Help

Qe - () @ @ @ ,OSEar:h %Fathes @ reda 2 8' 3.}; B-L)3

Address ] http: fum.cimsserver. com/reptescec. ssprInvoicel svel=1 fAceount CodeStart=+BrboAccount CodeStart=+&sccountCodeEnd=2zzzzzz2zzleeboccountCodeEnd=zezzzzzz ¥ | (g G0

Top 10 Pie Chart Publish Return

|x & &l =] |14 yoron | dh

Preview |

CIMS Top 10 Cost Report

AccountRange: All
Date Range: 6/1/2003 to 6/30,/2003

Account Charges

B CIMS Lab, Inc. Laurel 37 6%
B CIMS Lab, Inc. Roseville 350%
O CIMS Lab, Inc. Gibbsboro 15.7%
I3 CIMS Lab. Inc. Interriational ~ 6.8%
B CIMS Lab, Inc. Services 49%

Total: 100.0%

Account o Charges
37.58% 40,481.11
34.99% 37,681.80
15.68% 16,888.70

CC-CIMS Lab, Inc
AA-CIMS Lab, Inc.
BO-CIMS Lab, I

DD-CIMS Lab, Inc. Internstion 6.79% 7,216.57
EE-CIMS Lab, Inc. Services 4.94% 5,217.30 Invoice
Total 107,6B6.568
v
I@ Dane B Intemet

Figure A-38 + Top 10 Pie Chart Report Example
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Top Accounts for Rate Report

A-60

File name: RTOPC004.rpt

Stored Procedure: CIMSSP_Summary

This report provides the account codes with the highest usage of a specified rate code for
the parameters selected. For example, if you type 3 as the TopN parameter, the three
account codes with the highest rate code usage appear (see example Figure A-39 on
page A-60). If you leave the TopN parameter blank, the account codes with the ten
highest rate code usage appear.

Drilldown: None

Parameters:

m TopN

m Invoice Level

Starting and Ending Account Code

m From and To Date

B Rate Code

Report Example

File  Edit

Qs -

2l CIMS Server - Microsoft Internet Explorer

View Favorites  Tools  Help

O \ﬂ @ _7;‘, /?USEarch ‘»;":,I)Favuntes @ reds £8) - ;

L3

.','

acddress €] hip o, cmsserver.comraptexcet. 35p?Top+N=3dnwoicel evel=1 BAccountCodeStart=-+ArboAceount CodeStart—+AccountC odeEnd

bofccountCodetn ¥ | [E9 G0 Links

~

Top 10 By Rate Code Publish Return Help
& @[l +| [ T of1 #h .
Freview |
a
- E
CIMS Top 3 Accounts for Rate
Account Range: all
Date Range: 6/1 /2003 to 6/30/2002
05/390 Jobs Started
Account Units Rate Charge Y%
AR-CIMS Lab, Ine. Roseville 1,208 250 3,015.00  6Z.52%
BE-CIMS Lab, Inc. Gibbsboro 405 2.50 1,002.50  #1.00%
CC-CIMS Lab, Inc. Laurel 225 2,50 56250  11.66%
Run Total 1,929 4,822.50

|

&) Done
L

@ Tnternst

Figure A-39 + Top Accounts for Rate Report Example
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Standard Reports H

Cost Trend Report
File name: RTRDCOO1.rpt
Stored Procedure: CIMSSP_Summary_Month

This report provides total charges by account code for each month of the year for the
parameters selected. Monthly charges for each account code are presented on a single
line.

Note ¢ To print this report, use landscape mode on legal paper.

Drilldown: None

Parameters:

m Invoice Level

B Report Year

m Starting and Ending Account Code

Report Example

2l CIMS Server - Microsoft Internet Explorer,

File Edt View Favorites Toos Help >
) S o > W

eﬁack - Q \ﬂ @ (0| ) search ¢ Favories @ reda £4) = 3

Address €] hitp fumw, cmsserver.comfreptexcec. asp?InvoiceL evel=1 &iaar—20038ccount CodeStart=+BcbofccounkCodeStart=-+&Account CodeEnd: bonccountCodef ¥ | B G0 Liks *
Cost Trend Publish Return Help &

& &%= [l ~ [ 1 oof 1+ [ b .
Preview |
+ CIMS Lab, Inc. Rosevile v

+) CIM5 Lab, Inc. Gibbsboro
+| CIM3 Lab, Inc. Laurel
+| CIM5 Lab, Inc. International

Cost Trend For 2003

Account Charges by Month
January February March April May June

Af - CIMS Lab, Inc, Roseville

87,382 4,443 82,234 110,604 105,392 37,682
BB - CIMS Lab, Inc. Gibbsboro

28,985 38,709 33,247 71,273 43,058 16,390
CC - CIMS Lab, Inc. Laursl

32,868 53,335 54,213 1,400 111,072 40,451
DD - CIMS Lab, Inc, International

11,080 4,617 3,702 7,323 18,517 7,317
[EE - CIMS Lab, Inc. Services

€103 7,788 6,264 11,550 3,388 5517

[~
|

< |

&) Done ® Intemet
L

Figure A-40 « Cost Trend Report Example
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B Standard Reports

Cost Trend by Rate Report
File name: RTRDCO02.rpt
Stored Procedure: CIMSSP_Summary_Month

This report provides total charges by rate code description and rate group for each month
of the year for the parameters selected.

Note ¢ To print this report, use landscape mode on legal paper.

Drilldown: None

Parameters:

m Invoice Level

B Report Year

m Starting and Ending Account Code

Report Example

2l CIMS Server - Microsoft Internet Explorer,

File Edit View Favorites Tools Help
@ Back - () E @ £ /',\J Search 5.7 Favortes @M veds 2 (- = i
ficddress | &) hitps s, cimsserver, comreptexet. aspPinvaicel evel=1 countCodeStart=-+&cbofccount CodeStart=-+ Bccount CodeEnd=zzazezzazaticboAccount Codel | [E G0 Links
Cost Trend by Rate Publish Return Help e
& & e 10z~ L] 7 of e b oM i .
Preview |
- 05/390 Batch ~
- 05/390 Tso
#- 05390 Inputjoutput charges e b |
#- 05390 PrintsrReader yt
- 05/390 Storage Al
- O5/390 DBZ
+ T Cost Trend For 2003
/- Uniz background -
#-Lnix storags Rate Charges by Month
- Unilx filesystem
- Oracle
- IS Winddows Storags ) January February March April May June
M5 Windows Oradls Unix disk /O 46 398 56 B 8 40
- M5 Windlows S0 Server Unix character O 1 3 1 0 0 [
T Unix image time 174 225 143 943 73 477
-5 Exchangs Unix connect time 51 68 53 112 45 55
- M5 Windows Processes Urix user CPUI 1 10 3 2 1 1
Unix systsmm CPU 1 6 z 7 [ i
Unix total CRU 6 41 13 17 3 3
Unix mernary 12 52 17 7 34 z
Uni: image court: 869 7,520 1,230 322 120 233
Uni: loging 25 42 23 24 13 13
Unix interactive job 1,186 8,406 1,539 1,439 303 833
type charges
A
L) | G |9 il @ .
A
&) Done ® Internet

Figure A-41 + Cost Trend by Rate Report Example
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Standard Reports H

Resource Usage Trend Report

File name: RTRDROO1.rpt

Stored Procedure: CIMSSP_Summary_Month

This report provides total resource usage by rate code for each month of the year for the
parameters selected. This report is ordered by account code, rate group, and rate code.

Note ¢ To print this report, use landscape mode on legal paper.

Drilldown: None

Parameters:

m Invoice Level

B Report Year

m Starting and Ending Account Code

Report Example

2 CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Tools  Help

Q- Q¥ @ & ) search ¢ Favories @ mede £2) - &8 3

Acldress | €] hitp fumw, cmsserver.comreptexcec. ssp7InvoiceL evel=1 &aar—20038ccount CodeStart=+BcboAccountCodeStart=-+ &Account CodeEnd: bonccountCode ¥ | B G0 Lk *
Resource Usage Trend Publish Return Help had
& &7 [00x - M o4 10 of 14+ > oM dh .
Preview |
# CIMS Lab, Inc. Roseville ~
+1 CIMS Lab, Inc. Gibbsboro E !
+ [ nc. Laure! 5 ] rF
+ CIMS Lab, Inc. International el 5 =
by e Servies Resource Usage Trend
Account For 2003
Rate Usage by Month
January February March April May June
GG - CIMS Lab, Inc. Laurel

08/3290 Batch charges

057390 Jobs Started 300 438 324 651 626 225
057390 Steps Started 1,784 3,262 2,479 4,762 4,741 1,680
05/390 Cpu Mintes 357,74 258,30 165.07 35%.54 298,83 148,64
05/390 Cpu Mintes 358,08 260,61 166,73 118,92 314 111
(Initiators)

05/390 Cpu Mindtes 386,90 282,44 179.07 386,33 324,77 161.16

(ally
0S5/390 Tso charges

Tso Cpu Minutes 7.67 7.09 4.61 8.3 5.63 160

Tso Connect Minutes 5,633.92 16,009, 44 6,259.56 7,115.58 12,004.80 1,555.60

Tso Inputs 24,215 18,840 11,334 20,475 11,344 3577

Tso Outputs 25,209 19,857 13,297 22,838 13,774 4,001

Tso Cpu Minutes (Teb) 3.97

Tso Cpu Minutes 775 718 4.69 2.40 012 0.04

(Initiator) ~

< >
v

&) Done ® Intermet
=

Figure A-42 + Resource Usage Trend Report Example
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B Standard Reports

Transaction Report
File name: RTRNX001.rpt

Stored procedure: None

This report provides the Miscellaneous, Recurring and Credit, transactions for the
parameters selected. For more information about transactions, see Chapter 5, Using

Transactions.
Drilldown: None

Parameters:

® Transaction Type
m Starting and Ending Account Code
® From and To Date

Report Example

2 CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Taools  Help
eﬂack - \ﬂ \E‘ l] /'f‘i Search \',::.:‘Favnmtas @ reds £ (- _/’ 3
Address | &) http: | fuwas. cimsserver. comfreptexec, asp? TransactionType=AgsccountCadeStart=+&cboAccountCadeStart=+&Account CodeEnd=zzzzzzzzzzbchofccount CodeEnd=zzz: v | fog 6o Links
Transaction Report Publish Return Help &,
& &Iz | [ 1 oof1+ > M h .
Preview |
o
Transaction Report
P From Date: 6112003 To Date: 6/3002003
Recurring Transactions Aceout Codes: thiough 7777777777
Resource Date Start  Date Stop
Account Code Rae Code Amount  Freguency Processing Processing
3434342 3
2002 057390 Steps Started 0 Every quarter, period 2 11172001 123172199
Hates: TEst
3
< >
K]
€] Done # Internet

Figure A-43 « Transaction Report Example
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Standard Reports H

Cost Variance Report

File name: RVARCOO1.rpt

Stored Procedure: CIMSSP_Variance

This report provides a comparison of charges by account code, rate code description, and
rate group for a specified month and the month prior for the parameters selected.

Drilldown: None

Parameters:

m Invoice Level
m Report Month
B Report Year
[

Report Example

2l CIMS Server - Microsoft Internet Explorer

Starting and Ending Account Code

&) Done
L

File Edt View Favorites Toos Help e
e Back - () \ﬂ @ NP ) Search :\? Favarices @ vedia %) - & 3
Address ] hktp:ffum,cimsserver. comjreptescec. ssprInvoicel svel=1 &ML astReportingear=21998ML astReportingMonth=128ML astReportingDate=December-+21998GroupType=18 % | g Go  Links
Cost ¥ariance Publish Return Help e
& &7 0x - 4 4 3 of6 > oM dh .
Preview |
S Lab, Inc. Roseville
+ nc. © o _ _
* CIMS Lab, Inc. Laurel 5 - i
+ CIMS Lab, Inc. International Cl Ms : D{; T
+ CIMS Lab, Inc. Services B L
Cost Variance  june 2003
BB-CIMS Lab, Inc. Gibbsboro
May 2003 Jun 2003 Variance Percent
©5/330 Jobs Started 5,377.50 1,012.50 -4,365.00 -8L17
05/390 Steps Started 2,302.00 426,00 -1,874.00 -BL41
©5/350 Cpu Minutes 4,284.05 2,083.74 -2,200.31 -51.36
057390 Batch charges 11,563.55 3.524.24 ~§,439.31  -70.54
Teo Cpu Mindtes 470,22 60,27 -408.95 -87.18
Teo Connect Minutes 14,938.12 7,455.32 -7,482.80 -50.09
Teo Inputs 214,65 17.39 -19%.26 -9L.90
Tso Qutputs 115.57 9,16 -106.41 -92.07
057390 Tso charges 15,736.56 7.542.14 8,196.42  -52.08
Disk SI0s 923,53 352,93 -576.66 -62.0%
Tape SI0s 1,264.06 679,38 -604.68 -47.09
057390 Input/Output charges 7,213.65 T,032.31 ~1,181.34  -53.37
Input Records 56,85 3312 -23.73 -41.74
057390 Printer/Reader charges $6.85 3312 ~Z3.73  -4L74
v
< >
v
® Tnternst

Figure A-44 + Cost Variance Report Example
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B Standard Reports

Cost Variance Drilldown Report
File name: RVARC002.rpt

Stored Procedure: CIMSSP_Variance

This report provides a comparison of charges by rate code description and rate group for
a specified month and the month prior for the parameters selected.

Drilldown:

m Double-click a rate code description or its corresponding monthly totals, variance, or
percent and a breakdown of data by account code appears.

Parameters:

m Invoice Level

B Report Year

m Report Month

m Starting and Ending Account Code

Report Example

<A CIMS Server, - Microsoft Internet Explorer

File Edt View Favortes Toos  Help °
o Al O > o 3
(€2 BREK ) S search ¢ Favares @ eda ) [ = 3
address @] http i, cimsserver, com/reptexec. aspPlnvaicel svel=1 ast 1996 astReporti h—128MLastReportingDate=December+2199a6r ¥ | [Eg 6o Links
Cost ¥ariance Drilldown Publish Return Help bl
& @7 [0 =] T T b oM os | ®
Preview |
¥ 05/390 Batch charges N
¥ 05/390 Tso charges
&S 1 InputfOutput charges] g
/- 05390 Printer/Reader charge , .
[+ 05/390 Storage charges L e
[+ 05/390 DEZ charges - =
s ummeeenmeda | COSt Variance Drilldown June 2003
- Unix background job type chal
- Unix storage charges May 2002 Jun 2002 Variance Percent
- Oracle charges
B1-MS Windaws storage charges ©8/390 Jobs Started 17,212.50 4,822.50 -12,390.00 7198
B1-MS Windaws Oracle charges ©8/390 Steps Started 15,692.50 5,105.00 -10,587.50 67.47
- MS Windows SQL Server ©5/330 Cpu Minutes 22,782.16 10,967.63 -11,814.53 -5L86
B MS 115 057390 Batch charges T5,667.16 70,895.13 34,7920 -62.48
¥ M5 Exchange
- M5 Windows Processes Tso Cpu Minutes 1,097.20 02,39 -794.81 -72.44
Tso Connect Minutes 36,760.90 11,658.42 -25,102.48 -68.29
Tso Inputs 367,66 67.48 -300.40 -BLEG
Tso Outputs 208.13 35.89 -172.24 -B2.76
057390 Tso charges 78,434.11 12,064.18 “Z6,369.93 - 68.61
Disk S10s 15,418.22 6,825.54 -8,592.68 -55.73
Tape SIOs 10,276.41 4,734.68 -5,543.73 -53,94
057390 Input/Output charges 75,606.63 11,560.22 14,136.41  -55.01
TnpLt Recards T860.75 D ~T,458.91 78,40
057390 Printer/Reader charges T,860.75 0184 1,458.81  -78.40
Disk Dats Sets 27,841.00 8,491.25 -19,349.75 -69.50
NC 73200 CFavana « F=vnac 77 RA1 NN R/ AQ1 DK -10 =40 75 P ]
< EIES
v
&) Done @ Internet
=

Figure A-45 + Cost Variance Drilldown Report Example
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Standard Reports H

Resource Variance Report
File name: RVARROOL.rpt
Stored Procedure: CIMSSP_Variance

This report provides a comparison of resource usage by account code, rate group, and
rate code description for a specified month and the month prior for the parameters
selected.

Drilldown: None

Parameters:

m Invoice Level

B Report Year

m Report Month

m Starting and Ending Account Code

Report Example

2 CIMS Server, - Microsoft Internet Explorer, r__”'ilg‘
File Edt View Favorites Toos Help &
Q- © ¥ @ & ) search ¢ Favarites @ meda F) - 3
Address [ €] hitpe fum, cmsserver.comfreptexcec. asp?Invoicel evel=1 ast i 19980 astReporti h—128MLastReportingDate=Decemper+219386r ¥ | [ G0 Links *

Resource ¥ariance Publish Return Help 2
& &7 - M4 2 of o+ > oM dh .

Preview |

¥ CIMS Lat, Inc. Rosevile ~

% CIMS Lah, Inc. Gitbsboro - .

# CIMS Lab, Inc. Laurel (75 &

+ CIMS Lab, Inc. International ;lv i

CIM s 4 e
Resource Variance June 2003
EE-CIMS Lab, Inc. Services
May 2003 Jun 2003 Variance Percent
057390 Batch charges
©5/330 Jobs Started 123 44 -73 64,23
©5/330 Steps Started k] 16 -17 -5L52
©5/350 Cpu Minutes 0.55 0.01 -0.54 -98.75
057390 Input/Output charges
Disk 5108 302 36 -266 -850
057390 Printer/Reader charges
Input Records 1z z -10 8333
057390 Storage charges
Disk Data Sets 16 H -14 -87.50
Unix interactive job type charges
Urix disk /0 5 ks 10 4216
Unix charactsr /O 43,906 39,118 -4,785 -10.90
Unix image time 762,42 714,12 -48.30 -6.33
Unix connect time 94,20 99.71 551 585 W
< >
v
&) Done B Intemet
L—

Figure A-46 + Resource Variance Report Example
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B Standard Reports

Account Summary by Week Report
File name: RWEKCOO1.rpt
Stored Procedure: CIMSSP_Summary_Day

This report provides the total weekly and monthly charges by account code and rate code
description for the parameters selected.

Drilldown:

m Double-click the charge for a week and a breakdown of charges by rate code
description appears.

Parameters:

m Invoice Level

m Starting and Ending Account Code
m From and To Date

Report Example

2 CIMS Server - Microsoft Internet Explorer

Fle Edt Wew Favortes Tooks Help e
Q- (¥ @& ) search 57 Favorites @ veda €2 - 3
Address |&] http:/fmaw.cimsserver.comjreptexec. asp?nvoicel evel=1 &AccountCodeStart=+EcboAccountCodeStart=+EAccount CodeEnd: boAceountCodsEnd vIBe ks *
Account Summary by Week Publish Return Help i
2 & =[x - 1 oft &4 .
Preview |
—
+ CIMS Lab, Inc. International ' IMS s A{l by
+ CIMS Lab, Inc. Services g i
Account Summary By Week  rrom: 6/1/2003 To: 6/30/2003
Account Charge
AA - CIMS Lab, Inc. Roseville
wWeek of 6/1/2003 to 6/7/2003 20,722, 47
Week of 6/8/2003 to 6/14/2003 16,959.43
June 2003 37,681.50
Total for A& - CIMS Lab, Inc. Roseville 37,661.50
[BB - GIMS Lab, Inc. Gibbsboro |
wWeek of 6/1/2003 to 6/7/2003 7,264.62
week of 6/8/2003 to 6/14/2003 9,624,688
June 2003 18,889.70
Total for BB - CIMS Lab, Inc. Gibbsboro 16,889.70
CC - CIMS Lab, Inc. Laurel
week of 6/1/2003 to 6/7/2003 22,44870 W
< >
~
L&) Done: & Internet
L

Figure A-47 + Account Summary by Week Report Example
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Standard Reports H

Account Summary by Week—-Wide Report
File name: RWEKC002.rpt

Stored Procedure: CIMSSP_Summary_Day

This report is similar to the Account Summary by Week report (see page A-68). However,

the weeks are displayed across the top of the page.

Drilldown:

m Double-click an account code and a weekly breakdown of charges by rate code

description appears.
Parameters:
m Invoice Level
B Report Year

m Report Month

Starting and Ending Account Code

Report Example

) CIMS Server, - Microsoft Internet Explorer

Fle Edt Wew Favortes Tooks Help e
- 8 O <4 \ = o
Q- (¢ @& ) search ¢ Favorites @ vedia 2 & 3
Address |ej hittp: ffuwww,cimsserver  comjreptexac, asp?invoiceL svel=1 &Y ear=20034MLastReporting e ar=2199ML astReportingMonth=126ML astRsportingDate=December+21 998Gt V\ B s ®
Account Summary by Week - Wide Publish Return Help *
& &= - [ 1 oft #h .
Preview |
—
) CIMS Lab, Inc. T
# CIMS Lab, Inc, International
+ CIMS Lab, Inc. Services Account Summary By Week
Charges
/172003 /82003 &/15/2003 6/22/200% B/29/200% MTD
£/T/2003 E£/14/200% £/21/2003 E/28/200% £/30/200%
A - CIMS Lab, Inc. Roseville
BE - CIMS Lab, Inc. Gibbsboro
28182 5,624.55 15
©C - CIMS Lab, Inc. Laurel
22,145.70 18,031.41 10,4511
DD - CIMS Lab, Inc. International
| 1 a6
EE - CIMS Lab, Inc. Services
! 5161 1
Report Total 55.238.50 52,447,558 10
v
£} 2
~
@Dnne B Internet

Figure A-48 « Account Summary by Week—Wide Report Example
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B Standard Reports

Account Summary YTD Report
File name: RYTDCOO1.rpt

Stored Procedure: CIMSSP_Summary_Month

This report provides the total monthly and YTD charges by account code, rate group, and

rate code description for the parameters selected.

Drilldown:

® Double-click a month or the charge for a month and a breakdown of charges by rate
group appears. Double-click a rate group and a breakdown of charges by rate code

description appears.
Parameters:
m Invoice Level
B Report Year

m Starting and Ending Account Code

Report Example

2 CIMS Server - Microsoft Internet Explorer

Filz  Edt Wew Favortes Tools  Help o
ek ~ Iﬂ IELI > /.'3 Search 5/ Favortes @ redis £2) - = 32
Address | &) hitp: v, cimsserver comjreptexet asprinvaiceLevel=18ear=2003&Actount Code Start=- &eboAccount CodeStart countCodeEnd=zzzzzzzzzzinhoAccountCodeE v | [ Go  Links
Account Summary YTD Publish Return Help Ay
& & =2 [z - 1 oft L] .
Preview |
—
%) CIMS Lab, Inc. Laurel d F -
%) CIM5 Lah, Inc. International ] A .
# CIMS Lab, Inc, Services g % 35
Account Summary Year To Date For: 2003
Account Charge
| AA - CIMS Lab, Inc. Roseville
January 2003 87,381.95
February 2003 84,449.22
March 2002 82,234.27
April 2003 110,604.39
May 2003 105,392.23
June 2003 37,681.90
¥TD A& - CIMS Lab, Inc. Roseville E07,743.96
BB - CIMS Lab, Inc. Gibbsboro
January 2003 28,984.62
February 2003 36,708.66
March 2003 33,246.62
#pril 2003 71,272.80
May 2003 43,056.39
June 2003 16,889.70
¥TD BB - CIMS Lab, Inc. Gibbsboro 230,158.79
Cc - OTMS | ah. Tnre. | aurel A
< >
v
L& Done B Internet

Figure A-49 + Account Summary YTD Report Example
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Standard Reports H

Account Summary YTD—-Wide Report
File name: RYTDCO02.rpt

Stored Procedure: CIMSSP_Summary_Month

This report is similar to the Account Summary YID report (see page A-70). However, the

months are displayed across the top of the page.

Drilldown:

m Double-click an account code and a monthly breakdown of charges by rate code

description appears.
Parameters:
m Invoice Level
B Report Year
m Starting and Ending Account Code

Report Example

<A CIMS Server - Microsoft Internet Explorer

Fle Edt Wew Favortes Tooks Help e
- fu ) e e = 2
Q- © (¥ B & ) search ¢ Favorites @ viedia ) & 3
Address|@ http: v, cimsserver comjreptexec. asp?InvoiceLevel=1 &Y sar=2003fA0c0Unt CodeStart=+arhoAccountCodeStart=+Ac countCodeEnd hnAcmuntCndaEV‘ Go Links ¥
Account Summary YTD - Wide Publish Return Help &
&&= - I o i+ > oM # =]
Preview |
C] , e &
+ CIMS Lab, Inc. Gibbsbaro .
+ CIMS Lab, Inc. International —
+I CIMS Lab, Inc. Services Account Summary Year To Date For zo03
Account Charges by Month YTD
January | February | March | April | May | June |
July | Tuly | ptember | Gctober | November | December |
[ A& - CIMS Lab, Tnc. Rozeuills ]
1,498, 1 110,604 37.681.90
507,743.96
BB - CIMS Lab, Inc. Gibbsboro
28,584,627 3321662 L2725 13,056,390
230,158.79
CC - CIMS Lab, Inc. Laurel
----- i a 52130 L 111,072.4 10.481.11
373,370.29
DD - CIMS Lab, Inc. International
1107973 1.617.2 370159 3228 18,5170
52,554.97
EE - CIMS Lab, Inc. Services
515267 7.787.84 1,54 17
46,495.68
v
< >
v
L&) Done & Intsrnst
L

Figure A-50 « Account Summary YTD—Wide Report Example
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B Standard Reports

Spreadsheets

This section describes the CIMS Server spreadsheets. When you run a spreadsheet, CIMS
Server Web Reporting presents the report data in Microsoft Excel. In addition to viewing
the report in the Web browser, you can also save the spreadsheet as an Excel or other file
or publish the report for all users. For more information, see Working with Spreadsheets

on page 3-9. You must have Excel installed on the client running the spreadsheet.

Invoice Spreadsheet
File name: SINVCOO1.rpt
Stored Procedure: None
This spreadsheet provides invoice information for the parameters selected.
Drilldown: None
Parameters:
m Invoice Level
m Starting and Ending Account Code
m From and To Date

Report Example

CIMS Server - Microsoft Internet Explorer

File Edit Wiew Favorites Tools Help
ook ~ BREEAIPeE Fovorites @ Meda ) = 3
Address | @] http: | fuwa, cimsserver.com|reptexec, asp?Invaicel evel=1&Accaunt Codestart boAccountCodestart: countCodeEnd=CCRchoAccountCodeEn: ¥ a Go  Links >
Spreadsheet Invoice * Return
H30 - £/15£2003
A B € D E F G H 1 J
1 |AccountMame AccountCode RateCode RateDescripti RateGroup  GroupTitle StartDate EndDate Resourcelnits RateValue Per s
2 |CIMS Lab, IniAA Zool 0S5/390 Jobs 2 05/390 Batch 6/1/2003 6/30/2003 1,452.00 2.50
3 |CIMS Lab, IntAA Zooz 05/390 Steps 2 05/390 Batch 6/1/2003 6/30/2003 7,135.00 0.50
4 |CIMS Lab, IniAA Z003 0S5/390 Cpu f 2 05/390 Batch 6/1/2003 6/30/2003 314.29 20.00
5 |CIMS Lab, IntAA Z032 05/390 Cpu § 2 05/390 Batch 6/1/2003 6/30/2003 3.44 0.00
B |CIMS Lab, IniAA Z033 0S5/390 Cpu f 2 05/390 Batch 6/1/2003 6/30/2003 357.27 0.00
7 |CIMS Lab, IntAA Zoz0 Tso Cpu Miny 3 05/390 Tso 6/1/2003 6/30/2003 9.9z 25.00
g |CIMS Lab, IniAA ZZ04 Tso Cannect | 3 05/390 Tso 6/1/2003 6/30/2003 16,218.45 0.25
3 |CIMS Lab, IntAA Z0z1 Tso Inputs 3 05/390 Tso 6/1/2003 6/30/2003 29,003.00 200 M
10 |CIMS Lab, IniAA Z022 Tso Qutputs 3 05/390 Tso 6/1/2003 6/30/2003 30,826.00 1.00 M
11 |CIMS Lab, IntAs Z035 Tso Cpu Miny 3 05/390 Tso 6/1/2003 6/30/2003 011 0.00
12 |CIMS Lab, IniAA Z036 Tso Cpu Minu 3 05/390 Tso 6/1/2003 6/30/2003 10.60 0.00
13 |CIMS Lab, Intas 2005 Total S10s 5 05/390 Input 6/1/2003 6/30/2003 26,625,572.00 000 M
14 |CIMS Lab, IniAA 2006 Disk SI0s 5 05/390 Input 6/1/2003 6/30/2003 16,325,356.00 0.25 M
15 |CIMS Lab, IntAs Z007 Tape SI0s 5 05/390 Input 6/1/2003 6/30/2003 10,300,216.00 035 M
16 |CIMS Lab, IniAA Z014 Input Record: 6 05/390 Printe 6/1/2003 6/30/2003 386,100.00 1.00 M
17 |CIMS Lab, IniAs ZZ0% Tape Mounts 7 05/390 Stora 6/1/2003 6/30/2003 1,992.00 0.00
18 |CIMS Lab, IniAA ZZ06 Disk Data Sel 7 05/390 Stora 6/1/2003 6/30/2003 18,375.00 0.25
13 |CIMS Lab, IntAA ZZ33 DBZ Transact 10 ©5/390 DB2 6/1/2003 6/30/2003 17.00 0.0z
20 |CIMS Lab, IniAA 2734 OB2 Transact 10 0S/390 DBZ 6/1/2003 6/30/2003 0.27 015
21 |CIMS Lab, IniAs LLALOL Unix disk 1/0 12 Unix interacti: 6/1/2003 6/30/2003 44,38 0.10
22 |CIMS Lab, IniAA LLalnZ Unix characte 12 Unix interacti- 6/1/2003 6/30/2003 17,502.97 0.00 M
23 |CIMS Lab, IntAs LLALDZ Unix image tit 12 Unix interacti: 6/1/2003 6/30/2003 17471 0.038
24 |CIMS Lab, IniAA LLAln4 Uniz connect 12 Unix interacti- 6/1/2003 6/30/2003 362.80 0.10
25 |CIMS Lab, IniAs LLALDS Unix user CPL 12 Unix interacti: 6/1/2003 6/30/2003 18.79 0.01
26 |CIMS Lab, IniAA LLALO6 Uniz systern 12 Unix interacti- 6/1/2003 6/30/2003 317 0.02
27 |CIMS Lab, IntAs LLALD? Unix total CPL 12 Unix interacti: 6/1/2003 6/30/2003 21.98 0.03
20 |CIMS Lab, IniAA LLA10B Uniz mernory 12 Unix interacti- 6/1/2003 6/30/2003 1,724,530.10 0.00 M
23 |CIMS Lab, IniAA LLALDS Unix image cc 12 Unix interacti: 67142003 6/30/2003 7.,260.00
W[ 4[» M} SINVCOOL.pt / |4
&) Dane 0 Internet

Figure A-51 + Invoice Spreadsheet Example
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Run Total Invoice Spreadsheet
File name: SINVC002.rpt

Stored Procedure: None

This spreadsheet provides total invoice information by rate code for the parameters

selected.

Drilldown: None

Parameters:

m Starting and Ending Account Code
m From and To Date

Report Example

2 CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Toos Help -z
Q@ sk - %] @] | O seach e Favories @ ede £2) = 3
&) hitp [, chnsserver . comjreptesec. aspPAccountCodeStart=+BeboficcountCodsStart=+Account CodsEnd bofccountCodeEnd ~oanat v | B co >
Spreadsheet Run Total e path Publish Return Help &
F439 = 673072003
A B [ D E F G H =
1 |RatsCode  RateDescription RateGroup  GroupTitls StartDate  EndDate  ResourceUnits  RateValus  Per 1000 |
2 zooi 035/390 Jobs Started 2 05/390 Batch 6/1/2003  6/30/2003 2,649.00 250
3 |zo0z 05/390 Steps Started 2 05/390 Batch 6/1/2003  6/30/2003 13,398.00 050
4 |zoos 05/390 Cpu Minutes 2 05/390 Batch 6/1/2003  £/30/2003 598.22 20,00
5 |z03z 05/390 Cpu Minutes (Initistors) 2 05/390 Batch 6/1/2003  6/30/2003 .05 0.00
5 |z033 05/390 Cpu Minutes (All) 2 05/390 Batch 6/1/2003  £/30/2003 560,28 0.00
7 |zoz0 Tso Cpu Minutes 3 05/390 Tso 6/1/2003  6/30/2003 1681 25.00
5 zz04 Tsa Connect Mindtes 3 05/390 Tsa 6/1/2003  £/30/2003 52,707.13 028
§ |zoz1 Teo Inputs 3 05/390 Tso 6/1/2003  6/30/2003 52,912.00 200 M
10 |zozz Tsa Outputs 3 05/390 Tsa 6/1/2003  £/30/2003 56,396.00 100 M
11 |z03s Tso Cpu Minutes (Initiator) 3 05/390 Tso 6/1/2003  6/30/2003 025 0.00
12 |zo3e Tsa Cpu Minutes (All) 3 05/390 Tsa 6/1/2003  £/30/2003 1810 0.00
13 |zoos Total 5105 5 05/390 Input/Output charges  6/1/2003  6/30/2003  49,176,613.00 000 M
14 zoos Disk S10s 5 05/390 Input/Output charges  6/1/2003  6/30/2003  33,381,168.00 025 M
15 |zoo7 Tape S10s 5 05/390 Input/Output charges  6/1/2003  6/30/2003  15,795,444.00 035 M
16 | Z014 Input Recards & 05/390 Printer/Reader 6/1/2003  £/30/2003 429,266.00 100 M
17 |zzos Tape Mounts 7 05/390 Storage 6/1/2003  6/30/2003 2,509.00 0.00
18 zzo6 Disk Data Sets 7 05/390 Storage 6/1/2003  £/30/2003 47,330,00 028
19 |zz33 DBZ Transactions (Records) 10 05/390 DB2 6/1/2003  6/30/2003 17.00 0.0z
20 |zz34 DBZ Transastion Elapsed Minutes 10 0S/390 DB2Z 6/1/2003  £/30/2003 027 01s
21 |Latot Unix disk 1/0 12 Unix interactive 6/1/2003  6/30/2003 400,60 010
22 |LLatoz Unix charagter /O 12 Unix interactive 6/1/2003  £/30/2003 101,518.50 000 M
23 |LLat03 Unix image time 12 Unix interactive 6/1/2003  6/30/2003 5,295.13 0.08
24 |LLatod Unix conneet time 12 Unix interactive 6/1/2003  £/30/2003 512,98 010
25 |LLAL0S Unix user CPU 12 Unix interactive 6/1/2003  6/30/2003 90,50 001
26 |LLALDE Unix system CPU 12 Unix interactive 6/1/2003  £/30/2003 1397 0.0z
27 |LLato? Unix tatal CPU 12 Unix interactive 6/1/2003  6/30/2003 104,46 0.03
28 |LLAl0g Unix memory 12 Unix interactive 6/1/2003  §/30/2003  3,532,685.27 000 M
29 |LLA10g Unix image count 12 Unix interactive 6/1/2003  6/30/2003 11,908.00 0.0z
W[ [l STIVWCO02.mp0t / o [« ’
&) Done B Intemet
|

Figure A-52 + Run Total Invoice Spreadsheet Example

CIMS Server Web Reporting User’s Guide

A-73 N



B Standard Reports

Invoice by Rate Group Spreadsheet
File name: SINVC003.rpt

Stored Procedure: None

This spreadsheet provides invoice information for the rate codes within a selected rate

group for the parameters selected.
Drilldown: None
Parameters:

Invoice Level

Starting and Ending Account Code
® From and To Date

® Rate Group

Report Example

CIMS Server - Microsoft Internet Explorer

File Edt View Favorites Tools Help &

Q- O @G ) search 57 Favartes @ Mese €2) 2 R 3
om/reptexec,asprinvoicele &AccountCodeStart boaccountCodestart: countCodeEnd=zzzzzzzzzzBrboAccountCodeE: ~ .Gn Links >
Return
A B C D E F G H | J K~

1 |AccountName AccountCode RateCode  RateDescription RatcGroup | GroupTitle | StartDate  EndDate  Resourcelnits  Rotevslue  Per 100(—

2 |cims Lab, BB LLw101 M3 Windows Oracle logins 24 M3 Windows | 6/1/2003  6/30/2003 26.00 0.80

3 |CIMS Lab, IniEE LLw10zZ MS Windows Oracle session 24 MS windows « 6/1/2003  6/30/2003 153.33 0.25

4 |cims Lab, BB LLW103 MS Windows Oracle connect 24 MS Windows « 6/1/2003  6/30/2003 7,997.60 1.00 M

5 |CIMS Lab, IniBE LLw104 MS Windows Oracle uga mer 24 MS windows | §/1/2003  6/30/2003  5,358,022.34 0.00 M

 |CIMS Lab, IniBB LLW105 MS Windows Oracle pas mer 24 M3 Windows | 6/1/2003  6/30/2003 67,352,426.54 0.00 M

7 |CIMS Lab, IniEE LLw108 MS Windows Cracle physical 24 MS windows « 6/1/2003  6/30/2003 26,124.24 0.20 M

§ |CIMS Lab, IniBB LLw103 MS Windows Oracle physical 24M3 Windows | 6/1/2003  6/30/2003 40,118.17 0.80 M

§ |CIMS Lab, IniBE LLw110 MS Windows Oracle write et 24 MS windows | 6/1/2003  6/30/2003  6,427,025.70 0.00 M

10 CIMS Lab, BB w11z MS Windows Oracle messag: 24 M3 Windows | 6/1/2003  6/30/2003  187,653.35 0.06 M

11 | CIMS Lab, IniBE LLWw113 MS Windows Oracle messagi 24 MS windows « 6/1/2003  6/30/2003  187,376.72 0.00

12

13

14

15

16

17

18

13

20

21

22

23

24

25

26

27

28

23

W[« > [ ph SINVCOD3.rpt / || [ N

v

&) Done # Internet

Figure A-53 + Invoice by Rate Group Spreadsheet Example
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Invoice by Account Code Spreadsheet

File name: SINVC004.rpt

Stored Procedure: CIMSSP_Summary

This spreadsheet provides invoice information by account code for the parameters
selected.

Drilldown: None

Parameters:

m Invoice Level

m Starting and Ending Account Code

®m From and To Date

Report Example

icrosoft Internet Explorer

Fie Edt ‘View Favortes Tools Help ]
[EE \ﬂ E" ) ) ssarh 57 Favorites @ Media 4£2) - & 3
&) http:Jwmawn cimsserver..com|reptexec. aspPInvaicel evel=4&Accaunt Codestart boaccountCodestart: countCodeEnd: boAccountCodeEnd - .Gn >
Return
05038 hd £/30/2003
A B C D E J K L [} ] 0 =
1 | AccountCode Division Department  User Other RoteCode  RateDescripti RsteGroup  GroupTitle  StertDate  EndDate
2 ARAAAAKK TEAA AAARA KK IBMUSER 2733 DBZ Transact 10 05/330 DB2  6/1/2003 6730/
3 [ ARARARKK TEAR ABAA KK IBMUSER zz34 DBZ Transact 10 05/390 DBZ  6/1/2003  6/30/.
4 |ARARAAKKRG AR BAAA KK hobbes / LLR101 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/,
5 AAAAAAKKhD AR ABAA KK hobbes / LLR10Z Unix filesyste 19 Unix filesyste  6/1/2003  6/30/.
B |ARARAAKKNG AR BAAA KK hobbes / LLR103 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/,
7 AAAAAAKKhD AR ABAA KK hobbes /home LLR101 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/.
B |ARARAAKKRG AR BAAA KK hobbes /hame LLR1DZ Unix filesyste 19 Unix filesyste  6/1/2003  6/30/,
3 ARAAAAKKhD AR ABAA KK hobbes /home LLR103 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/.
10 AARARAKKRS AR BAAA KK hobhes /opt LLR101 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/,
11 | ARAARAKKNhD AA ABAA KK hobbes /opt LLR10Z Unix filesyste 19 Unix filesyste  6/1/2003  6/30/.
12 AARARAKKNS AR BAAA KK hobhes /opt LLR103 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/,
13 | ARAARAKKNhD AA ABAA KK hobbes /mp LLR101 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/.
14 AARARAKKNS AR BAAA KK hobbes /Amp LLR1DZ Unix filesyste 19 Unix filesyste  6/1/2003  6/30/,
15 | ARAARAKKNhD AA ABAA KK hobbes /mp LLR103 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/.
16 AARARAKKNS AR BAAA KK hobhes fusr LLR101 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/,
17 | ARAARAKKNhD AA ABAA KK hobbes /usr LLR10Z Unix filesyste 19 Unix filesyste  6/1/2003  6/30/.
10 AARARAKKNS AR BAAA KK hobhes fusr LLR103 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/,
13 | ARAARAKKNhD AA ABAA KK hobbes /var LLR101 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/.
20 AARARAKKNS AR BAAA KK hobbes fvar LLR1DZ Unix filesyste 19 Unix filesyste  6/1/2003  6/30/,
21 | ARAARAKKhD AA ABAA KK hobbes /var LLR103 Unix filesyste 19 Unix filesyste  6/1/2003  6/30/.
22 AARARAKKNS AR BAAA KK hobbes adm LLD101 Unix Black we 15 Unix storage  6/1/2003  6/30/,
23 | ARAARAKKhD AR ABAA KK hobbes arsap LLD101 Unix Block we 15 Unix storage  6/1/2003  6/30/.
24 AARARAKKNS AR BAAA KK hobbes belayton LLD101 Unix Black we 15 Unix storage  6/1/2003  6/30/,
25 | ARAARAKKhD AA ABAA KK hobbes bin LLD101 Unix Block we 15 Unix storage  6/1/2003  6/30/.
26 AARARAKKNS AR BAAA KK hobbes daeman LLD101 Unix Black we 15 Unix storage  6/1/2003  6/30/,
27 | ARARRAKKhD AR ABAA KK hobbes george LLa10Z Unix characte 12 Unix interactic  6/1/2003  6/30/.
20 AARARAKKNS AR BAAA KK hobbes gearge LLA103 Unix image tit 12 Unix interactis  6/1/2003  6/30/,
23 | ARAARAKKhD AA ABAA KK hobbes george LLA104 Unix connect 12 Unix interactic  6/1/2003  6/30/2 —
W[4 ph SINVCOD4.1pt / [] . N
v
&) Done 4 Internet

Figure A-54 + Invoice by Account Code Spreadsheet Example
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B Standard Reports

Proration by Total Amount Spreadsheet
File name: SPERX001.rpt
Stored Procedure: CIMSSP_Summary

This spreadsheet enables you to prorate an amount that you enter as a parameter across
account codes. The percentage prorated to each account is based on the total charge
incurred by the account. That is, the higher the total charge for an account, the higher the
percentage of the prorate amount that is assigned to that account.

Drilldown: None
Parameters:
m Invoice Level

B Prorate

Starting and Ending Account Code
® From and To Date
Report Example

In the following example, $100,000 is prorated across accounts for the parameters
selected.

2} CIMS Server - Microsoft Internet Explorer, @@@
Ty
€

File Edit View Favorites Tools Help
(€ \ﬂ E" ) ) ssarh 57 Favorites @ Meda ) - & 3
Address | @] http: | fuwan cimsserver.com|reptexec. asp?Invaicelevel=1 countCodeStart=+&rhboAccountCadeStart=+&AccountCodeEnd: boaccount ¥ aGn Links >

Proration by Tatal Amount Open with Publish Return
Excel

1 Account Range: All Il

2 |Date Range: 6/1/2003 to 6/30/2003

3

4 Account Cods Account Name Charges Percent Frorsted Amount

5 |aa CIMS Lab, Inc. Rosaville 58,224.31 35.77% 35,765.95

6 BB CIMS Lab, Inc. Gibbsbora 4392241 17.61% 17,806.05

7 lcc CIMS Lab, Inc. Laurel 52,184.32 33.32% 33,317.35

8 DD CIMS Lab, Inc. International 18,038.30 7.31% 7,312.69

9 EE CIMS Lab, Inc. Services 14,301.8% 5.80% 5,797.96

10 |Run Total 246,671.23 100% 100,000.00

11

12

13

14

15

16

17

15

19

20

21

22

23

24

25

26

27

28 |

29 i
W] 4[> | v\ SPERXOOLrpt / |«] B[

v

&) Done B Intemet
=

Figure A-55 « Proration by Total Amount Spreadsheet Example
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Proration by Rate Code Spreadsheet

File name: SPERX002.rpt

Stored Procedure: CIMSSP_Summary_RateCode

This spreadsheet is similar to Proration by Total Amount report (see page A-77) except
that the prorate amount is applied by account code to the rate code that you select.

Drilldown: None

Parameters:

m Invoice Level

B Prorate

m Starting and Ending Account Code
m From and To Date

m Rate Code

Report Example

In the following example, $50,000 is prorated across accounts charged for the rate code

7006 for the parameters selected.

2} CIMS Server - Microsoft Internet Explorer, @@S‘
Jm
o

File Edit View Favorites Tools  Help

Qs - %) @] | O seach e Favories @ ede €2 = 3

furess | @] hitp o, cimsserver com|reptexec asp?Invoicel evel—1Prorate=50000RAc countCodsStart=+cbofccountCodeStart =+ Account CodeEnd=azezazezezticboaceountc v | B G0 Links >

Open with Publish

Excel Return

Proration by Rate Code

Account Range: All
Date Range: 6/1/2003 to 6/30/2003
Z006-Disk S10s

1
2
3
4
5 |Account Code Account Name Charges Percent Prorated Amount
6 | AA CIMS Lab, Inc. Roseville 7,344.72 43.36% 21,678.91
7 BB CIMS Lab, Inc. Gibbsboro 975.22 5.76% 2,678.49
8 cC CIMS Lab, Inc. Laurel 5,919.47 34.94% 17,472.10
9 DD CIMS Lab, Inc. International 2,700.33 15.94% 7,970.38
10 EE CIMS Lab, Inc. Services 0.04 0.00% 01z
11 |Run Total 16,939.78 100% 50,000.00

28 |

29 =

W4« [ ¥} SPERXDOZ.rpt / |«] L Hipis
-

&) Done ® Internet
—

Figure A-56 + Proration by Rate Code Spreadsheet Example
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B Standard Reports

Proration by Rate Group Spreadsheet
File name: SPERX003.rpt

Stored Procedure: CIMSSP_Summary_RateGroup

This spreadsheet is similar to Proration by Total Amount report (see page A-77) except
that the prorate amount is applied by account code to the rate group that you select.

Drilldown: None

Parameters:

m Invoice Level

B Prorate

m Starting and Ending Account Code
® From and To Date

m Rate Group

Report Example

In the following example, $30,000 is prorated across accounts charged for rate codes
belonging to the rate group OS/390 Input/Output charges for the parameters selected.

File Edit View Favorites Tools  Help

@Eack - \ﬂ @ l, /‘.-]SEarEh %Favuntes @ reda 4

Proration by Rate Group

2} CIMS Server - Microsoft Internet Explorer, @@S‘
Jm
o

fudress | @) hittp o, cinsserver comjreptexec ssp7Involcel evel=1 BProrate=30000RAcCoUntCodeStart=+ BeboficcountCodsStart =+ BAccount CodeEnd=azezezzzzztucoaccountc | £ Go
Open with

Excel

L3
Links

Publish Return

Account Range: All
Date Range: 6/1/2003 to 6/30/2003
087390 Input/Output charges

Account Name

CIMS Lab, Inc. Roseville
CIMS Lab, Inc. Gibbshoro
CIMS Lab, Inc. Laurel

CIMS Lab, Inc. International
CIMS Lab, Inc. Services

AA
BB
cC
9 DD
EE
Run Total

1
2
3
4
5 Account Code
&
7
8

29
1|« v [ v\ SPERX003.rpt /

&) Done
—

Charges
14,179.56
2,669.50
8,215.39
2,755.62
0.04
27,820.41

Proratsd Amount
15,290.46
2,878.97
,859.02
2,971.51

0.04

30,000.00

Percent
S0.97%
9.60%
29.53%
9.91%
0.00%
100%

&
BERRER 1T

© Internet

Figure A-57 + Proration by Rate Group Spreadsheet Example
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Top 10 Accounts for Rate Spreadsheet

File name: STOPC004.rpt

Stored Procedure: CIMSSP_Summary_RateCode

This spreadsheet provides the account codes with the highest usage of a specified rate

code for the parameters selected. For example, if you type 3 as the TopN parameter, the
three account codes with the highest rate code usage appear (see example Figure A-58).
If you leave the TopN parameter blank, the account codes with the ten highest rate code
usage appear.

Drilldown: None

Parameters:

TopN

Invoice Level

Starting and Ending Account Code

From and To Date

Rate Code

Report Example

File

Qe -

Edit  View Favorites  Tools  Help

\ﬂ @ 7:‘, /._755ar:h 5.¢ Favories @ meda €4 - &

) CIMS Server - Microsoft Internet Explorer gﬁlg‘
o

Top 10 Accounts for Rate 5§

Open with
Excel

Publish

fudress @) hitp umm. clinsserver comjreptexec  ssp?Top+N=38Irvoicel svel=1 BAccoUntCodeStart=+&choAccount CodsStart=+AccountCodeEnd=zezazazazaticboiiccountCodeEne | Ed Go  Links ™

Return

1
2
3
4
5
B
7
8
g

10
11
12
13
14
15
16
17
18
14
20
21
22
23
24
25
26
27
28
28

Top 3 Accounts for Disk SIOs
Account Range: All

Date Range: 6/1/2003 to 6/30/2003
Account

A/-CIMS Lab, Inc. Roseville
CC-CIMS Lab, Inc. Laurel
DD-CIMS Lab, Inc. International

Run Total

W4 (¥ STOPCOO4.rpt /

&) Done

Units
16,564,291
13,163,149

2,495,674

34,167,178

Rate

Per 1000

0.25 /M
0.25 /M
0.25 /M

Charge
4,141.00
3,290.79

623.94

8,541.66

48.48%
36.53%
7.30%

® Internet

Figure A-58 + Top 10 Accounts for Rate Spreadsheet Example
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B Standard Reports

Account Summary Week Spreadsheet
File name: SWEKCOO1.rpt

Stored Procedure: None

This spreadsheet provides account summary weekly information by account code for the

parameters selected.

Drilldown: None

Parameters:

m Invoice Level

B Report Year

m Report Month

m Starting and Ending Account Code

Report Example

licrosoft Internet Explorer

File  Edt View Favorites Tools Help ]
[EE \ﬂ E" l, ) search 5 Favorites @t mesia ) = 3
&) http: Jumawn cimsserver..com|reptexec. aspPInvaicel evel=1 astR 1998MLastRep h=12&M_astReportingDate=December-+21998Grc ¥ | 5 G0 >
Spreadsheet Account Summary Week ':"’f:l with Publish Return
A B C D E F G H [ J K L -

1 | AccountCode AccountMame RateDescripti - 6/1/2003 - 6/ 8/8/2003 - 6/ 6/15/2003 - £6/22/2003 - £6/29/2003 - £ MTD |
2 AA CIMS Lab, Ini ©5/390 Jobs Started 1,710.00 1,732.50 187.50 3,630.00

3 AA CIMS Lab, Int©S/390 Steps Started 1,703.00 1,750.50 114.00 3,5867.50

4 Af CIMS Lab, Ini 05/390 Cpu Minutes 1,336.29 4,642.60 307.15 6,286.04

5 AA CIMS Lab, Int©S/390 Cpu Minutes (Initial 0.00 0.00 0.00 0.00

B A4 CIMS Lab, Ini©5/390 Cpu Minutes (All) 0.00 0.00 0.00 0.00

7 AA CIMS Lab, IntTso Cpu Minutes 123.83 100,34 23.75 247.92

g A CIMS Lab, IniTsa Connect Minutes 2,553.55 1,611.55 389.55 4,554.65

3 AA CIMS Lab, ImiTso Inputs 31.02 20,01 6,98 58.01

10 As CIMS Lab, ImiTsa Qutputs 16.39 10.60 3.94 30.93

11 A& CIMS Lab, IntTso Cpu Minutes {Initiator) 0.00 0.00 0.00 0.00

12 an CIMS Lab, IniTsa Cpu Minutes (All) 0.00 0.00 0.00 0.00

13 A& CIMS Lab, ImiTotal S10s 0.00 0.00 0.00 0.00

14 a4 CIMS Lab, IniDisk SIOs 1,938.87 1,823.76 318.66 4,081.29

15 A& CIMS Lab, ImiTape S10s 1,626.29 1,817.30 16142 3,605.01

16 A8 CIMS Lab, IniInput Records 286.81 Bz.62 14.62 386.05

17 A& CIMS Lab, ImiTape Mounts 0.00 0.00 0.00 0.00

18 a4 CIMS Lab, IniDisk Data Sets 2,258.75 2,178.00 307.00 4,743.75

LERET) CIMS Lab, IntDB2Z Transactions (Records) 0.26 0.26

20 An CIMS Lab, IniDB2Z Transaction Elapsed Minutes 0.04 0.04

21 AR/ CIMS Lab, IntMS Windows Disk Size in MI 0.00 0.00 0.00 0.00

22 AA CIMS Lab, Int M3 Windows Number of File 0.02 0.07 0.01 0.10

23 AR/ CIMS Lab, IntMS Exchange Bytes Sent 1z.46 549 0.01 17.96

29 An CIMS Lab, IniM3 Exchange Emails Sent 0.00 0.00 0.00 0.00

25 AR CIMS Lab, IntMS Exchange Bytes Receive 433.63 209.07 1.37 644,07

26 AA CIMS Lab, Ini M3 Exchange Emnails Receiw 0.00 0.00 0.00 0.00

27 AR CIMS Lab, IntMS Windows Elapsed Time i 0.00 0.00 0.00 0.00

28 aa CIMS Lab, Int M3 Windows CPU Time in si 0.00 0.00 0.00 0.00

29 A/ CIMS Lab, IntMS Windows Kernel CPU Tir 0.00 0.00 0.00 0.00
W[« [» [ »il\ SWEKCOD1.1pt / [] i

a
&) Done 4 Internet

Figure A-59 + Account Summary Week Spreadsheet Example
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Account Summary YTD Spreadsheet
File name: SYTDCOO1.rpt

Stored Procedure: None

This spreadsheet provides account summary YID information by account code for the

parameters selected.

Drilldown: None

Parameters:

m Invoice Level

B Report Year

m Starting and Ending Account Code

Report Example

2} CIMS Server - Microsoft Internet Explorer, @@
'l'.

File Edit View Favorites Tools  Help
Qe - ) ¥ B (i Ooeweh Gproonss @hrede €) (- 1L L3
Address | &) http: | fuwan cimsserver.com|reptexec, aspPInvaicelevel=1 countCodeStart=+&choAccountCodeStart=+&Account CodeEnd=zzzzzzzzzzdchoAccount Codefr Gn Links >

Spreadsheet Account Summary YTD Esf:l with Publish Return

A B c D E F G H J Ko

1 Accountcode AccountName January  Fehruary March April May June July August Septe™|
2 AR CIMS Lah, Inc. Roseville 87,381.95 84,449.22 82,234.27 110,604,338  105,392.23 45,536.00

3 BB CIMS Lab, Inc. Gibbsboro 28,984 .62 36,708 .66 33,248 .62 71,272.80 43,056.39 20,785.13

4 cc CIMS Lah, Inc. Laurel 32,6868.42 53,335.48 54,213.12 £1,399.72  111,072.43 50,272.32

5 oD CIMS Lab, Inc. International 11,079.73 4,617.21 3,701.58 7,322.87 18,517.00 9,486 .55

§ |EE CIMS Lab, Inc. Services ,192.87 7,787,864 6,26357  11,549.7F 9,366.33  10,187.56

7

8

9

10

1

12

13

14

15

16

17

18

19
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21
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W[ <[> »l\SYTDCODL.1pt / || Emm |

-

&) Done # Internet

Figure A-60 « Account Summary YTD Spreadsheet Example
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Account Summary YTD by Rate Spreadsheet
File name: SYTDCO02.rpt

Stored Procedure. None

This spreadsheet provides account summary YI'D information by rate code description

for the parameters selected.
Drilldown: None
Parameters:

m Invoice Level

B Report Year

m Starting and Ending Account Code

Report Example

rosoft Internet Explorer

File Edk View Favorites Tools  Help d
(€ BREEAIPeE Fovorites @ Meds ) - & 3
fddress | @] http: | fuwan cimsserver.com|reptexec, asp?Invaicelevel=1 countCodeStart=+&rhboAccountCadeStart=+&AccountCodeEnd: boaccountCodeEr ¥ aGn Links >

Spreadsheet Summary YTD by Rate LIATE Return
Al AccountCode
B c D E F G H | J

1 [#ccountCode laccountMameRateDescription Year January  Fehruary March April May June

2 An CIMS Lab, Ine. 057390 Iobs Startsd 2003 5,307.50 7,767 .50 5,122.50 7,357.50 9,247 .50 3,630.00

3 An CIMS Lab, Inc. 0S/390 Steps Started 2003 4,348.50 £,503.00 4,788.50 6,428.00 7,711.50 3,567.50

4 an CIMS Lab, Ine. 05/390 Cpu Minutss 2003 14,757.02 9,789 .66 5,601.56 15,661.30 | 11,627.59 6,266.04

5 | AA CIMS Lab, Inc. 0S/390 Cpu Minutes (Initiators) 2003 0.00 0.00 0.00 0.00 0.00 0.00

6 |an CIMS Lab, Inc. 05/390 Cpu Minutes (All} 2003 0.00 0.00 0.00 0.00 0.00 0.00

7 AA CIMS Lab, Inc. Tse Cpu Minutes 2003 251.45 247.29 153.03 344,31 456.26 247.92

8 an CIMS Lab, Inc. Tso Connect Minutes 2003 7,631.06 7,037.75 6,32541 | 1571642 | 18,621.58 4,554 65

9 Ah CIMS Lab, Inc. Tso Inputs 2003 £3.99 66.21 32.48 76.38 130.50 58.01

10 an CIMS Lab, Inc. Tso Qutputs 2003 39.98 4z2.02 23.79 48,16 78.78 30.93

11 Ak CIMS Lab, Ine. Tso Cpu Minutes {Tch) 2003 0.00

12 an CIMS Lab, Inc. Tsa Cpu Minutes (Initiator) 2003 0.00 0.00 0.00 0.00 0.00 0.00

13 an CIMS Lab, Inc. Tso Cpu Minutes (All) 2003 0.00 0.00 0.00 0.00 0.00 0.00

14 an CIMS Lab, Inc. Total S10s 2003 0.00 0.00 0.00 0.00 0.00 0.00

15 a4 CIMS Lab, Inc. Disk SIOs 2003 18,905.60 7,202.18 | 18,071.58  11,849.47 £,138.79 4,081.29

16 At CIMS Lab, Inc. Tape S10s 2003 5,470.00 4,928.77 5,590.77 | 1340529 6,267.71 3,605.01

17 a4 CIMS Lab, Inc. 3390 S10's 2003 0.00

18 an CIMS Lab, Inc. 3380 S10's 2003 0.00

EREES CIMS Lab, Inc. 3375 S10's 2003 0.00

20 an CIMS Lab, Inc. 3480 S10's 2003 0.00

21 Ah CIMS Lab, Inc. 3420 S10's 2003 0.00

22 an CIMS Lab, Inc. Virtual SI0's 2003 0.00

23 Ah CIMS Lab, Inc. Input Records 2003 660.32 696,66 597.39 621.03 1,798.41 386.05

24 an CIMS Lab, Inc. Tape Mounts 2003 0.00 0.00 0.00 0.00 0.00 0.00

25 Ah CIMS Lab, Inc. Disk Data Sets 2003 6,434.25 5,769.00 6,058.25 8,767.50 | 10,739.75 4,743.75

26 An CIMS Lab, Inc. DBZ Transactions (Records) 2003 052 052 0.26 078 052 0.26

27 Ah CIMS Lab, Inc. DBZ Transaction Elapsed Minutes 2003 01z 0.09 0.0z 028 008 0.04

28 an CIMS Lab, Inc. M3 Windows Disk Size in MB 2003 0.00 0.00 0.00 0.00 0.00 0.00

29 Ah CIMS Lab, Inc. MS Windows Humber of Files 2003 0.08 0.08 01z 014 010 010

W[« > »il\SYTDCODZ.1pt / [] Emmma [

~

&) Done 9 Internet

Figure A-61 « Account Summary YTD by Rate Spreadsheet Example

B A-82

CIMS Server Web Reporting User's Guide



Standard Reports H

Account Summary YTD Cost by Rate Group Spreadsheet

File name: SYTDC003.rpt

Stored Procedure. None

This spreadsheet provides account summary YID information by rate code description

for the rate group selected for the parameters selected.

Drilldown: None

Parameters:

m Invoice Level

B Report Year

m Starting and Ending Account Code

® Rate Group

Report Example

File Edit View Favorites Tools  Help Y

Q- ©Q @G S sesrch Sl pavores @ medis E4) r

prInvaiceley CodeStart:

A B C D E F G H | Joo
1 AccountCode AccountMame RateDescription Year January  Fehruary March April May il
2 An CIMS Lab, Inc. Roseville MS Exchange Bytes Sent 2003 3.10 6.11 4.04 742 24.40 18
3 AA CIMS Lab, Inc. Roseville Ms Exchange Emails Sent 2003 0.00 0.00 0.00 0.00 0.00 o
4 An CIMS Lab, Inc. Roseville MS Exchange Bytes Received 2003 342.53 505.63 423.82 583.32 1,403.41 866
5 |AA CIMS Lab, Inc. Roseville Ms Exchange Emails Received 2003 0.00 0.00 0.00 0.00 0.00 o
B BB CIMS Lab, Inc, Gibbshoro MS Exchange Bytes Sent 2003 0.01 0.02 0.00 0.22 4.69 1
7 BB CIMS Lab, Inc. Gibbsboro Ms Exchange Emails Sent 2003 0.00 0.00 0.00 0.00 0.00 o
8 BB CIMS Lab, Inc, Gibbshoro MS Exchange Bytes Received 2003 68.00 10540 47.73 58.55 158.94 121
3 BB CIMS Lab, Inc. Gibbsboro Ms Exchange Emails Received 2003 0.00 0.00 0.00 0.00 0.00 o
10 |cc CIMS Lab, Inc. Laurel MS Exchange Bytes Sent 2003 0.00 0.1z 0.00 0.00 0.78 1)
11 |cC CIMS Lab, Inc. Laurel Ms Exchange Emails Sent 2003 0.00 0.00 0.00 0.00 0.00 o
12 |cc CIMS Lab, Inc. Laurel MS Exchange Bytes Received 2003 49.21 106.21 86.03 89.18 122.37 55
13 |cC CIMS Lab, Inc. Laurel Ms Exchange Emails Received 2003 0.00 0.00 0.00 0.00 0.00 o
14 oD CIMS Lab, Inc. International MS Exchange Bytes Sent 2003 0.03 1.22 0.01 0.73 0.61 1)
15 oD CIMS Lab, Inc. International M3 Exchange Emails Sent 2003 0.00 0.00 0.00 0.00 0.00 o
16 DD CIMS Lab, Inc. International MS Exchange Bytes Received 2003 93.03 14140 96.94 175.70 60.59 28
17 oD CIMS Lab, Inc. International M3 Exchange Emails Received 2003 0.00 0.00 0.00 0.00 0.00 o
18 [EE CIMS Lab, Inc, Services MS Exchange Bytes Sent 2003 0.00 0.00 0.00 0.25 774 3
13 [EE CIMS Lab, Inc. Services Ms Exchange Emails Sent 2003 0.00 0.00 0.00 0.00 0.00 o
20 [EE CIMS Lab, Inc, Services MS Exchange Bytes Received 2003 0.00 0.00 0.00 244 373.72 158
21 [EE CIMS Lab, Inc. Services Ms Exchange Emails Received 2003 0.00 0.00 0.00 0.00 0.00 o
22
23
24
25
26
27
28
23
W[ 4> »l\SYTDCODZ.1pt / [«] e |
~
&) Done 0 Internet

Figure A-62 + Account Summary YTD Cost by Rate Group Spreadsheet Example
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Crosstab Reports

This section describes the CIMS Server crosstab reports. You can run a crosstab report as
a report or a spreadsheet. The examples in this section show the report format.

Daily Crosstab—Charges
File name: XDAYCOO01.rpt
Stored procedure: CIMSSP_Summary_Day

This report provides total daily charges by account code and rate code description for the
parameters selected.

Drilldown: None

Parameters:

®m Invoice Level
m Starting and Ending Account Code
® From and To Date

Report Example

) CIMS Server - Microsoft Internet Explorer

Fle Edt Wew Favortes Tooks Help w
Q- © - [x] B & 0 search 5 Favortes @ veda €2} - i 3
address | &) htep: fww.cimsserver comjreptexec. aspHnvoicsLevel=1 RccountCodeSt art =+t boAccountCodeStart=-+&Account CodeEnd bofccountCodeEnd vIBe ks *
Daily Crosstab - Charges Publish Return Help i
& &[0z~ [ 1 of 1+ [ # .
Preview |
A~
= P
CIMS
Account Daily Crosstab - Charges From 6/1/2003 to 6/30/2003
Total All Days 6/1/2003 6/2/2003 6/3/2003
Total All Accounts 107,686.58 5,571.68 7,255.24 10,586.16
AA - CIMS Lab, Inc. Roseville | Total for Account 37,681.90 1,795.19 3,499.16 2,093.37
001 - 05790 Jobs Started 3,015.00 47.50 335.00 65.00
003 - 057790 Steps Started 2,884.50 39.00 321.00 38.00
005 - 05790 Cpu Mintes 5,584.72 44.06 287.79 33.25
013 - Tso Cpu Minutes 202.07 19.76 2.17 4.92
015 - Ta Connest Minutes 3,814.21 284.89 277.83 693.01
016 - Teo Inputs 42.95 7.83 0.26 0.07
016 - Tao Outputs 22.71 4.08 0.14 0.04
032 - Disk 5108 3,354.28 31.88 324.12 34.11
034 - Tape 5108 3,071.81 62.60 597.53 273.68
070 - Tnput Records 360.94 15.00 16.58 015
< >
v
&) Done ® Internet

Figure A-63 + Daily Crosstab—Charges Report Example
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Daily Crosstab—Usage
File name: XDAYROO1.rpt
Stored procedure: CIMSSP_Summary_Day

This report provides total daily resource usage by account code and rate code description
for the parameters selected.

Drilldown: None

Parameters:

m Invoice Level
m Starting and Ending Account Code
® From and To Date

Report Example

2 CIMS Server - Microsoft Internet Explorer ElE‘El
i

File Edt Wiew Fawortes Tooks  Help

oBack - lﬂ lg h /__‘ISearch \‘?:'\’E‘Favuntes @ redia £4) [:;'v ; (<] 3

Address |@&] http:/fwaw.cimsserver comjreptexec. asp?invoicel evel=1 &AccountCodeStart=+EcboAccountCodeStart=+EAccount CodeEnd=22zz22z222cboceount CodeEnd—zzzzzzzz + | [ G Links **

Daily Crosstab - Usage Publish Return
| x @ &fwr =] || 4 4] T of i+ P o | da | fo2e]
Preview | )
A
Account Daily Crosstab - Resource Usage  From6/1/2003 to 6/30/2003
Total All Days 6/172003 6/2f2003 6/3f2003
AA - CIMS Lab, Inc. Roseville
001 - 05/390 Jobs Started 1,206 19 134
003 - 05/390 Steps Started 5,769 78 642
05 - O5/330 Cpu Minutes 279.23 2.20 14.39 1.t
007 - O5/330 Cpu Minutes (Initiators) 2.72 0.05 0.28 o.t
o0& - 05330 Cpu Minutes (All) 320.00 2.35 15.44 1.t
013 - Tso Cpu Minutes 8.08 0.79 0.09 (L
015 - Tzo Connect Minutes 15,256.70 1,139.57 1,111.33 z,77z.1
016 - Tso Inputs 21,477 3,918 131
018 - Tso Outputs 22,709 4,079 139
020 - Tso Cpu Minutes (Initistor) 0.08 0.00 0.00 o.t
021 - Tso Cpu Minutes (All) 8.61 0.85 0.09 0. @
< 3 |0
hd
L&) Done B Internet
il

Figure A-64 + Daily Crosstab—Usage Report Example
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Detail by Identifier Crosstab
File name: XDETROO1.rpt
Stored procedure: CIMSSP_Ident_Crosstab

This report provides total charges by rate code for a selected identifier value or values for
the date range selected.

Drilldown: None

Parameters:

m From and To Date
m Identifier

m Start and End Value
Report Example

In this example, the identifier selected is Exchange User and the identifier start and end
values are both deborah.

2 CIMS Server - Microsoft Internet Explorer,

Fle Edt Vew Favortes Took Help i

Qe - © |ﬂ @ ,;\J /-]Search 5\7 Favorites @ vedia ) - 3

Address | @] http:/fmaw.cimsserver.comjreptexec. asp?Rangs=9BDateStart=6:2F 1 %2F 20038 FromDate=62F 1 % 2F20038fromMonth=68FromDay—=18fromyear=20038DateEnd=62 | g4 G0 Links ™

Detail by Identifier Publish Return Help

& & [l0x | [ 1 oft #h .

Preview |

Detail by Identifier Crosstab
Date Range: 6/1 /20023 to 6/20/2002
Exchange User From deborah to deborah

600-MS Windows 601-MS Windows 603-MS Windows 640-MS Exchange | 641-MS Exchange | 642-MS Exchang

SQL Server SQL Server SQL Server Reads Bytes Sent Emails Sent Bytes Received
Records Duration (seconds)
Total 1.00 20.56 72.00 773,947.00 28,00 4,994,659
deborah 100 20.56 72.00 773,947.00 28,00 4,394,659

|
£

<

&3}

@ Done & Internet

Figure A-65 + Detail by Identifier Crosstab Report Example
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Detail by Identifier by Date Crosstab
File name: XDETR0O02.rpt
Stored procedure: CIMSSP_Ident_Crosstab_StartDate

This crosstab report provides total and total daily charges by rate code for a selected
identifier value or values for the date range selected.

Drilldown: None

Parameters:

m From and To Date
m Identifier

m Start and End Value
Report Example

In this example, the identifier selected is Exchange User and the identifier start and end
values are both deborah.

2 CIMS Server - Microsoft Internet Explorer

Fle Edt ¥ew Favorites Tools Help e
Qe - © ¥ A @ ) search 57 Favortes @ veda 2 - & 3
address | @] http:/fmaw.cimsserver.comjreptexec. asp?Rangs=9BDateStart=6:2F1%2F 20038FromDate=6%2F 1 %2F20038fromMonth=68FromDay—=18fromyear=20038DateEnd=62 ¥ | g G0 Links ™
Detail by Identifier by Date Publish Return Help &
& &[0z~ [ 1 of 1+ [ # .
Preview |
m )
1
Detail by Identifier by Date Crosstab
Date Range: 6/1/2002 to 6/20/2002
Exchange User From deborah to deborah
600-MS Windows 601-MS Windows 603-MS Windows 640-MS Exchange
SOL Server SOL Server SQL Server Reads Bytes Sent
Records Duration (seconds)
Total 100 20,56 72.00 773,947.00
debarah Tatal 100 20,56 72.00 773,347.00
62 2005 0.00 0.00 0.00 0.00
3/ 2003 0.00 0.00 0.00 65,164,00
64 2003 0.00 0.00 0.00 3,485.00
65/ 2005 0.00 0.00 0.00 0.00
5/ 2003 0.00 0.00 0.00 62,816.00
5 2003 0.00 0.00 0.00 0.00
102003 0.00 0.00 0.00 65,609.00
et innn nnn nnn nnn 4N 200 nn hd]
< >
v
L&) Done: B Internet
L

Figure A-66 < Detail by Identifier by Date Crosstab Report Example
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Monthly Crosstab—Charges
File name: XMONCOO1.rpt

Stored procedure: CIMSSP_Summary_Day

This report provides total monthly charges by account code and rate code description for

the parameters selected.
Drilldown: None

Parameters:

m Invoice Level
m Starting and Ending Account Code
® From and To Date

Report Example

3 CIMS Server, - Microsoft Internet Explorer

EER

File Edt View Favorites Tools Help h
Qs - BREEK ) ) search 5 Favories @ ede £2) - 3
Address | @] http: i, chnsserver. comfreptescer  asp?Invoicel evsl=1 &Account CodeStart=+arhoAccount CodeStart=+accountCodeEnd: hafccountCodeEnd v B ks ?
Monthly Crosstab - Charges Publish Return Help &
& &l - [ T of 1+ > M dh .
Preview |
~
CIMS
CIMS 5@V |
Account Monthly Crosstab - Charges From 6/1/2003 to 6/30/2003
Total all Months 06f2003
Total All Accounts 136,267.56 136,267.56
AR - CIMS Lab, Inc. Roseville | Total for Account 45,536.00 45,536.00
o0l - O5/380 Jobs Started 3,630.00 3,630.00
003 - O5/390 Steps Started 3,567.50 3,567.50
005 - 054390 Cpu Minutes 6,286.04 6,286.04
013 - Tso Cpu Minutes 247.92 247.92
015 - Tzo Connect Minutes 4,554.65 4,554.65
016 - Tzo Inputs 58.01 58.01
018 - Tzo Outputs 30.93 30.93
032 - Disk S10s 4,081.29 4,081.29
034 - Tape SI0s 3,605.01 3,605.01
070 - Input Records 386.05 386.05 9
< >
v
&) Done B Intemet
=

Figure A-67 « Monthly Crosstab—Charges Report Example
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Monthly Crosstab—Usage
File name: XMONROO1.rpt
Stored procedure: CIMSSP_Summary_Day

This report provides total monthly resource usage by account code and rate code
description for the parameters selected.

Drilldown: None

Parameters:

m Invoice Level
m Starting and Ending Account Code
® From and To Date

Report Example

2 CIMS Server - Microsoft Internet Explorer

Fle Edt View Favortes Took Help F

Qe - © \ﬂ @ _jj /-_] Search “T:E‘Favw\tes @ veda ) ['\. ; (=] 3

Address (] hktp:/fum,cinsserver.comjreptesec. ssprInvoicel svel=1 fceount CodeStart=+arboAccount CodeStart=+&ccountCodeEnd=2zzzzzz2z2leboccountCodeEnd=zezezzzz: ¥ | g Go  Links

Monthly Crosstab - Usage Publish Return
| % & @foor <] || 4 4] Lo 1+ >y o4 | =
Preview | )
&
Account Monthly Xtab - Resource Usage From 6/1/2003 to 6/30/2003
Total all Months 06f2003
AM - CIMS Lab, Inc. Roseville
001 - 05/390 Jobs Started 1,452 1,452
003 - O5/390 Steps Started 7,135 7,135
05 - O5/330 Cpu Minutes 314.29 314.29
007 - O5/330 Cpu Minutes (Initiators) 3.44 3.44
008 - 05/390 Cpu Minutes (All) 357.27 357.27
013 - Tso Cpu Minutes 9.92 9.92
015 - Tzo Connect Minutes 18,218.45 18,218.45
16 - Tso Inputs 29,003 29,003
16 - Teo Outputs 30,926 30,926
020 - Tso Cpu Minutes (Initiator) 0.11 0.11
021 - Tso Cpu Minutes (&1} 10.60 10.60 2
g 3 |0
b4
&) Done B Intemet
!

Figure A-68 « Monthly Crosstab—Usage Report Example
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Summary Crosstab—Charges
File name: XSUMCO01.rpt
Stored procedure: CIMSSP_Summary

This report provides total charges by account code and rate code description for the
parameters selected.

Drilldown: None

Parameters:

m Invoice Level
m Starting and Ending Account Code
® From and To Date

Report Example

3 CIMS Server, - Microsoft Internet Explorer

Fle Edit View Favorites Tools  Help [

Q- © ¥ @ & ) search S Favories @Pveda ) (- ; = 3

Address (] hktp:ffum.cinsserver.comjreptescec. ssprInvoicel svel=1 &hceount CodeStart=+arboAccount CodeStart=+&ccountCodeEnd=zzzzzzz2z2leboiccountCodeEnd=zezzzzzz: ¥ | [£d Go  Links

Summary Crosstab - Charges Publish Return

| % & @foor <] |14 Lot »ob o || ok | B

Preview |

13,

CIMS

Account Summary Crosstab - Charges From 6/1/2003 to 6/30/2003

0S/390 Batch charges

001 - 05/390 Jobs 003 - 05/390 Steps 005 - 05/390 Cpu 007 - 05/390 Cpu

Started started Minutes Minutes {Initiators)
AA - CIMS Lab, Inc. Roseville 3,630.00 3,567.50 6,286.04 0.00
BB - CIMS Lab, Inc. Gibbsboro 1,795.00 700.00 2,187.76 0.00
CC - CIMS Lab, Inc. Laurel 745.00 1,085.50 3,109.22 0.00
DD - CIMS Lab, Inc. International 285.00 1,337.50 381,43 0.00
EE - CIMS Lab, Inc. Services 167.50 8.50 0.24 0.00

s
€9

<m

<]

&) Done B Intemet
L

Figure A-69 « Summary Crosstab—Charges Report Example
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Summary by Rate Group Crosstab—Charges
File name: XSUMC002.rpt
Stored procedure: CIMSSP_Summary_RateGroup

This report provides total charges by account code and rate code description for the rate
codes within a selected rate group for the parameters selected.

Drilldown: None

Parameters:

m Invoice Level

Starting and Ending Account Code
® From and To Date
® Rate Group

Report Example

2 CIMS Server - Microsoft Internet Explorer

File Edit View Favortes Toos Help =
Qe - O \ﬂ @ () ) seach ¢ Favaries @ eda ) - & L3
Address | @] http: [ Juw. cinsserver. comfreptescer  asp?Invoicel evsl=1 fhccount CodeStart=+arhoAccount CodeStart=+&ccountCodeEnd: hafccountCodeEnd vBe ks ?
Summary Crosstab 2 - Charges Publish Return Help &
& @[l +| [ 1 of i =
Preview |
o
Summary By Rate Group Xtab - Charges  rrom6/1/2003 to 6/30/2003
0S /390 Batch charges
001 - 0S/390 Jobs 003 - 0S/390 Steps 005 - 0S/390 Cpu 007 - 0S/390 Cpu
Started Started Minutes Minutes (Initiators)
AA - CIMS Lab, Inc. Roseville 3,630.00 3,567.50 6,286.04 0.00
BB - CIMS Lab, Inc. Gibbsboro 1,795.00 700.00 2,187.76 0.00
CC - CIMS Lab, Inc. Laurel 745.00 1,085.50 3,108.22 0.00
DD - CIMS Lab, Inc. International 285.00 1,337.50 361.43 0.00
EE - CIMS Lab, Inc. Services 167.50 8.50 0.24 0.00
Total All Accounts 6,622,50 6,699.00 11,964.69 0.00
v
< >
v
&) Done B Intemet
L

Figure A-70 « Summary by Rate Group Crosstab—Charges Report Example
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Summary Crosstab—Usage
File name: XSUMROO1.rpt
Stored procedure: CIMSSP_Summary

This report provides total resource usage by account code and rate code description for
the parameters selected.

Drilldown: None

Parameters:

m Invoice Level
m Starting and Ending Account Code
® From and To Date

Report Example

2 CIMS Server - Microsoft Internet Explorer

File Edt View Favorites Tools Help L7
. NS .. » B 4
e Bk - () \ﬂ @ ) ) search Sl ravories @ medis 62) = 3
address | &) http: | fuwa, cimsserver.com|reptexec, aspPInvaicel evel=1&Accaunt CodeStart boAccountCodestart: countCodeEnd=zzzzzzzzzztchofccauntCodeEnd=zzzzzzzz: v | [og 6o Links
Summary Crosstab - Usage Publish Return Help o]
Z & [z <] [ 1 ooft h .
Preview |
.
Account Summary Xtab - Resource Usage From 6/1/2002 to 6/20,/2002
001 - 0S£390 Jobs 003 - 0S/390 Steps 005 - 0S/£390 Cpu 007 - 0S/£390 Cpu
Started Started Minutes Minutes (Initiators)
AA - CIMS Lab, Inc. Roseville 1,452 7,135 314.29 3.44
BB - CIMS Lab, Inc. Gibbsboro 718 1,400 109.38 0.96
CC - CIMS Lab, Inc. Laurel 298 2,171 155.46 1.41
DD - CIMS Lab, Inc. International 114 2,675 19.07 3.23
EE - CIMS Lab, Inc. Services 67 17 0.01 0.01
A
<)) ER
b
&) Done # Internet

Figure A-71 < Summary Crosstab—Usage Report Example
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Summary by Rate Group Crosstab—Usage

File name: XSUMR002.rpt

Stored procedure: CIMSSP_Summary_RateGroup

This report provides total resource usage by account code and rate code description for

the rate codes within a selected rate group for the parameters selected.

Drilldown: None

Parameters:

m Invoice Level

m Starting and Ending Account Code
® From and To Date

® Rate Group

Report Example

2 CIMS Server - Microsoft Internet Explorer

File Edit View Favorites Tools  Help

Qe - Q¥ @ & ) search 5 Favories @ ede 2 - 3

I

U

£
Address | @] http: [ Juw. cinsserver. comfreptescer. asp?lnvoicel evsl=1 &Account CodeStart=+arhoAccount CodeStart=+&ccountCodeEnd: bofccauntCodeEnd: L3 ﬂGu Links
Summary Crosstab 2 - Usage Publish Return Help 2
& @[l +| [ 1 of 1 i =
Preview |
—
Summary By Rate Group Xtab - Usage From 6/1/2003 to 6/30,/2003
QS /390 Batch charges
001 - 057390 Jobs 003 - 057390 Steps 005 - 057390 Cpu 007 - 057390 Cpu
Started Started Minutes Minutes {Initiators)
AA - CIMS Lab, Inc. Roseville 1,452 7,135 314.29 3.44
BB - CIMS Lab, Inc. Gibbshoro 718 1,400 109.38 0.96
CC - CIMS Lab, Inc. Laurel 298 2,171 155.46 1.41
DD - CIMS Lab, Inc. International 114 2,675 19.07 3.23
EE - CIMS Lab, Inc. Services 67 17 0.01 0.01
Total all Accounts 2,649 13,398 598.22 9.05
v
< >
v
&) Done B Intemet
=

Figure A-72 « Summary by Rate Group Crosstab—Usage Report Example
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Weekly Crosstab—Charges
File name: XWEKCOO1.rpt
Stored procedure: CIMSSP_Summary_Day

This report provides total weekly charges by account code and rate code description for
the parameters selected.

Drilldown: None

Parameters:

m Invoice Level
m Starting and Ending Account Code
® From and To Date

Report Example

2} CIMS Server - Microsoft Internet Explorer QE|E\
File Edit View Favorites Toos Help >
Qe - © [ B & O search o Favortes @ veda £2) = 3
Address €] http s, cimsserver. com/reptexe. aspPlnvaicel svel=1 BAccount CodeStart=+achoAccount CodeStart=+ccountCodeEnd bofccountCodeEnd v B ks ?

weekly Crosstab - Charges Publish Return Help &
& &l - [ T of 1+ > M dh .
Preview |
Py
= w1
CIMS |
¥
Account Weekly Crosstab - Charges From 6/1/2003 to 6/30/2003
Total All Weeks 6/1/2003 6/8/2003 6/15/2003

Total All Accounts 136,267.56 55,238.90 72,029.64 8,999.02

AR - CIMS Lab, Inc. Roseville | Total for Account 45,536.00 20,722.47 22,149.14 2,664.39

001 - 05/390 Jobs Started 3,630.00 1,710.00 1,732.50 187.50

003 - 05/330 Steps Started 3,567.50 1,703.00 1,750.50 114.00

005 - 05/390 Cpu Minutes 6,286.04 1,336.29 4,642.60 307.15

013 - Tso Cpu Minutes 247.92 123.83 100.34 23.75

015 - Tso Connect Minutes 4,554.65 2,553.55 1,611.55 389.55

016 - Too Inputs 58.01 31.02 20.01 6.98

018 - Teo Outputs 30.93 16.39 10.60 3.94

032 - Disk 5108 4,081.29 1,938.87 1,823.76 318.66

034 - Tape 510s 3,605.01 1,626.29 1,817.30 161.42
070 - Input Records 386.05 288.81 82.62 162 |

< >
v
&) Done B Intemet
L—

Figure A-73 + Weekly Crosstab—Charges Report Example
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Weekly Crosstab—Usage
File name: XWEKROO1.rpt
Stored procedure: CIMSSP_Summary_Day

This report provides total weekly resource usage by account code and rate code
description for the parameters selected.

Drilldown: None

Parameters:

m Invoice Level
m Starting and Ending Account Code
® From and To Date

Report Example

2 CIMS Server - Microsoft Internet Explorer

Fle Edt View Favortes Took Help .,
@ sk - %) @] | Oseach ' ravoies @Prede ) - L2 3
o & Q|2 .S SR a =" 4
fudcloss ] bt o, cimsssrvs . comjrapkescer . SspPlroicel svsl—2BAreoUntC ek art—+furbiAeountCadeskart—+ e caunkCodsEnd BotccountCodsErd =
weekly Crosstab - Usage Publish Return Help &
& &l - [ T of 1+ > M dh .
Preview |
o

CIMS &

Account Weekly Crosstab - Resource Usage rrom 6/1,/2003 to 6/30/2003

Total All Weeks | 6/1/2003 6/8/2003 6/15/2003
AARAAA - Roseville - CIMS
(et ¢ IS 001 - 05/390 Jobs Started 2,037 527 474 41t
003 - 0S/330 Steps Started 11,769 3,060 3,151 2,151
005 - ©5/330 Cpu Minutes 235.50 57.56 64.05 39.21
007 - 05/330 Cpu Minutes (Tnitistors) 5.45 1.42 1.48 0.9
008 - 08/330 Cpu Minutes (All) 254.29 62.48 68.96 42.6¢
013 - Tso Cpu Mindtes 1.18 0.47 0.04 0.z
015 - Tso Conneet, Minutes 8,779.67 2,854.19 225.67 1,963.3¢
016 - Tso Tnputs 1,423 302 22 51!
016 - Tso Outputs 1,543 330 26 541
020 - Tso Cpu Mintes (Initistor) 0.04 0.01 0.00 0.0
021 - Tso Cpu Mintes (all) 1.28 0.50 0.04 030
< 3|
b
&) Done B Intemet
|

Figure A-74 + Weekly Crosstab—Usage Report Example
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Templates

This section describes CIMS Server report templates. These templates are launched when
you create a report in CIMS Server Web Reporting (see Creating and Running CIMS Web
User Created Reports on page 2-10). Templates can be customized, but custom templates
must be stored in the same directory as the standard templates. If CIMS Server is installed
in the default path, the location is C:\Program Files\CIMSLab\Server\Reports\
Standard\Templates. Please consult CIMS Lab before you customize templates (see
Contacting Technical Support on page 6-5).

Report Both Template
File name: RTMPBOO1.rpt
Stored procedure: CIMSSP_Summary

This template produces Both reports that show resource usage and charges by account
code and rate code description for the parameters selected.

Drilldown: None
Parameters:

m Invoice Level

Starting and Ending Account Code
® From and To Date
m Four rate codes (selected when report was created)

m Four decimal place options (selected when report was created)
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Report Examples

Figure A-75 shows the creation of a Both report called Job Report. Figure A-76 shows the
resulting report that has been run from the Reports menu.

<3 CIMS Server, - Build a Report - Microsoft Internet Explorer
Edit

File

Views  Favorites  Tools  Help

Gﬂack ) @ @ ~‘h fr\ search 57 Favortes @Preds €2 (- L @ - 3
Address | ] http: | fuwas. cimsserver. com|Define CustSumRpts., asp?OULpULT ype=RaReset=true

CIMS

Server

.

Beo ks

Login Reports Spreadsheets Favorites Admin  Help Logout Home

Build a Report

Please select parameters for Report
Go to Report: | (new Report)
Report Type: |Both v

Report Name: | Johb Report ‘

Report Description: |

[Imake visible to all users

Resource
Column 1: 2001 - 05/330 Jobs Started v
Column 2: [ 2003 - 05/390 Cpu Minutes v|
Column 3: | v|
Column 4: | v|
Add
&) 4 Internet

Figure A-75 + Creating a Report Example

3 CIMS Server, - Microsoft Internet Explorer

File Edit View Favorites Tools  Help e

Q-0 @A

/:.\ Search ¢ Favartes @ media §7) p/:'{- ; J

Links **
Job Report Return Help e
& &%=l + [ 1 oof 1+ [ b .
Preview |
[+] ~ i
# CIMS Lah, Inc. Gitbsboro
+ CIMS Lab, Inc. Laurel b
+ CIMS Lah, Inc. International
+ CIMS Lah, Inc. Services
Job Report Fram:
To:
Account 05/390 Jobs  ©5/330 Jobs  OS/390 Cpu ©5/330 Cpu
Started Started Cost  Minutes Mindtes Cost
AA_CIMS Lab, Ine. Ruseville
Z,892.00 7,230.00 ET) 7,650.28
BE-CIMS Lab, Inc. Gibbsboro
1,715.00 4,287.50 126.20 2,524.24
CC-CIMS Lab, Ine. Laurel
544,00 1,350.00 218.27 4,365.25
DD-CIMS Lab, Inc. International
266.00 865.00 246 643,12
EE-CIMS Lab, Inc. Services
129,00 322,50 0oz 0.49
v
] L3
v
@ Done ® Intemet

Figure A-76 + Generated Report Example

CIMS Server Web Reporting User’s Guide A-97 N



B Standard Reports

The preceding examples are also applicable to the Cost and Resource reports with the
following exceptions:

B The Report Type is Cost or Resource rather than Both.

B The resulting report shows resource usage or charges, not both.

Report Cost Template
File name: RTMPCO01.rpt
Stored procedure: CIMSSP_Summary

This template produces Cost reports that show charges by account code and rate code
description for the parameters selected.

Drilldown: None
Parameters:

m Invoice Level

Starting and Ending Account Code

® From and To Date

m Eight rate codes (selected when report was created)

m Eight decimal place options (selected when report was created)
Report Example

See page A-97.
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Report Resource Template
File name: RTMPROO1. rpt
Stored procedure: CIMSSP_Summary

This template produces Resource reports that show resource usage by account code and
rate code description for the parameters selected.

Drilldown: None

Parameters:

m Invoice Level

m Starting and Ending Account Code

® From and To Date

m Eight rate codes (selected when report was created)

m Eight decimal place options (selected when report was created)
Report Example

See page A-97.

Spreadsheet Both Template
File name: STMPBOO1.rpt
Stored Procedure. None

This template produces Both spreadsheets that show resource usage and charges by
account code and rate code description for the parameters selected.

Drilldown: None

Parameters:

m Invoice Level

m Starting and Ending Account Code

® From and To Date

m Four rate codes (selected when spreadsheet was created)

m Four decimal place options (selected when spreadsheet was created)
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Report Example

Figure A-76 shows the creation of a Both spreadsheet called Oracle Usage. Figure A-77
shows the resulting report that has been run from the Spreadsheets menu.

3 CIMS Server, - Build a Spreadsheet - Microsoft Internet Explorer,
Edit

File: Views  Favorites  Tools  Help

& = " A
Qe - O \ﬂ E"‘ h S search 57 ravories @Preda ) (-
fddress | @] http: | fuwas, cimsserver. com|Define CustSumRpts, asp?OULpULT ype=SeReset=true

CIMS

Server

@ -3

v

Beo ks

Login Reports Spreadsheets Favorites Admin  Help Logout Home

Build a Spreadsheet

Please select parameters for Spreadsheet
Go to Spreadsheet: |(new Spreadshest) v
Spreadsheet Type: |Both v

Spreadsheet Name: |Oracle Usage |

Spreadsheet Description: |

[rake visible to all users

Resource
Column 1: [LLE101 - Oracls Logins v
Column 2: [LLE10Z - Oracle Sessian CPU v
Column 3: [LLE103 - Oracls Connect v
Column 4: [LLE104 - Oracle Uga Memory v
L Add )
&) CIMs Server is ready. #® Internet

Figure A-77 - Creating a Spreadsheet Example

23 CIMS Server - Microsoft Internet Explorer

Filg Edit ¥iew Favorites Toadls Help .',

Qe - © @ @ \h pSEarEh S;"\?Favw\tes @ e £2) ﬁ:{- ;, a3

Address | @] http:ffum,cinsserver. comjreptescec. ssprInvoicel svel=1 Bceount CodeStart=+acboAccount CodeStart=+aAccountCodeEnd=zzzezzzezalicbodccounts ¥ | g Go  Links ™

Oracle Usage Open with Publish Return
Exce
A [ B [ & [ D | E ] F | G [H]J ! I J [ ®x =
Accountiame AccountCade Oracle Logins Oracle Logins Oracle Sessio Oracle Sessio Oracle Cannect | Oracle Conne Oracle Uga Memery | Oracle Uga ©
CIMS Lsh, Trudd, 4000 080 320,56 7377 25140 1,131.71 7,073,367.38 1766
CIMS Lab, IniBE sa.57 1350 2520.00 1,134.00 54,150.92 01s
CIMS Lsh, TG 10,00 020 53.07 1221 3,z4n.21 1,458.10 2,445,544 94 511
CIMS Lab, IniEE a5.00 190 1120 18658 2,078.07 935.14 9,671,392.14 24,20

e ) ) ) ) ) ) Y o

W[ 4[» ¥} STMPBOD1.rPE 14 | ’”J

1=

Dane @ Tnternst

[

Figure A-78 + Generated Spreadsheet Example
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The preceding examples are also applicable to the Cost and Resource spreadsheets with
the following exceptions:

B The Spreadsheet Type is Cost or Resource rather than Both.

m The resulting spreadsheet shows resource usage or charges, not both.

Spreadsheets Cost Template
File name: STMPCO01.rpt
Stored Procedure. None

This template produces Cost reports that show charges by account and rate code
description for the parameters selected.

Drilldown: None

Parameters:

®m Invoice Level

m Starting and Ending Account Code

® From and To Date

m Eight rate codes (selected when spreadsheet was created)

m Eight decimal place options (selected when spreadsheet was created)
Report Example

See page A-100.
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Spreadsheets Resource Template
File name: STMPROO1.rpt
Stored Procedure. None

This template produces Resource spreadsheets that show resource usage by account and
rate code description for the parameters selected.

Drilldown: None

Parameters:

m Invoice Level

m Starting and Ending Account Code

® From and To Date

m Eight rate codes (selected when spreadsheet was created)

m Eight decimal place options (selected when spreadsheet was created)
Report Example

See page A-100.
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ASP ¢ Acronym for Active Server Pages. A server-side scripting environment developed
by Microsoft for developing Web pages and applications.

CIMS Server Resource File ¢ The resource file that contains the data that is input into
CIMS Server. The CIMS Server Resource File contains CIMS Server Resource Records.
These records are comma-delimited and can contain a very large number of resource
identifiers and resources. See also identifier and rate code.

cookie ¢ A small text file that stores information about a Web site user. CIMS Server
Web Reporting stores user information, such as the report parameter values entered by a
user, in a cookie.

DSN ¢ Acronym for Data Source Name. The name assigned to an ODBC data source.

identifier ¢ In the CIMS Server Resource Record, a unique key that denotes the source
of a resource that has been consumed. Examples include device name, server name,
system ID, phone number, user ID, state code or building number. A consumed resource
can have one to many identifiers.

IIS » Acronym for Internet Information Services. Microsoft software that supports Web
site creation, configuration, and management.

ODBC ¢ Acronym for Open Database Connectivity. An interface providing a common
language for database access.

rate code < A rate code represents the resource units being reported (for example, CPU
time, transactions processed or lines printed). The rate code includes the value for the
resource and other rate processing information.

URL ¢ Acronym for Uniform Resource Locator. The address for a resource on the
Internet or an intranet.
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A

account codes
explanation of 2-8
setting levels that appear in starting and ending
parameter lists 4-8
adding
favorite reports 4-2
transactions 5-3 to 5-4
auto log on, using 1-3

batch reports, running 2-14
billing for miscellaneous, recurring, or credit
items See transactions

C

configuring CIMS Server Web Reporting
system-wide configuration 4-7 to 4-8
user-specific configuration 4-2 to 4-6
creating and running Web user reports 2-10 to 2-
12
credits, applying See transactions
crosstab reports (standard), descriptions of A-84
to A-95
Crystal Reports
creating parameter fields in 4-9
use in CIMS Server Web Reporting 1-2
viewer
selecting for a user 4-6
selecting for all users 4-8
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reports created by Web user 2-11
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drilldown in reports
closing 3-6
example 3-6 to 3-7
using 3-5 to 3-7

E

editing
spreadsheets 3-10
transactions 5-4

F

favorite reports
about 4-2
accessing 4-3 to 4-4
adding 4-2
deleting 4-4

H
Help, accessing 1-6

invoice number
parameter setting 2-5
system setting 4-7
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logging on to CIMS Server Web Reporting 1-3 to
1-4

logging out of CIMS Server Web Reporting 1-6

menu bar, using 1-5

N

navigating
CIMS Server Web Reporting 1-5
reports 3-3, 3-5
transactions 5-4

0

organization name and address, setting 4-7

P

parameters
for reports 2-4 to 2-7
customizing 4-9
for transactions 5-3
customizing 4-9
password
about 1-5
changing 1-5
entering 1-3
paths for published reports, showing or hiding 4-
5
printing
reports 3-3
spreadsheets 3-10
published reports
creating 2-13 to 2-14
filtering 2-16
folder paths to, showing or hiding 4-5
running from a batch script 2-14
sorting 2-16
viewing 2-15
vs saved reports 2-13
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reports
created by Web user 2-10
deleting 2-11
running 2-11
updating 2-10
drilldown in 3-5 to 3-7
example 3-6 to 3-7
favorites
about 4-2
accessing 4-3 to 4-4
adding 4-2
deleting 4-4
interface, description of 3-2
navigating 3-3, 3-5
parameters for 2-4 to 2-7
customizing 4-9
printing 3-3
published
creating 2-13 to 2-14
example 2-17
filtering 2-16
folder paths to, showing or hiding 4-5
running from a batch script 2-14
sorting 2-16
viewing 2-15
vs saved reports 2-13
running 2-2 to 2-3
saving 3-3, 3-8
standard
about A-4
descriptions of A-7 to A-102
stopping from loading 3-4
templates (standard)
descriptions of A-96 to A-102
text
copying text from 3-8
searching for text in 3-4
types of 2-2
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saving
reports 3-3
spreadsheets 3-10
security
permissions required for folders 1-7
user access to reports 2-14
spreadsheets
closing in Excel 3-10
created by Web user See reports, created by Web
user
editing 3-10
favorites See reports, favorites
interface, description of 3-9
opening in Excel 3-10
parameters for See reports, parameters for
printing 3-10
published See published reports
running See reports, running
saving 3-10
standard, descriptions of A-72 to A-83
standard reports
about A-4
descriptions of A-7 to A-102
starting CIMS Server Web Reporting 1-2

T

technical support, contacting 6-5
templates (standard), descriptions of A-96 to A-
102
timing out
about 1-6
setting for 4-7
transactions
about 5-2
adding 5-3 to 5-4
deleting 5-4
editing 5-4
navigating 5-4
parameters for 5-3
customizing 4-9
troubleshooting 6-2 to 6-4

u
URL, entering 1-2
user ID, entering 1-3
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